Options avancées de LyX

Version 2.4.x

par I'équipe de [y X*

13 mai 2024

*Le principal responsable de la rédaction de ce fichier est MIKE RESSLER. Merci d’en-
voyer vos commentaires et corrections a la liste de diffusion de la documentation de LyX,
<lyx-docs@lists.lyx.org>.

Traduction en francais par : OLIVIER FAUCHEUX, ADRIEN REBOLLO, SIEGFRIED MEUNIER-
GUTTIN-CluzEl et JEAN-PIERRE CHRETIEN. Merci d’envoyer vos commentaires et correc-
tions sur la traduction a la liste de diffusion de LiyX en francais <1yx-fr@lists.lyx.org>.






Table des matieres

1 Introduction 1
2 LyX et BTEX 3
2.1 Comment IyX utilise BTEX . . . . . . . ... ..o 3
2.2 Traduire des fichiers BTEX en LyX . . . . . . . ..o .. .. 4
2.3 Insérer du code BTEX dans des documents Iy X . . . . . . .. .. .. 4
24 IyXetlepréambule XTEX . . . . . . ... ..o 5
2.4.1 A propos du préambule BETEX . .. oo oo )
2.4.2 Changer le préambule . . . .. ... ... ... 6
243 Exemples . . . ... 7
24.3.1 Exemple 1: Décalages . . . . . ... ... ... ... 7
2.4.3.2 Exemple 2 : Etiquettes . . . . . . .. ... ... ... 7
2.4.3.3 Exemple 3 : Indentation de paragraphe . . . . . . . . 8
24.34 Exemple 4 : Ce document . . . . . . ... ... ... 8
25 IyXetleserreurs BKTEX . . . . . . .. .o Lo 8
3 Classes de document 13
3.1 Collections . . . . . . . . . 13
3.1.1 AMS-ETEX (American Mathematical Society) . . . . . .. .. 13
3.1.1.1 Ce qu’offrent ces formats. . . . . .. ... ... ... 14
3.1.2 Tailles de police supplémentaires . . . . . ... .. ... ... 16
3.1.3 Hébreu. . . . ... . .. .. 16
3.1.4 Japonais (classes standard) . . .. ... ... 17
3.1.5 Japonais (paquet JS) . . . . ... 17
3.1.6 Japonais (paquet BX) . . ... ... oo 17
3.1.7 Japonais (classe JLReq) . . . . ... ... 18
3.1.8 Koma-Script . . . . . .. .. 18
3181 Enrésumé. . . ... ... 18

3.1.8.2  Article KOMA-Script, Report KOMA-Script, et Book
KOMA-Script . . . . . . . ... 19
3.1.8.3 La nouvelle classe lettre : Letter KOMA-Script (v.2) 22
3.1.84 Problemes . . . . .. ..o 22
3.1.9 Collection polonaise M. W.. . . . .. ... ... ... ..... 23
3.1.10 Collection Tufte . . . . . . . ... ... ... L. 24
3.2 Articles . . ... 24
3.2.1 Astronomy & Astrophysics . . . . .. ... 24
3.2.1.1 Introduction . . . . ... ... ... 24

iii



Table des matiéres Table des matieres

3.2.1.2  Pour commencer . . .. ... ... ... .. ..... 24

3.2.1.3 Leblocden-téte . . ... .. ... ... .. ..... 25

3.2.1.4 Labstract . . . . . . ... ... ... ... ... .. 25

3.2.1.5 Environnements supportés . . . . . . ... ... L. 26

3.2.1.6  Commandes non encore supportées par ILyX . . . . . 26

3.2.1.7 Figures et tableaux flottants . . . . . . . .. ... .. 26

3.2.1.8 Format derevue . . . . ... ... ... ... .. .. 27

3.2.1.9 Le fichier d’exemple . . . .. ... ... ... .... 27

3.2.2  Article AASTEX . . . . . . . 27
3.2.2.1 Introduction . . . . ... ... ... ... ... ... 27

3.2.2.2 Commencer un nouveau papier . . . .. .. ... .. 28

3.2.2.3 Finir votre papier . . . . . . . .. ... 28

3.2.2.4 Commentaires sur des commandes particulieres . . . 29

3.2.2.5 FAQs, conseils, trucs et autres astuces . . . . .. .. 30

3.2.2.6 Touche finale . . . . ... ... ... ... ... 32

3.2.2.7 Echecs (chess) . . . . ... 32

3.2.3 Elsevier . . . . . . ... 32
3.24 Paper . ... 32
325 RevIEX4 . . . . . 32
3.2.5.1 Installation . . ... ... ... ... ... ... 33

3.2.5.2 Dans le préambule . . . . . ... ... ... 33

3.25.3 Champs! . ... ... 33

3.2.5.4 Notes importantes . . . . .. . ... ... ... ... 33

3.2.6 Revues Springer . . . . . .. .. ..o 34
3.3 Livres . . . . . 34
3.3.1 Memoir . . . . . .. 34
3.3.1.1 Introduction . ... ... ... ... ... .. ... 34

3.3.1.2 Fonctions de base et restrictions . . . . . . . . .. .. 35

3.3.1.3 Fonctions supplémentaires . . . . . . . .. ... ... 36

3.3.2 Livrederecettes . . . . . ... .. ... 37
3.4 Curricula vitae . . . . ... 37
3.4.1 Europass (2013) . . . . . ..o 37
342 Europe CV . . . .. . 37
343 Modern CV . . . . . .. 37
344 CVsimple . . .. ... 37
3.5 Lettres . . . . . . . 38
3.5.1 DIN-Brief . . . . ... ... . 38
3.5.2  Lettre en francais (frletter) . . . . . ... ... ... 38
3.5.3 Lettre en francais (lettre) . . . .. ... ... ... ... ... 38
3.5.4 G-Brief (V.2) . . . ... 38

1. NdT : Dans la section sur RevIgEX, j’ai traduit « layout » par « champ » & de nombreux
endroits. Ce que I'auteur indiquait était peut-étre un environnement, mais ressemble de toute facon
a un champ a remplir. N’ayant pas RevIEX, je ne peux pas aller vérifier.

iv



Table des matieres Table des matiéeres

3.6 Présentations . . . . . ... ... 38
3.6.1 Beamer . . . .. .. ... 38
3.6.2 FoilTEX . . . . . . 39

3.6.2.1 Introduction . . .. ... ... ... L. 39
3.6.2.2 Pour commencer . . . .. ... .. ... ....... 39
3.6.2.3  Environnements supportés . . . . ... ... L. 40
3.6.2.4 Création de diapos . . . . . . .. ... ... ... 42
3.6.2.5 Fonctions de Foil TEX non-supportées . . . . . . . . . 43
3.6.3 Powerdot . . .. .. ... 44
3.6.4 Seminar . . . . . . ... 44
3.6.5 Diapos Slides (alias SLITEX) . . . . . . ... ... .. ... .. 44
3.6.5.1 Introduction . . ... ... ... ... ... ... 44
3.6.5.2 Pour commencer . . .. ... .. ... ... ... 44
3.6.5.3 Environnements de paragraphe . . . .. .. ... .. 45
3.6.5.4 Réaliser une présentation grace a Diapo, Surcouche
et Note . . .. .. ..o 46
3.6.5.5  Le fichier modele pour la classe Diapos . . . . . . .. 50

3.7 Rapports. . . . . . . 50

3.8 Scripts . . . .. 51
3.8.1 Broadway . . .. .. .. ... 51

3.8.1.1 Introduction . ... ... ... ... ... ... ... 51

3.8.1.2  Problemes particuliers . . . . . ... ... ... ... 51

3.8.1.3 Fonctions particulieres . . . . . . .. ... ... ... 51

3.8.1.4 Taille de papier et marges . . . . ... ... ... .. o1

3.8.1.50 Environnements . . ... ... ... ... ... 51

3.8.2 Hollywood (scripts d’Hollywood) . . . . . .. ... ... ... 52
3.8.2.1 Introduction . . .. ... ... ... ... ... ... 52

3.8.2.2 Problemes particuliers . . . . .. ... ... .. 52

3.8.2.3 Fonctions particulieres . . . . . .. .. ... ... .. 53

3.8.2.4 Taille de papier et marges . . . . ... ... ..... 53

3.8.2.,5  Environnements . . ... ... ... ... ...... 53

3.8.2.6 Jargondescript .. ... ... ... ... ... 54

4 Modules 55

4.1 Particularités d’'un domaine académique . . . . . .. ... ... 55
4.1.1 Chimie : mentions de danger et conseils de prudence . . . . . 55
4.1.2  Chimie : énoncés de risque et sécurité . . . . . . .. ... .. 55
4.1.3 Linguistique . . . . . . . ... oL 59

4.2 Accessibilité . . . ... 55
421 Braille . . . . ..o 95

4.3 Annotation & revue. . . .. ... 56
4.3.1 Notes FiXme . . . ... .. . ... ... ... ... 56
4.3.2 Commentaires PDF . . . . . . ... ... ... ... ...... 56
4.3.3 Formulaires PDF . . . . . ... ... ... ... ..., 56



Table des matiéres Table des matieres

4.4

4.5

4.6

4.7

4.8

4.9

4.10

4.11

4.12

434 Ruby (Furigana) . . ... ... ... .. ... ... ... 56
4.3.5 Notes TODO . . . . . . . .. ... .. 56
Bibliographie . . . . . . . ... 26
4.4.1 Style APA avec Natbib . . . . . . . ... ... ... ... ... 56
Boites . . . . . o7
4.5.1 Boites colorées sophistiquées . . . . . . . . ... 57
4.5.2 Boites graphiques . . . . . . .. ..o o7
4.5.3 Section Boxes . . . . . .. ... o 58
4.5.4 Minipages a largeur variable . . . . . .. ... ... o8
Solutions & astuces . . . . . . ... 58
4.6.1 Polices Computer Modern corrigées . . . . . . . . . ... ... 58
4.6.2 Corrections du noyau IXTEX (obsolete) . . . ... .. ... .. 58
4.6.3 Inserts minimalistes . . . . . . . . ... o8
4.6.4 Astuces pour le titre et le préambule . . . . . ... ... .. 59
Flottants & légendes . . . . . . . . . . . . ... L. 59
4.7.1 Flottant d’Algorithm2e . . . . . . .. .. ... ... ... ... 59
4.7.2 Légendes bilingues (multilingues) . . . . . ... ... ... .. 59
4.7.3 Numérotation des figures par section . . . . . . .. ... ... 59
4.7.4 Numérotation des tableaux par section . . . . .. . . ... .. 59
Notes de bas de page et notes en fin de document . . . . . . .. . .. 60
4.8.1 Notes en fin de document (basiques) . . . ... ... ... .. 60
4.8.2 Notes en fin de document (étendues) . . . .. ... ... ... 60

4.8.3 Notes de bas de page renvoyées en fin de document (basiques) 60
4.8.4 Notes de bas de page renvoyées en fin de document (étendues) 60

Loisirs, sport et musique . . . . . . . . .. ... L. 61
4.9.1 Echiquier . . ... . ... ... 61
4.9.2 Notation du format musical Lilypond . . . . . . . . . ... .. 61
Améliorations des listes . . . . . . . . ... oL 61
4.10.1 Listes personnalisables . . . . . . ... ... ... ... .... 61

4.10.1.1 Paramétrage des énumérations . . . . . . . . .. .. 61

4.10.1.2 Paragraphes numérotés dans les rapports . . . . . . . 62

4.10.1.3 Reprise d’énumération . . . . . . . . ... ... L. 62

4.10.1.4 Espacement dans les listes . . . . . . ... ... ... 63

4.10.1.5 D’autres personnalisations . . . . . . . . . ... ... 63
4.10.2 Listes de paragraphe . . . . . . . .. . ... ... ... ... 64
Programmation littéraire . . . . . . . . .. ..o 64
4.11.1 Noweb . . . . . . . . e 64
411.2 Row (knitr) . . .. ..o 64
4.11.3 Sweave . . . . ... 64
Maths . . . . . o 65
4.12.1 Théoremes AMS . . . . . . . ... ... .. ... ... 65
4.12.2 Théoremes AMS (étendu) . . . .. ... ... ... .. 65
4.12.3 Théoremes AMS (étendu, numérotation par type et par chapitre) 65
4.12.4 Théoréemes AMS (étendu, numérotation par type) . . . . . . . 65

vi



Table des matieres Table des matiéeres

4.12.5 Théoremes AMS (numérotation par type et par chapitre) . . . 66
4.12.6 Théoréemes AMS (numérotation par type) . . ... .. .. .. 66
4.12.7 Numéroter les équations par section . . . . . . . . . ... ... 66
4.12.8 Théoréemes standard . . . . . . . .. ... 66
4.12.9 Théorémes standard (nommables) . . . . . . . ... ... ... 67
4.12.10 Théorémes standard (numérotés par chapitre) . . . . . . . .. 67
4.12.11 Théorémes standard (numérotation par section) . . . . . . . . 67
4.12.12 Théorémes standard (numérotation par type et par chapitre) . 67
4.12.13 Théorémes standard (numérotation par type et par section) . 67
4.12.14 Théoremes standard (numérotation par type) . . ... .. .. 68
4.12.15 Théoremes standard (non numérotés) . . . . . . . . .. .. .. 68
4.12.16 Sous-équations . . . . . ... 68

4.13 Formatdelapage . . . . . . . . . ..o o 68
4.13.1 Personnalisation en-tétes/pieds de page . . . . . . . .. .. .. 68
4.13.1.1 En-tétes et pieds de page sur mesure . . . . . . . .. 69

4.13.2 Parties du document en format paysage . . . . . . . . . .. .. 70
4.13.3 Multi-colonnes . . . . . ... oo 70
4.13.3.1 Lesbases . . .. .. ... ... ... .. 71

4.13.3.2 Des colonnes dans des colonnes . . . . ... ... .. 73

4.13.3.3 Exemples plus compliqués . . . . . . . ... ... .. 73

4.13.3.4 This is a subsubsection heading as a preface . . . . . 74

4.14 Styles de paragraphe . . . . . . ... ..o 78
4.14.1 Paragraphes de forme inhabituelle . . . . . . .. .. .. .. .. 78
4.14.1.1 Formes prédéfinies . . . . . ... .. ... ... ... 78

4.14.1.2 Formes personnalisées . . . . . . . . ... ... ... 81

4.14.2 Paragraphes en renfoncement . . . . . . ... ... ... .. 82
4.14.3 Initiales (lettrines) . . . . . . ... ... ... L. 83

4.15 Balisage dutexte . . . . . . . .. . 83
4.15.1 Balisage du texte césurable (soul) . . . . ... ... ... ... 83
4.15.2 Balisage logique . . . . . . . .. ... 83

5 Personnaliser une bibliographie avec BibTEX ou Biblatex 85
5.1 Autres styles de citation . . . . ... ..o L 85
5.2 Bibliographies subdivisées . . . . . .. ... . oo 86
5.3 Bibliographies multiples . . . . . . ... ... ... .. 87
6 Choix de puces dans ListePuces 89
6.1 Introduction . . . . . . . . ... 89
6.2 A quoi elles ressemblent . . . ... 89
6.3 Comment s’en servir . . . . . . ... 90
7 Outils supplémentaires 91
7.1 Documents en plusieurs fichiers . . . . . . .. ... ... ... .. .. 91
7.1.1 Généralités . . . . . .. 91

vii



Table des matiéres

Table des matieres

7.2

7.1.2 Références croisées entre fichiers . . . . . . ... ... ... ..
7.1.3 Listes bibliographiques dans tous les sous-documents . . . . .
Archives IyX . . . . o Lo

8 LyX et le Web

8.1
8.2
8.3
8.4

Formules mathématiques en XHTML . . . . ... ... ... ... ..
Bibliographie et citations . . . . . ... ..o
Index . . . . . . .
Nomenclatures et glossaires . . . . . . . . . ... ... ... ...

9 Exportation DocBook

10 Le Serveur LyX

10.1
10.2
10.3

10.4

10.5
10.6

10.7

Introduction . . . . . . ..o
Démarrer le Serveur LyX . . . . ..o L0000
Communication normale . . . . . . ... ... ... ...
10.3.1 AppleScript (Mac OSX) . . . . . . . ... ... ... .. ...
Notification . . . . . . . . . .
Le protocole serveur LyX . . . . ..o o Lo
Recherche inversée DVI/PDF . . . . . ... ... ...
10.6.1 Activation automatique . . . . . . . .. .. ... L. L.
10.6.2 Activation manuelle . . . . . . .. ... ... L.
10.6.3 Configuration et utilisation de visionneuses particulieres

Recherche directe . . . . . . . . . ... o

11 LyX et applications externes

11.1

11.2

Correcteur TEX . . . . . . . .
11.1.1 Imtroduction . . . . . . . . . . . ...
11.1.2 Comment l'utiliser . . . . . ... .. ... ... ... ..
11.1.3 Réglages fins . . . . . . . . ...
Controle de version sous IyX . . . . . ..o o o000
11.2.1 Introduction . . . . . . . . . .. ...
11.2.2 Les commandes RCS sous Ly X . . . . .. ... .00
11.2.2.1 Initialiser le contrdle de version . . . . . .. .. ...
11.2.2.2 Enregistrer les changements . . . . . . . ... .. ..
11.2.2.3 Nouvelle version modifiable . . . . . . . .. ... ..
11.2.2.4 Revenir a la version du dépot . . . . . . . .. .. ..
11.225 Copy . - v o v v o e
11.2.2.6 Annuler le dernier enregistrement . . . . . . . .. ..
11.2.2.7 Visionner historique . . . . . . . ... ... ... ..
11.2.2.8 Informations de révision . . . . . . . . . ... .. ..
11.2.3 CVScommandsin Iy X . . . .. . ..o 000000
11.2.3.1 General CVSusage . . . . . . ... ... ... ....
11.2.3.2 Register . . . . . . .. ...

viii

95
96
98
99
99

101

103
103
103
104
104
105
105
105
106
106
108
111



Table des matieres Table des matiéeres

11.2.3.3 Check In Changes . . . . .. ... ... ... .... 120
11.2.3.4 Check Out Changes . . . .. ... ... ... .... 121
11.2.3.5 Revert To Repository Version . . . . . ... ... .. 121
11.23.6 Copy . . - o v o v o i 121
11.2.3.7 Rename . . . . . . . . . . . ... ... 121
11.2.3.8 Update of the local directory checkout from repository 122
11.2.3.9 Show History . . . . .. ... ... ... ... .... 122
11.2.3.10 Revision info . . . . . . ... ... ... ... 122
11.2.4 SVN commands in IyX . . . . .. ..o 122
11.2.4.1 Register . . . . . . .. . L 123
11.2.4.2 Check In Changes . . . . .. .. ... .. .. .... 123
11.2.4.3 Check Out For Edit . . . ... ... ... ...... 123
11.2.4.4 Revert To Repository Version . . . . . . . ... ... 123
11245 Copy . . o v v v o s 123
11.2.4.6 Rename . . . . . . . . . . ... ... ... ... ... 124
11.2.4.7 Update of the local directory checkout from repository 2124
11.2.4.8 Show History . . . . . . ... .. ... . ... .... 124
11.2.49 File Locking . . . . . . .. .. ... 0. 125
11.2.4.10 Automatic Locking Property . . . . . ... ... .. 125
11.2.4.11 Revision Information in Documents . . . . . . . . .. 125
11.2.5 SVN and Windows Environment . . . . . . ... .. ... .. 126
11.2.5.1 Preparation . . . . . . . . .. ... ... ... 127
11.2.5.2 Bringing a document under Subversion control . . . . 127
11.2.5.3 SSH tunnel used with SVN under Windows . . . . . 128
11.2.5.4 End-of-Line Conversions . . . . . . . . .. ... ... 128
11.2.6 Les commandes GIT sous Ly X . . . . . .. ... ... ... .. 128
11.2.6.1 Initialiser le contréle de version . . . . . . ... ... 129
11.2.6.2 Enregistrer les changements . . . . . . . . ... ... 129
11.2.6.3 Revenir a la version du dépot . . . . . . . ... ... 129
11.2.6.4 Renommer . . . . . . .. .. ... .. ... ..., 130
11.2.6.5 Afficher I'historique . . . . . . . . . .. .. ... ... 130
11.2.6.6 Infos deversion . . . . . ... .. ... ... ..... 130
11.2.7 Personnalisation avancée . . . . . . . . . ... ... ... ... 130
11.2.8 Controle de version et comparaison de documents . . . . . . . 130
11.3 Programmation littéraire . . . . . . . . . .. ..o 131
11.3.1 Introduction . . . . . . . . .. ... ... 131
11.3.2 La programmation littéraire . . . . . . . . . . .. .. ... .. 131
11.3.2.1 Références . . . . . . . . . .. ... L. 132
11.3.3 LyX et la Programmation Littéraire avec Noweb . . . . . . . . 132
11.3.3.1 Génération des documents et du code (weaving and
tangling) . . . ... 133
11.3.3.2 Configurer IyX . . . . . . . ..o 135

2. Note that this command will work only with subversion = 1.5

X



Table des matiéres Table des matieres

11.3.3.3 Fonctions pour le déboguage . . . . . . . . . . .. .. 136

11.3.3.4 Ajouts a la barre d’outils . . . . .. ... ... ... 136

11.3.3.5 Couleurs personnalisées . . . . . . .. ... .. ... 137

11.3.4 IyX et knitr/Sweave . . . . . ... Lo 137

Index 139



1 Introduction

Le guide des Options avancées de IiyX que vous étes en train de lire est avant tout
la deuxieme partie du Guide de I’Utilisateur. La raison de la division en deux du do-
cument est tres simple : le Guide de I’Utilisateur est déja énorme et il contient toutes
les fonctions de base qu’il faut connaitre pour préparer la plupart des documents.
Cependant, 'Equipe de LyX a pour but a long terme de rendre LyX extensible par
différents fichiers de configuration et paquetages externes. Cela signifie que si vous
voulez utiliser le paquetage WTEX Fizzwizzle, vous pouvez créer un fichier de format
qui lui soit dédié sans modifier LyX lui-méme. Nous avons déja regu ainsi plusieurs
contributions, et certaines sont documentées ici. Il y a aussi quelques fonctionnalités
plus « avancées », comme les méthodes de présentation de bibliographies et la gestion
des documents éclatés en plusieurs fichiers, qui ne sont pas couverts par le Guide de
l'utilisateur et sont décrites ici.

Ce manuel décrit aussi quelques fonctions spéciales, comme la gestion d'un fax et
le contrdle de version, qui nécessitent des logiciels supplémentaires pour fonctionner
convenablement. Il y a également un chapitre consacré a Iy X et HT'ML. Et enfin, il
y a un chapitre sur les trucs et astuces KTEX, qui servent a améliorer vos documents
grace a la puissance de BTEX. Aprés tout, IyX est seulement WYSIWYM !, et ne
sera jamais qu’une interface a certaines des fonctions de IXTEX.

Si vous n’avez pas encore lu I'Introduction, il est stir que vous n’étes pas au bon
endroit. L’ Introduction est la premiere chose a consulter, car elle décrit les notations
et les formats de tous les manuels. Vous devez aussi étre a 1'aise avec le Guide de I’ Uti-
lisateur et avec toutes les fonctions de base de LyX.

Comme tous les sujets couverts par ce manuel dépendent étroitement de l'interac-
tion de Ly X avec IXTEX, le premier chapitre traite du fonctionnement interne de IyX
et explique comment LyX peut générer exactement le code ETEX que vous désirez.
Il est évidemment destiné a des utilisateurs aguerris de IyX.

Avertissement : dans le document, on utilise « graphique » en tant que raccourci
de « objet graphique » : graphique, diagramme, image, schéma, etc.

1. « What You See Is What You Mean » : « Vous voyez ce que vous voulez dire ».






2 LyX et IATEX

2.1 Comment LyX utilise BTEX

Ce chapitre est a la fois pour les TEX-niciens et les curieux de KTEX. Nous allons
y expliquer comment [xX et IXTEX fonctionnent ensemble pour produire une sortie
imprimable. C’est le seul endroit de tous ces manuels ol nous présumons que vous
connaissez quelque chose a XTEX.

A un moment, nous avions coutume d’appeler LyX une « interface WYSIWYM
pour BTEX », mais ce n’est plus vrai désormais. Des interfaces pour BTEX existent.
Ce sont basiquement des éditeurs avec la possibilité de faire tourner ETEX et de
marquer les erreurs dans le fichier que vous éditez. Bien que LyX soit un éditeur, et
qu’il fasse tourner WIEX, et qu’il marque aussi les erreurs dans le fichier, il fait aussi
beaucoup, beaucoup d’autres choses. Grace au concept WYSIWYM, vous n’avez pas
besoin de connaitre IXTEX pour utiliser [y X efficacement. Iy X a aussi ajouté quelques
extensions a KTEX. Essayez un jour ceci : faites Fichier>Exporter>LaTeX, (ou bien
Affichage > Afficher le code LaTeX) puis regardez le préambule du fichier .tex obtenu.
Vous remarquerez une variété de nouvelles macros définies spécialement par LyX.
Ces macros sont définies automatiquement, en fonction de ce que vous utilisez dans
le document.

Il y a plusieurs commandes qui invoquent ETEX automatiquement. Ce sont :

— Document > Visionner

— Document > Mettre a jour
Elles n’invoqueront IXTEX que si le fichier a changé depuis la derniere fois que KTEX
I’a traité.

Quand vous faites tourner KTEX sur le fichier que vous éditez, Ly X réalise les étapes

suivantes :

1. I convertit le document en I¥TEX et I'enregistre dans un fichier avec I'extension
.tex au lieu de .1lyx.

2. Il fait tourner IXTEX sur le fichier .tex (peut-étre plusieurs fois) et exécute toute
autre commande (comme bibtex ou makeindex) nécessaire a la compilation du

fichier KTEX.
3. S’il y a des erreurs, il affiche le journal d’erreurs.

Si vous avez lancé KTEX avec Document> Visionner> DVI, Ly X exécute alors xdvi sur
le fichier DVI. Si vous avez utilisé Document > Visionner > PostScript, Ly X réalise deux
étapes supplémentaires :
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— il fait tourner dvips pour convertir le fichier DVI en PostScript ;

— il exécute une visionneuse PostScript, comme ghostview, pour afficher le ré-
sultat.

LyX procede de maniere similaire pour afficher ou exporter d’autres formats.

2.2 Traduire des fichiers BETEX en LyX

Vous pouvez importer un fichier TEX dans LyX en utilisant le menu Fichier >
Importer>LaTeX de LyX. Cela va appeler un programme nommé tex2lyx, qui va
créer un fichier toto.lyx a partir du fichier toto.tex. LyX va ensuite ouvrir ce
fichier.

tex21yx peut traduire la plupart des constructions KTEX légales, mais pas toutes.
Ce qu’il ne parviendra pas a comprendre, il le laissera mode TEX, ce qui fait qu’apres
avoir traduit un fichier avec tex2lyx, vous pouvez rechercher les portions en code TEX
et les corriger manuellement.

Si vous ignorez ce qu’est le code TEX, lisez le paragraphe suivant.

2.3 Insérer du code BTEX dans des documents LyX

Vous pouvez faire en [y X tout ce que vous faites en IXTEX, pour une raison tres
simple : vous pouvez toujours insérer du code KTEX dans un document IxX. [xX
ne peut tout simplement pas, et ne pourra probablement jamais, afficher toutes les
structures KTEX possibles. Si vous avez besoin d’insérer des commandes KTEX dans
votre document [yX, vous pouvez utiliser la boite de code T, que vous pouvez
mettre dans votre document avec Insertion>Code TeX.

Voici un exemple d’insertion de commandes KTEX dans un document LyX. Le code
ressemble a ceci :

\begin{tabular}{11}

\begin{minipage}{5cm}

Un exemple d’environnement minipage. Vous pouvez
mettre presque tout dedans, m\~eme des figures
et des tableaux (non flottants).
\end{minipage}

&

\begin{minipage}{5cm}

\begin{verbatim}

\begin{minipage}{5cm}

Un exemple ...

\end{minipage}

\end{verbatim}

\end{minipage}

\end{tabular}
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La boite de code TRX contenant ce texte est juste apres ce paragraphe. Ceux d’entre
vous qui lisent le manuel en ligne verront seulement un paquet de texte en rouge.

Ceux qui lisent une version imprimée du manuel verront le résultat final :
Un exemple d’environne-

ment minipage. Vous pou-
vez mettre presque tout
dedans, méme des figures
et des tableaux (non flot-
tants).

En plus de I'utilisation du code TgX, vous pouvez aussi créer un fichier séparé conte-
nant une structure IXTEX complexe. Vous pouvez alors utiliser Insertion> Fichier>
Sous-document pour inclure votre fichier (vous devez choisir le type Incorporé (in-
put)). Nous vous recommandons de ne faire cela que si vous avez un fichier .tex dont
vous savez déja qu’il marche. Sinon, vous allez avoir du mal a partir a la chasse aux
erreurs...

\begin{minipage}{5cm}
Un exemple ...
\end{minipage}

Encore quelques notes pour insister :

— au sein de IyX, le code IXTEX apparait en rouge;
— Iy X ne vérifie pas si votre code KIEX est correct ;
— attention a ne pas réinventer la roue.

Sur ce dernier point, [y X dispose déja de pas mal de possibilités, et encore plus sont
en préparation. Assurez-vous de vérifier dans les manuels que Iy X n’a pas déja telle
ou telle fonction avant de vous lancer joyeusement dans 1’écriture de code IKTEX. De
plus, il existe beaucoup de paquetages IXTEX pour faire toutes sortes de choses, des
étiquettes et enveloppes aux tableaux sur plusieurs pages. Voyez un site du CTAN
pour plus de détails.

Si vous avez effectivement besoin de faire quelque chose de bizarre avec votre docu-
ment, référez-vous a un bon livre sur ETEX pour avoir de I'aide. Un certain nombre
sont cités dans la bibliographie du Guide de [’Utilisateur.

2.4 LyX et le préambule BPTEX

2.4.1 A propos du préambule BTEX

Si vous connaissez déja BIEX, il n’y a pas besoin d’expliquer ici a quoi sert le
préambule. Si vous ne le connaissez pas, ce qui suit vous en donnera une idée — nous
vous recommandons encore de consulter un livre sur KTEX pour plus d’information.
Dans tous les cas, il vaut mieux lire les points ci-dessous, parce qu’ils expliquent ce
que vous pouvez faire et ce que vous n’avez pas besoin de faire dans le préambule
KETEX d’un document LyX.

Le préambule IXTEX vient au tout début d’'un document, avant le texte. Il sert a :

— déclarer la classe de document. Iy X I'a déja fait a votre place.
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Si vous étes un IXTEX-nicien expérimenté, et que vous avez une classe de do-
cument particuliere dont vous voulez vous servir, voyez le manuel de Person-
nalisation pour savoir comment la faire reconnaitre par IyX. Puis soumettez
le fruit de vos efforts a I’équipe LyX pour que cela paraisse dans de prochaines
versions !

— déclarer les paquetages utilisés. Les paquetages KIEX fournissent des com-
mandes spéciales, qui sont disponibles dans un document seulement si le paque-
tage a été déclaré dans le préambule. Par exemple, le paquetage indentfirst
force I'indentation de tous les paragraphes. Il y a d’autres paquetages pour des
étiquettes, des enveloppes, des marges, etc.

— fixer les compteurs, variables, longueurs et largeurs. Il y a plusieurs compteurs
et variables IXTEX qui doivent étre fixés globalement depuis le préambule afin
d’avoir Deffet désiré. (Il y a aussi d’autres variables que vous pouvez ajuster
dans le document.) Les marges sont un bon exemple de ce qui doit étre fixé
dans le préambule. Un autre exemple est le type de marqueur pour les listes.
Vous pouvez en fait régler cela n’importe ou, mais il est préférable de le faire
une seule fois, dans le préambule.

— déclarer les commandes définies par 1'utilisateur (avec \newcommand ou \renewcommand),
pour la plupart ce sont des abréviations pour des commandes I¥TEX qui appa-
raissent tres souvent dans le document. Bien que le préambule soit un bon
endroit pour déclarer de telles commandes, elles peuvent étre définies n’importe
ou ailleurs (mais avant d’étre utilisées pour la premiére fois, bien siir...). Ce
peut étre utile s’il y a beaucoup de code IXTEX brut dans votre document, ce
qui normalement ne devrait pas étre le cas.

LyX ajoute son propre lot de définitions au préambule du fichier .tex qu’il engendre.
Ceci rend les fichiers KTEX générés par LyX portables.

2.4.2 Changer le préambule

Les commandes que IyX ajoute au préambule d'un fichier ETEX sont détermi-
nées ; vous ne pouvez pas les changer sans modifier les sources de IyyX. Vous pouvez
toutefois ajouter vos propres commandes au préambule en sélectionnant Document >
Parametres > Préambule IATEX. Ly X ajoute tout ce qu’il y a dans la fenétre Préam-
bule BTEX & son propre préambule. Avant d’ajouter vos propres déclarations, vous
devriez vous assurer que LyX ne fait pas déja ce que vous voulez faire (rappelez-
vous ce que nous avons dit : ne réinventez pas la roue!). Assurez-vous aussi que
votre préambule est correct. IiyX ne le vérifie pas. S’il y a une erreur, vous risquez de
voir apparaltre un message d’erreur comme « Missing \begin{document} ». Si vous
voyez ce message, vérifiez votre préambule.
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2.4.3 Exemples

Voici quelques exemples de ce que vous pouvez ajouter au préambule, et de 'effet
produit :

2.4.3.1 Exemple 1 : Décalages

Il y a deux variables dans IXTEX qui controlent la position de la page : \hoffset
et \voffset, c’est-a-dire décalage horizontal et décalage vertical. Ces variables sont
utiles si vous pensez par exemple a l'impression d’étiquettes. Parfois, la taille d’un
médium d’impression et 'aire effectivement imprimable ne sont pas les mémes. C’est
la qu’interviennent \hoffset et \voffset.

Les valeurs par défaut de \hoffset et \voffset sont toutes deux de 0 pt, c’est-a-
dire que la page n’est pas décalée.

Malheureusement, quelques pilotes DVI semblent toujours décaler la page. Nous
ne savons pas pourquoi, ni pourquoi ’administrateur systéme n’a pas corrigé un tel
comportement. Si vous utilisez IyX sur un systeme que vous n’entretenez pas vous-
méme, et si votre administrateur systéme est un paresseux !, \hoffset et \voffset
peuvent sauver la mise. Supposez que vos marges du haut et de gauche soient toujours
0,5 pouce trop grandes. Vous pouvez ajouter ceci au préambule :

\setlength{\hoffset}{-0.5 in}
\setlength{\voffset}{-0.5 in}

...et vos marges devraient désormais étre correctes.

2.4.3.2 Exemple 2 : Etiquettes

Supposez que vous vouliez imprimer un paquet d’étiquettes d’adresse. Il y a un pa-
quetage plutét sympathique, disponible a votre archive CTAN la plus proche, pour
imprimer des feuilles d’étiquettes, appelé labels.sty. Il est possible que votre sys-
teme n’ait pas ce paquetage installé par défaut. Nous vous laissons le vérifier. Il vous
faut aussi lire sa documentation ; nous n’allons pas le faire a votre place. Toutefois,
comme c’est un exemple, nous allons vous montrer comment il marche.

D’abord, assurez-vous que vous utilisez la classe de document article. Ensuite, vous
devez ajouter ce qui suit dans votre préambule :

\usepackage{labels}
\LabelCols=3
\LabelRows=7
\LeftBorder=8mm
\RightBorder=8mm
\TopBorder=9mm
\BottomBorder=2mm

1. NdT : Traduction vraisemblable de « your sysadmin is a doofus ».
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Ceci est la configuration pour des feuilles d’étiquette Avery, référence #5360. Vous
étes maintenant prét a imprimer des étiquettes, mais si vous devez insérer du code
KTEX, placez les commandes \begin{labels} et \end{labels} autour de chaque
étiquette. C’est expliqué dans la documentation du paquetage, ainsi que d’autres
fonctions de celui-ci.

Un jour, quelqu’un écrira peut-étre une fonction de IyX pour supporter directement
ce paquetage. Peut-étre méme que ce sera vous.

2.4.3.3 Exemple 3 : Indentation de paragraphe

Les Américains ont I’habitude d’indenter la premiere ligne de chaque paragraphe.
Comme avec toutes leurs autres moeeurs étranges, la plupart des Américains vont
se plaindre et récriminer jusqu’a ce qu’ils aient ce qu’ils veulent, et qu’ils puissent
indenter la premiere ligne de chaque paragraphe.

Bien siir, cette habitude n’est pas typographiquement correcte. Dans des livres,
vous n’indentez en général la premiere ligne d’un paragraphe que s’il en suit un
autre. L’idée derriere l'indentation de la premiere ligne est de pouvoir distinguer
deux paragraphes consécutifs. S’il y a pas de paragraphe précédent, par exemple s’il
suit une figure, ou si c’est le premier paragraphe d’une section, alors il n’y a pas
d’indentation spéciale.

Si vous &tes un Américain typique 2, cependant, vous ne vous occupez pas de choses
aussi ésotériques ; vous voulez votre indentation! Ajoutez ceci au préambule :

\usepackage{indentfirst}

Si votre distribution TEX n’est pas un vieux coucou, vous avez ce paquetage, et tous
vos paragraphes auront l'indentation que vous pensez qu’ils méritent.

2.4.3.4 Exemple 4 : Ce document

Vous pouvez aussi aller voir le préambule de ce document pour avoir une idée de
certaines possibilités avancées. La fenétre Préambule IATEX risque de ne pas étre visible
en une fois, méme en plein écran.

2.5 LyX et les erreurs BTEX

Quand IyX invoque KETEX, il lui dit d’ignorer toute erreur et de continuer. Il se
sert ensuite du fichier log de XTEX pour en faire 'autopsie. S’il y a une erreur quelque
part, [y X ouvre une boite avec un listing d’erreurs. Cliquer sur I'une d’elles déplace
le curseur a I'emplacement approprié¢ dans le document 3.

2. NdT : Ce qui m’étonnerait, mais on ne sait jamais!
3. LyX fera occasionnellement des déductions fausses sur I’emplacement de l’erreur. Ca arrivera
surtout dans les tableaux, les figures, les math et le préambule.
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Quelques-uns préferent regarder le fichier journal directement, il est accessible par
Document Fichier journal LaTeX. Il y a quelques erreurs et avertissements assez fré-
quents. Nous allons les traiter ici. Vous devriez vous reporter a un bon livre sur IXTEX
pour une liste complete.

— « LaTeX Warning »

Tout ce qui commence par ces mots est un message d’avertissement destiné a
« déboguer » le code IXTEX lui-méme. Vous aurez des messages de ce type si vous
avez ajouté ou changé des références croisées ou des entrées de bibliographie,
auquel cas BKTEX essaye de vous dire que vous devez l'exécuter une nouvelle
fois.

Vous pouvez en général les ignorer.

— « LaTeX Font Warning »

Un autre message d’avertissement, cette fois au sujet de polices que KITEX n’a
pas trouvées. Le reste du message indiquera souvent la police de substitution
que KTEX a choisi.

Vous pouvez les ignorer sans crainte.

— « Overfull \hbox »

ETEX adore cracher ce genre de messages. Il engendre apparemment au moins
un message de ce type pour n’importe quel document que vous écrivez. Ces
messages vous préviennent que les lignes sont trop longues et débordent sur
la marge de droite. Ceci se produit si E'TEX ne trouve pas comment couper
les lignes de maniére raisonnablement correcte (notoirement avec une police a
chasse fixe, du fait que cette police ne permet pas trouver les points de cé-
sure automatiquement). Dans de nombreux cas, c¢’est impossible & déceler dans
le rendu final (ce peut étre un point ou deux). Parfois cependant, les lignes
débordent visiblement dans la marge, et c’est quelque chose que vous ne sou-
haiterez pas voir dans votre impression finale.

Il y a plusieurs solutions pour minimiser 'effet de ces débordements. Cocher Ac-
tiver les fonctionnalités micro-typographiques dans Document > Paramétres > Polices
peut déja améliorer significativement les choses. Par ailleurs, un code KTEX tel
que celui qui suit, inséré dans Document > Parametres> Préambule réduit d’ha-
bitude massivement les débordements de ligne (ce code est inséré dans le pré-
ambule du présent document) :

\tolerance 1414
\hbadness 1414
\emergencystretch 1.5em
\hfuzz 0.3pt

Dans certains, cependant, vous devrez finalement réécrire le texte pour obtenir
des césures correctes .

4. Pour les détails , voir http://www.tex.ac.uk/FAQ-overfull .html
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Dans tous les cas, il faut vérifier les lignes concernées, au plus tard avant ’édition
de la version finale du document. Vos yeux vous diront s’il y a un probleme avec
un espacement trop grand ®.

— « Underfull \hbox »

Pas aussi courant que son cousin. Ceci de produit si IXTEX ne trouve pas de
point de césure raisonnable et par conséquent crée des lignes trop aérées. Comme
précédemment, vérifiez si cela se voit.

— « Overfull \vbox » et « Underfull \vbox »

Des avertissements sur des problemes de saut de page. A nouveau, vous n’avez
qu’a regarder ce qui sort. Vous verrez bien si quelque chose ne va pas.

— « LaTeX Error: File ’Xxxx’ not found »

Le fichier « Xxxx » n’est pas présent sur ce systeme. Ceci apparait habituel-
lement parce qu’'un paquetage nécessaire a votre document n’est pas installé.
Si vous n’avez pas touché au préambule ou si vous n’avez pas utilisé la com-
mande \usepackage{}, alors un des paquetages que LyX a essayé de charger
est manquant. Faites Aider> Configuration IKTEX pour voir la liste des paquetages
dont LyX a entendu parler. Ce fichier est mis a jour a chaque fois que vous
reconfigurez LyX (avec Outils>Reconfigurer) et vous dit quels paquetages ont
été détectés et a quoi ils servent.

Si vous avez utilisé la commande \usepackage{}, et que le paquetage en ques-
tion n’est pas installé, vous devez l'installer vous-méme.

— « LaTeX Error: Unknown option »

Les messages d’erreur commencant ainsi essayent de vous dire que vous avez
spécifié une option impossible ou inexistante dans un paquetage. Vérifiez dans
sa documentation.

— « Undefined control sequence »

Si vous avez inséré du code KTEX dans votre document, et fait une faute de
frappe, vous aurez un de ceux-la. Vous pouvez aussi avoir oublié de charger un
paquetage. Dans tous les cas, d’habitude ce message d’erreur veut dire que vous
avez utilisé une commande inconnue.

Il y a d’autres messages d’erreur et d’avertissement. Quelques-uns sont explicites ©.
Ce sont souvent des messages KTEX. D’autres sont carrément incompréhensibles. Ce
sont en fait des messages d’erreur TEX, et nous n’avons vraiment aucune idée de ce
qu’ils signifient ou de comment les déchiffrer. Personne ne le sait.

Voici une liste de vérifications a effectuer si vous étes confronté a des messages
d’erreur :

1. cherchez d’éventuelles fautes de frappe dans le code KTEX que vous avez inséré ;

5. Vous pouvez aussi activer I'option « draft » dans les options de classe via DOCUMENT >
PARAMETRES > CLASSE DE DOCUMENT : IATEX tracera une barre noire dans la marge des lignes qui
débordent.

6. NdT : Pour un anglophone...
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2. s’il n’y a pas de fautes de frappe, vérifiez que vous avez utilisé les commandes
correctement ;

3. si vous avez un paquet de boites d’erreur entassées tout en haut du document
— et surtout si vous voyez « Missing \begin{document} », ca veut dire qu’il
y a des erreurs dans le préambule. Commencez par corriger votre préambule ;

4. si vous n’avez rien ajouté au préambule et si vous n’avez pas ajouté de code
ETEX au document, le suspect numéro un est votre distribution ETEX elle-
méme. Vérifiez s’il manque des paquetages et rajoutez-les;

5. tres bien, il ne manque aucun paquetage. Avez-vous utilisé une des options de
réglage fin de IyyX ? Plus précisément, avez-vous mal utilisé I'une d’entre elles,
en essayant par exemple d’insérer manuellement des tas d’Espaces Insécables,
de sauts de paragraphe ou de sauts de page? Avez-vous essayé de bricoler
quelque chose avec tout ¢a au lieu d’utiliser les environnements de paragraphe
appropriés 7

6. d’accord, vous n’avez utilisé aucune des options de réglage fin, vous avez joué
dans les regles. Avez-vous essayé une manceuvre bizarre ? Avez-vous fait quelque

chose de pas net dans un tableau ou une équation, comme insérer un graphique
dans une case de tableau?

7. Avez-vous de longues portions de texte dans lesquelles IXTEX ne peut pas trouver
d’endroit ou passer a la ligne ? Par défaut, KTEX est assez strict avec la quantité
d’espace entre les mots qu’il va ajouter pour passer a la ligne. Il est alors
préférable que vous retravailliez le paragraphe pour éviter le probleme.

8. avez-vous exagéré avec 'imbrication? Ly X (actuellement) ne vérifie pas que
vous restez dans les limites de 'imbrication d’environnements. Si vous avez
imbriqué un tas d’environnements jusqu’au 17¢ niveau, le probleme est la;

9. vous n’avez obtenu aucun message d’erreur, mais votre rendu ne ressemble pas
a grand chose. Si vous avez un tableau ou une figure qui est trop large ou trop
haute pour la page, vous devez :

a) mettre la figure a 1’échelle pour qu’elle tienne.
b) rétrécir le tableau pour qu’il tienne.

10. Si quelque chose d’autre ne va pas avec le rendu, et que vous n’avez rien essayé
de bizarre ni bricolé avec les réglages fins, nous ne savons pas trop ce qui cloche.

Si vous n’étes pas plus avancé avec tout ceci — et bien, peut-étre que vous avez trouvé
une erreur dans LyX. ..
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3 Classes de document

Comme il est précisé dans le Guide de l'utilisateur, E'TEX fournissait a 1’origine
quatre classes de document standard, a savoir article, rapport, livre et lettre, mais
des particuliers et des organisations (surtout dans les premiers temps la Société Amé-
ricaine de Mathématiques -— AMS) ont ajouté de nombreuses contributions pour élar-
gir le nombre de classes de document. Dans ce chapitre nous reprenons les classes
principales maintenues par des organisations externes, dont quelques unes sont mar-
quées « Indisponible : » en gris léger dans le menu déroulant Classe de document de la
page Documents> Parameétre > Classe de document et que vous devrez installer comme
indiqué au chapitre Installer de nouvelles classes du Manuel de personnalisation si
vous voulez les utiliser.

3.1 Collections

3.1.1 AMS-ETEX (American Mathematical Society)

Les classes de document American Mathematical Society (AMS) dans la catégorie
Articles et American Mathematical Society (AMS) dans la catégorie Livres sont tenues
a jour par la Société : I'utilisation en est décrite dans le manuel de Maths et sur leur
site web http://www.ams.org/publications/authors/tex/amslatex. Le résumé
ci-apres a été écrit a l'origine par DAVID JOHNSON et mis a jour par RICHARD
KIMBERLY HECK et ’équipe LyX.

Les formats IXTEX AMS ont été écrits pour se conformer au style suggéré pour les
articles mathématiques a soumettre aux publications de I’American Mathematical
Society. Les formats ne sont pas définis pour une revue particuliere, mais peuvent
facilement y étre adaptés. Il faut vous référer a la documentation de '’AMS pour
obtenir des instructions spécifiques a chaque revue (habituellement il suffira de chan-
ger une ligne dans la sortie TEX). Cette documentation est disponible sur le réseau
a http://www.ams.org ou par ftp a ftp://ftp.ams.org/pub/tex/amslatex/. Ces
formats sont appropriés, et utiles, pour tout écrit mathématique.

Il y a actuellement 3 formats KTEX AMS de base distincts :

1. amsart : le format standard d’article AMS, voir Fichier>QOuvrir un Exemple>
Articles> American Mathematical Society (AMS);

2. amsbook : le format standard de livre AMS (en réalité de monographie), voir
Fichier > Ouvrir un Exemple > Livres> American Mathematical Society (AMS) ;

3. amsproc : le format standard AMS pour les actes de congres ou assimilés.
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LyX ne connait nativement que les deux premiers; voir le chapitre Installer de nou-
velles classes du manuel de Personnalisation si vous voulez utiliser amsproc.

Les formats eux-mémes ne contiennent qu’un minimum nécessaire pour I'utilisation
des classes AMS. Ils n’incluent pas en particulier d’environnements de « théoremes »
pour les théoremes, les lemmes, et similaires. Ceux-ci sont fournis par le module
THEOREMES (AMS), chargé implicitement lorsqu’une classe AMS est sélectionnée (il
peut étre utilisé également avec d’autres classes et peut étre enlevé, si vous souhaitez
utiliser autre chose). Les environnements contenus dans Théorémes AMS (é&tendu),
moins fréquemment utilisés, doivent étre chargés manuellement.

Implicitement, les théoremes et environnements similaires sont numérotés consé-
cutivement tout au long du document, mais ceci peut étre modifié en chargeant le
module Théorémes standard (numérotation par section) ou bien, si vous uti-
lisez la classe 1livres (AMS), le module Théorémes standard (numérotation par
chapitre). Ceux-ci vont numéroter les environnements comme n.m., ou le premier
nombre référe la section (ou le chapitre) et le second réfere le numéro d’ordre courant
dans la section (ou le chapitre). De nombreux environnements peuvent aussi rester
non numérotés, ceux-ci sont marqués par un astérisque. Si par hasard vous dési-
rez que tous les environnements soient non numérotés, utilisez le module Théorémes
standard (non numérotés).

Notez que ces modules ne doivent pas étre nécessairement utilisés avec les classes
AMS. Tl est parfaitement possible d’utiliser les modules Théorémes (AMS) et les
autres modules mentionnés ci-dessus avec d’autres classes, comme Article (classe
standard), Report (classe standard, Book KOMA-script, etc.

3.1.1.1 Ce qu’offrent ces formats

La liste des environnements offerts par ces formats est longue. Avec KTEX AMS il y
a la possibilité de définir une variété illimitée d’environnements de type « théoreme ».
Cependant, ’AMS recommande les environnements disponibles dans LyX.

Voici la liste des environnements ainsi que les environnements standard, comme
SECTION, BIBLIOGRAPHIE, TITRE, AUTEUR et DATE proposés par Article (AMS)
and Book (AMS) :

Adresse Ce devrait étre I'adresse permanente de l'auteur.

Adresse__Actuelle Ce devrait étre I'adresse temporaire de 'auteur au moment de la
soumission, si elle est différente de 1’Adresse ci-dessus.

Email L’adresse e-mail de I'auteur.
URL L’adresse de la page personnelle de I'auteur, s’il le souhaite.

Mots-clés Mots-clés ou descripteurs, utilisés pour identifier les sujets discutés dans
I’article.

Classe_Sujet Ceci fait référence a la Classification des Sujets de I’AMS, publiée et
décrite dans Mathematical Reviews. Elle est aussi disponible en ligne sur les
sites de ’AMS cités plus haut.
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Remerciements
Dédicace
Traducteur

Les environnements suivants sont fournis aussi bien par les modules Théorémes
standard que par les modules Théorémes (AMS), en version numérotée ou non nu-
mérotée pour ce dernier. Ces environnements sont fournis dans la seule version non
numérotée par le module Théorémes standard (non numérotés) :

Théoreme 1. Typiquement utilisé pour les résultats les plus importants.

Corollaire. Corollaire utilisé pour des assertions qui découlent assez directement
d’assertions précédentes. Peuvent étre également des résultats importants.

Lemme 2. Ce sont des résultats moins forts, nécessaires a la preuve d’autres asser-
tions.

Proposition 3. e sont des résultats moins importants qui apportent quelque chose a
la théorie générale dont il est question.

Conjecture 4. Ce sont des assertions fournies sans justification, dont l’auteur ne
connait pas de preuve, mais qui semblent vraies (du moins aux yeuzr de l'auteur).

Définition. Devinez a quoi ¢a sert. La police, a la fois a I’écran et a 'impression,
est différente dans cet environnement.

Exemple. Utilisé pour illustrer des résultats prouvés.

Probléme 5. On ne sait pas a quoi sert celui-ci, vous devriez chercher.

Exercice. Ecrire une description de celui-ci.

Remarque 6. Cet environnement est également un nouveau type de théoreme, habi-
tuellement une observation mineure.

Affirmation. Souvent utilisé dans le cours d’une preuve d’un résultat plus vaste.

Cas 1. En général, ils servent a diviser de longues preuves en examinant des cas
distincts.

Cas 2. Le schéma de numérotation des cas leur est spécifique : il n’appartient pas
a la méme séquence que les autres assertions.

Démonstration. A la fin de cet environnement est inséré un symbole CQFD (d’habi-
tude un carré, mais cela peut varier avec les différents styles). Si vous désirez avoir
d’autres environnements insérés dans celui-ci, et avoir le symbole CQFD tout a la
fin, il faut augmenter la profondeur de ceux-ci (voir la section Emboiter les environ-
nements dans le Guide de l'utilisateur). ]

Fait 7. Utilisé de la méme maniere que Proposition, quoique peut-étre a plus petite
échelle.
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Et ces environnements sont fournis par le module Théorémes AMS (étendu) :
Critere. Une condition requise.
Algorithme. Une procédure générale a utiliser.

Axiome. C’est une propriété ou assertion considérée comme vraie dans la théorie
dont il est question.

Condition. Utilisé parfois pour expliciter une condition admise dans le contexte de
la discussion.

Note. Note Typographie similaire a Remarque.

Notation. Comme son nom l'indique

Résumé 8. Utilisable comme Proposition, a une échelle peut-étre réduite

Conclusion. Utilisé parfois a la fin d'une argumentation
Hypothese. Hypothése
Question. Question

Il existe 10 modules mathématiques de plus incluant plusieurs options de numéro-
tation (Numérotés par type, ...).

En plus, ces environnements se servent automatiquement des paquetages de polices
AMS-ETEX et AMS. 11 faut qu’ils soient disponibles sur votre systéme pour pouvoir
utiliser ces environnements.

3.1.2 Tailles de police supplémentaires

La collection « Tailles de police supplémentaires » fournit les classes de document
article (avec les tailles de police supplémentaires), lettre (avec les tailles de police
supplémentaires), livre (avec les tailles de police supplémentaires) et rapport (avec les
tailles de police supplémentaires), qui utilisent respectivement les classes de document
article.cls, book.cls, letter.cls et report.cls mais offrent les tailles de base
supplémentaires 8, 9, 14, 17 et 20 dans la fenétre Document > Parametres > Polices.

3.1.3 Hébreu

Les classes de document Article hébreu et Lettre hébreu utilisent les classes de do-
cument article.cls et letter.cls pour faciliter 'utilisation de I’hébreu avec LyX.
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3.1.4 Japonais (classes standard)

LyX inclut une collection de paquets qui visent a faciliter la saisie des documents en
japonais. Les paquets ont été développés a différentes époques, de ce fait ils supportent
des moteurs de mise en page et des fonctionnalités différentes. La présente collection
est la plus ancienne. elle ajuste les classes standard IXTEX aux spécifications de la
mise en page du japonais, pour ’écriture horizontale ou verticale. La collection inclut
Article japonais (classe standard), Article japonais (classe standard, écriture verticale),
Livre japonais (classe standard) , Livre japonais (classe standard, écriture verticale),
Rapport japonais (classe standard), Rapport japonais (classe standard, écriture verti-
cale), qui fonctionnent toutes avec les moteurs « classiques » appropriés au japonais,
pETEX et upldTEX.

Pour T'utilisation avec le moteur plus récent Lual&TEX, la collection inclut éga-
lement les classes spécifiques Article japonais (classe standard pour LuaTeX), Article
japonais (classe standard pour LuaTeX, écriture verticale), Livre japonais (classe stan-
dard pour LuaTeX), Livre japonais (classe standard pour LuaTeX, écriture verticale),
Rapport japonais (classe standard pour LuaTeX) et Rapport japonais (classe standard
pour LuaTeX, écriture verticale) fournies par le paquetage IXTEX latexja.

Les modeles pour ces classes Lual&fTEX peuvent étre trouvés via Fichier>Nouveau
avec modele dans les catégories respectives (Articles, Livres ou Rapports).

3.1.5 Japonais (paquet JS)

Cette collection inclut des versions améliorées des classes de Japonais (classes stan-
dard) (voir 3.1.4). Elle contient Article japonais (paquet JS) et Livre japonais (paquet
JS). Une classe pour un rapport peut étre obtenue en utilisant Livre japonais (paquet
JS) avec l'option report dans Document>Parametresi> Classes de document> Options
de classer> Réglable. Toutes ces classes fonctionnent avec les moteurs « classiques »
adaptés au japonais, pIATEX et upldTEX.

Pour 'utilisation avec le moteur plus récent Lual&¥TEX, la collection inclut aussi les
classes spécifiques Article japonais (paquet JS pour LuaTeX), Livre japonais (paquet JS
pour LuaTeX), et Rapport japonais (paquet JS), fournies par le paquet I¥TEX luatexja.

Les modeles pour les classes Lual&TEX se trouvent via Fichier> Nouveau avec modele
dans leurs catégories respectives (articles, livres ou Rapports).

3.1.6 Japonais (paquet BX)

Ce paquet contient les classes de document Article japonais (paquet BX), Livre ja-
ponais (paquet BX), et Rapport japonais (paquet BX) qui fournissent des classes de
document autres pour les documents japonais. En outre, une classe Transparents ja-
ponais (paquet BX) pour créer des présentations est incluse. Au contraire des classes
de Classes standard et paquet JS (sec. 3.1.4 et 3.1.5), qui ne permettent d’utiliser direc-
tement que pIATEX et up A TEX (et LualATEX uniquement via les classes supplémentaires
fournies par le paquetage IXTEX luatexja), les classes de ce paquet peuvent étre utilisées
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avec pdfiiTEX, XeKTEX et LualfTEX directement, grace aux paquetages appropriés
permettant de typographier le japonais.

3.1.7 Japonais (classe JLReq)

Ce paquet émane de la classe jlreq qui est conforme aux standards des Spécifi-
cations pour la mise en page des textes en japonais, définies par le Consortium de
la Toile (W3C, voir https://www.w3.org/TR/jlreq/?lang=en). Il peut étre utilisé
avec LualiTEX aussi bien qu’avec pIATEX et up¥TEX.

LyX fournit des formats pour Article japonais (classe JLReq), Livre japonais (classe
JLReq), et Japanese Rapport japonais (classe JLReq), tous dérivés de la classe IXTEX jlreq
via des options de classe particuliéres.

Un exemple d’article est disponible via Fichier>Quvrir un exemple > Articles> Article
japonais (classe JLReq). La documentation en anglais est disponible ici : http://
mirrors.ctan.org/macros/jptex/latex/jlreq/jlreq.pdf.

3.1.8 Koma-Script

Original de BERND RELLERMEYER, mis a jour par JURGEN SPITZMULLER et
I’équipe LyX

3.1.8.1 En résumé

La collection de classes de document KOMA-Script est un développement des
classes Script créées par Frank Neukam au début des années 1990 : elle a été formelle-
ment publiée en 1994 avec 'ajout d’une classe lettre. Depuis une seconde classe lettre
a été incluse. Les classes de Frank Neukam s’inspirent des principes de la typographie
et ceci a été completement repris dans la conception des classes KOMA-Script.

Les classes de document Iy X Article KOMA-Script, Report KOMA-Script, Book
KOMA-Script, et Letter KOMA-Script correspondent respectivement aux classes
ITEX scrartcl.cls, scrreprt.cls, scrbook.cls et scrlettr.cls, de la famille
Koma-Script. Elles forment des alternatives aux classes standard, respectivement
article.cls, report.cls, book.cls et letter.cls et sont plus proches des conven-
tions typographiques européennes en un certain nombre de points :

— la taille de caractere standard est de 11 pt dans Article KOMA-Script, Report
KOMA-Script, et Book KOMA-Script, et de 12 pt dans Letter KOMA-Script ;

— les en-tétes, les marqueurs de I’environnement Description et d’autres éléments
de la classe Letter KOMA-Script sont en police grasse sans empattement !. La
numérotation des en-tétes de chapitre est rendue de la méme maniere que celle
des en-tétes de section, c’est-a-dire sans la ligne supplémentaire « Chapitre... ».

1. Il y a une grande différence entre les anciennes polices cm grasses sans empattement et les
nouvelles polices ec, particulierement pour les en-tétes. En comparaison, les polices grasses sans
empattement ec semblent un peu plus fines. Le paquetage BTEX cmsd.sty de WALTER SCHMIDT
permet de reproduire ’apparence « habituelle », tout en utilisant les polices ec.
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En outre, I'apparence des en-tétes peut étre modifiée par un certain nombre
d’options (a entrer dans le champ Options de la fenétre Document > Paramétres >
Classe de document).

— le format d'une page KOMA-Script suit 'une des deux conventions typogra-
phiques fondées sur la division d’une page en bandes ou en tracant un cercle.
Implicitement, on imagine une page divisée horizontalement et verticalement
en bandes et on alloue des bandes aux marges, laissant les bandes inutilisées
pour la zone de texte. Vous pouvez modifier la taille des marges en changeant
le facteur par lequel la page est divisée en bandes : implicitement la valeur est
9 pour une page A4 et 'augmenter produira des bandes plus étroites, donc des
marges plus étroites.

Quel que soit le facteur, deux bandes sont allouées pour les marges externes
et inférieures pour un document recto-verso et une bande pour les marges in-
ternes et supérieures, laissant la zone de texte occuper environ la moitié de
la page. Puisque la majorité des documents recto-verso ont une reliure, ceci
peut faire apparaitre les marges internes trop étroites; vous pouvez alors ap-
pliquer une correction de reliure a la page, qui est déduite avant que la taille
des bandes soit calculée. La principale méthode utilisée dans les classes de do-
cuments pour modifier le type de zone sont les options BCOR et DIV ( dans
LyX elles doivent étre entrées dans le champ d’Options du dialogue Document >
Parametres> Classe de document). Elles permettent une modification plus claire
des marges de page que celle du dialogue Document > Parameétres. Une descrip-
tion détaillée de ces options, en allemand, est disponible dans le scrguide de
la documentation Koma-script ;

— les classes de document IXTEX de la famille Koma-Script définissent un cer-
tain nombre de commandes supplémentaires. Celles d’entre elles qui ont une
signification dans LyX sont implémentées par des types de paragraphes y cor-
respondant.

Une description détaillée des classes de document IXTEX de la famille Koma-Script se
trouve dans le scrguide (en allemand) et le srcguien (en anglais) de la documen-
tation Koma-Script.

3.1.8.2 Article KOMA-Script, Report KOMA-Script, et Book KOMA-Script

Les classes de document Article KOMA-Script, Report KOMA-Script, et Book
KOMA-Scripta sont implantées respectivement dans les fichiers de format scrartcl.layout,
scrreprt.layout et scrbook.layout. Ils contiennent tous les types de paragraphe
correspondant aux classes standard respectives article, report, et book mais partielle-
ment modifiés, a I’exception du type Liste, spécifique a LyX, qui est remplacé par le
nouveau type Marquage (Labeling) qui a les mémes fonctions. En plus du type Mar-
quage, il y d’autres nouveaux types de paragraphe. Ceux-ci cependant n’apparaissent
pas dans la classe Letter KOMA-Script.
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— AjoutPartie (AddPart), AjoutChap (Addchap), AjoutSec (Addsec) : sont les équi-
valents respectifs de Partie*, Chapter* et Section*, ajoutant de plus une entrée
dans la table des matieres. AjoutPartie et AjoutChap n’existent pas dans article
(koma-script).

— AjoutChap*, AjoutSec* : ont le méme rdle que, respectivement AjoutChap et
AjoutSec, mais sans indiquer de numéro de chapitre ou de section. AjoutChap*
n’est pas disponible dans article (koma-script)?.

— MiniSec : géneére un en-téte écrit avec des caracteres de taille standard, juste
au-dessus du paragraphe suivant et sans modifier la structure du document.

— Légende_Dessus (Captionabove) et Légende_Dessous (Captionbelow) : sont des
légendes spéciales qui respectent les différents réglages d’espacement nécessaires
pour des légendes placées au-dessus ou au-dessous d'un élément (si vous sui-
vez strictement les regles typographiques, vous mettez toujours les légendes au-
dessus des tableaux). Vous pouvez aussi utiliser I'option de classe tablecaptionsabove,
qui transformera Légende en Légende_ Dessus pour les tableaux et en Légende_Dessous
pour les figures. Il vous faut au minimum Koma-Script version 2.8q pour avoir
cette fonction.

— Dicton (Dictum) : sert a mettre une citation ou un proverbe, par exemple au
début d'un chapitre. Si vous utilisez le parameétre optionnel (Insertion > Auteur du
dicton), vous pouvez y mettre 'auteur du dicton. Dicton et auteur sont séparés
par une ligne. Il vous faut au minimum Koma-Script version 2.8q. Maxime n’est
pas présent dans article (koma-script).

Les types qui sont présentés ci-dessous forment en compagnie des types Titre, Auteur
et Date, la zone de titre du document. Ils doivent étre entrés au-dessus du premier pa-
ragraphe « normal » 3. Lorsqu’un tel type est utilisé plusieurs fois, la derniére instance
annule les précédentes, donc pour chaque type, seule compte la derniére occurrence.
L’ordre des différents types n’a, lui, aucune importance, tout comme celui des Titre,
Auteur et Date.

— Sujet (Subject) : introduit au-dessus du titre ordinaire (Titre, Auteur, Date) un
paragraphe centré pour indiquer le sujet du document.

— Editeurs (Publishers) : introduit au-dessous du titre ordinaire (Titre, Auteur,
Date) un paragraphe centré indiquant le nom de I'éditeur.

— Dédicace (Dedication) : dans report (koma-script) et book (koma-script), dis-
pose un paragraphe centré, sur une page a part apres la page de titre, pour la
dédicace. Dans article (koma-script), dispose un paragraphe centré, en-dessous
du titre normal (Titre, Auteur, Date, Editeurs) pour la dédicace.

— En-téte_Titre (Titlehead) : produit un paragraphe aligné a gauche au-dessus du
titre normal (Titre, Auteur, Date, Sujet) pour un en-téte de document.

2. Il y a aussi une commande \addpart* dans book (koma-script) et dans report (koma-script),
mais comme elle fait la méme chose que Partie*, elle n’a pas été implémentée dans TyX.
3. Les commandes KTEX correspondantes doivent apparaitre avant la commande \maketitle.
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— Verso_Titre_Haut (Uppertitleback) : dans un document report (koma-script)
imprimé recto-verso, dispose un paragraphe aligné a gauche, en haut du verso
de la page de titre. N’a aucun effet dans un document imprimé en recto seul ni
dans article (koma-script).

— Verso_Titre_Bas (Lowertitleback) : dans un document report (koma-script) im-
primé recto-verso, dispose un paragraphe aligné a gauche, en bas du verso de la
page de titre. N’a aucun effet dans un document imprimé en recto seul ni dans
article (koma-script).

— Titre_Suppl. (Extratitle) : introduit une page « moche » qui précede le document
réel, comprenant un paragraphe sans formatage spécial.

KOMA-Script propose de nombreuses options dans la rubrique Options de classe de la
page Document > Parametres > Classe de document , options que vous pouvez appliquer
au document entier, parmi lesquelles

draft=true produit un document PDF avec un petit carré noir a la fin de chaque
ligne contenant une erreur de mise en page; la valeur implicite est false;

headings= peut prendre la valeur big, normal ou small; la premiere et la derniere
ajustent les tailles de en-tétes pour tenir compte des dimensions des page ou
les valeurs implicites ne seraient pas adaptées;

numbers= peut prendre les valeurs auto (implicite), enddot ou noenddot ; la premiere
laisse KOMA-Script ajouter des points apres les numéros de chapitres, sections,
etc. ; la seconde force I'addition de points et la troisieme les supprime ;

et pour le mathématiques :

legno fait apparaitre la numérotation des équations sur la gauche plutot que sur la
droite, et

fleqn justifie les équations sur la gauche plutét que de les laisser centrées.

Elle propose également des commandes pour modifier I'impression du document in-
dépendamment des commandes et des paquetages KTEX standard : par exemple pour
obtenir des légendes en police grasse, ajoutez

\setkomafont{captionlabel}{\bfseries}

au Document > Parametres > Préambule KTEX et le probleme est résolu.

Si vous rédigez un livre, il est habituel de numéroter en romain les pages prélimi-
naires et de laisser le Chapitre de cette partie non numéroté. Si vous utilisez I'en-
vironnement Chapitre®, votre avant-propos et votre préface n’apparaitront pas dans
la table des matieres; pour les faire apparaitre, vous devrez utiliser ’environnement
chapitre et le code TEX

\frontmatter

au tout début du livre (pas dans le préambule KTEX) et

\mainmatter

avant le premier chapitre du corps de texte. Ou bien, vous pouvez utiliser Chapitre
dans Préliminaires.
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Vous pouvez aussi vouloir inclure des environnement Chapitre non numérotés a
la fin du livre aprés les annexes, s’il y en a*. Si vous utilisez les environnements
Chapitre*, il ne seront pas numérotés, ajoutez donc le code TEX

\backmatter

avant le premier de ces chapitres et utilisez ’environnement Chapitre. Ces com-
mandes resteront sans effet sur la numérotation dans LyX, elles n’affecteront que
I'impression PDF ou les en-tétes seront non numérotés et apparaitront dans la table
des matieres.

Les fichiers de configuration correspondant aux classes article (koma-script), report
(koma-script), et book (koma-script) comprennent le fichier scrmacros.inc. Clest la
que vous définirez vos propres types. Copiez scrmacros.inc dans votre répertoire
personnel de formats, et éditez-le!

3.1.8.3 La nouvelle classe lettre : Letter KOMA-Script (v.2)
par JURGEN SPITZMULLER

Koma-Script version 2.8 a introduit une nouvelle classe de lettres scrlttr2 qui
remplace scrlettr, désormais périmée. Elle a — du c6té KTEX — une interface com-
pletement nouvelle et n’est pas compatible avec I’ancienne classe. LyX supporte les
deux, mais il est recommandé d’utiliser la nouvelle.

Cette classe recouvre les mémes fonctionnalités que Letter KOMA-Script, plus
quelques autres. Les éléments de base sont Adresse (adresse du destinataire, comme
Lettre dans le précédent format), Ouverture et Fermeture. Adresse_Suivante (NextAd-
dress) démarre une nouvelle lettre (vous pouvez donc écrire plusieurs lettres dans un
méme document). Les nouveaux éléments concernent 'expéditeur, ce sont : E-Mail,
URL, Fax, Banque et la possibilité de mettre un Logo (par Insertion > Graphique/image)
dans I’en-téte.

La plus grande amélioration est la possibilité de configurer la mise en page de la
lettre pour s’adapter a presque tous les besoins, soit dans le préambule (Document>
Paramétres. . .) soit avec un fichier de style spécial (Option de la Classe Lettre, d’ex-
tension .1lco), qui sera lu comme une option de classe®. Jetez donc un ceil sur le
modele Fichier>Nouveau avec modele> Lettres > KOMA-Script Letter (V.2). Vous trou-
verez une description détaillée dans la documentation de Koma-Script (scrguide).

3.1.8.4 Problémes

Avec IyX, la visualisation d'un document de classe Koma-Script peut poser quelques
problémes :

4. Les annexes sont normalement « numérotées » avec des lettres.

5. Le paquetage KOMA est livré avec quelques fichiers .1co par défaut. Il y a par exemple
un fichier DIN.1lco qui suit les régles typographiques allemandes, et un KOMAold.lco qui permet
de retrouver la mise en page par défaut de 'ancienne classe scrlettr. Vous pouvez charger cette
derniére avec 'option de classe KOMAold, mise dans le champ Options dans Document > Parameétres>
Classe de document.
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— le numéro de chapitre pour un type Chapitre apparait sur une ligne a part,
au-dessus de l'en-téte de chapitre, au lieu d’étre sur la méme ligne juste avant.
C’est causé par le comportement interne de IyX face au marqueur de type
Counter__Chapter dans le fichier de format ;

— les en-tétes des types AjoutChap et AjoutSec sont uniquement dans la « vraie »
table des matieres WTEX, et pas dans la table des matiéres Iy X (Document
Plan) ;

— les paragraphes avec la classe de document letter apparaissent séparés par de
I'interligne supplémentaire, et non par une indentation. C’est le comportement
par défaut, qui se passe de commande KTEX spécifique. Mais dans la fenétre
Document > Parameétres le bouton a cocher correspondant indique Indentation.
Cocher Interligne inseére toujours des commandes IXTEX supplémentaires dans
le document pour causer cet espacement, ce qui ne serait pas le comportement
désiré dans ce cas.

3.1.9 Collection polonaise M. W.

par TOMASZ LUCZAK

Les classes de document IxX Article polonais (paquet MW), Rapport polonais
(MW) et Livre polonais (MW ) correspondent aux classes de document IXTEX mwart . cls,
mwrep.cls et mwbk.cls respectivement. Elles remplacent les classes de document
standard article.cls, report.cls et book.cls et sont mieux adaptées en bien des
aspects aux conventions typographiques polonaises.

Les différences principales sont :

— Les titres non numérotés (avec une étoile, comme Section*) sont présents dans
la table des matieres.

— Des styles de mise en page supplémentaires :

uheadings en-tétes sur plusieurs lignes,

myheadings en-tétes personnalisés, définis par les commandes \markright et
\markboth,

myuheadings en-tétes personnalisés sur plusieurs lignes
outer le numéro de page est placé du coté extérieur de la page
— Options
rmheadings titres avec empattement — par défaut,
sfheadings titres sans empattement,
authortitle sur la page de titre, d’abord 'auteur puis le titre — par défaut,
titleauthor sur la page de titre, d’abord le titre puis 'auteur,
withmarginpar réserver de la place sur la page pour les marges.

Outils supplémentaires
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3.1.10 Collection Tufte

Les classes de document Book Tufte and Handout Tufte utilisent les fichiers tufte-book.cls
et tufte-handout.cls. Les informations détaillées sur ces classes peuvent étre trou-
vées via Fichier> Ouvrir un exemple > Livrest> Tufte Book and Fichier > OQuvrir un exemple
Handouts > Tufte Handout.

3.2 Articles

Voir également les classes de document dans les collections (section 3.1).

3.2.1 Astronomy & Astrophysics

Original par PETER SUTTERLIN, mis & jour par 1’équipe LyX.

3.2.1.1 Introduction

Cette section décrit comment utiliser LyX pour écrire des articles a soumettre au
journal scientifique Astronomy € Astrophysics (paquetage aa), avec la Version 9.1 de
la classe de document aa.cls; I'information qui la concerne est accessible via le lien
https://www.aanda.org/for-authors/latex-issues/texnical-background-information.

Un manuel est fourni avec ce paquetage, et doit étre consulté avant d’installer cette
classe de document comme indiqué dans la section Installation de nouvelles classes
du manuel de Personnalisation.

Notez que I’éditeur de ce journal a changé le ler janvier 2001 : ce n’est plus Springer
mais EDP Sciences. Ce changement a aussi entrainé quelques légeres modifications
aux fichiers de style, notamment la suppression de la commande thesaurus. Si vous
avez une ancienne version installée, veuillez la mettre a jour. Pour une information
sur la compatibilité avec I'ancien format (version 4), voyez les commentaires dans
IyXDir/layouts/aapaper.layout.

3.2.1.2 Pour commencer

Il est recommandé de commencer a partir du modele distribué avec LyX via
Fichier>Nouveau avec modele> Articles> Astronomy & Astrophysics. Si vous n’utilisez
pas de modele, jetez un ceil aux réglages suivants :

— Choisissez Astronomy & Astrophysics de la liste des Articles champ Classe de Do-
cument du dialogue Document > Paramétres. (D’accord, c’est évident.)

— Ne changez pas 'option Mise en page : laissez-la sur Implicite. La mise en page
est prise en charge par les macros, vous n’avez rien a changer.
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3.2.1.3 Le bloc d’en-téte

La premiéere chose a entrer est 'information d’en-téte. Elle consiste en sept entrées,
dont certaines sont facultatives. Ce sont

— Titre (Title) : (nécessaire)

— SousTitre (Subtitle) : (facultatif)
— Auteur (Author) : (nécessaire)
— Adresse (Address) : (nécessaire)

— Tirés_A_Part (Tiré a part) : (facultatif) : qui contacter pour demander des tirés
a part.

— Mail : (facultatif) Adresse mail pour les contacts.
— Date : (nécessaire) Format suggéré Received: <date>; Accepted <date>

Il n’y a pas besoin de taper la commande \maketitle, LyX le fait tout seul quand
I’en-téte est fini. Bien que l'ordre des entrées d’en-téte n’ait pas d’importance il est
conseillé de conserver la séquence ci-dessus, juste pour avoir un meilleur aspect visuel
et correspondre au format du document réel.

Si vous voulez placer des notes de bas de page dans le bloc d’en-téte, par exemple
pour entrer votre adresse actuelle, utilisez les notes de bas de page standard avec
Insertion>Note en Bas de Page. Iy X utilisera automagiquement \thanks{} dans ce
cas.

Via Edition>Style de texte, vous trouverez deux marqueurs utiles pour le titrage :

— Institution pour indiquer les couples auteur/institution. Les institutions sont
numeérotées séquentiellement comme elles apparaissent dans le champ Address,
vous devez donc mettre un marqueur pour chaque auteur.

— Email pour indiquer une adresse électronique.

En plus de ces points, les macros utilisent une commande IXTEX supplémentaire qui
n’a pas d’équivalent dans [yX :

— \and pour séparer les noms quand il y a plusieurs auteurs et plusieurs instituts.

La commande appropriée doit étre tapée dans LiyX en mode TEX. Voir les exemples
dans le modele et via Fichier>Ouvrir I'exemple> Articles > Astronomy & Astrophysics.

3.2.1.4 L’abstract

L’abstract (résumé) devrait suivre immédiatement le bloc d’en-téte. Avec la version
5 I'abstract est devenu une commande, et il est maintenant limité a un seul para-
graphe. En plus, il doit contenir une entrée avec les mots-clés. La seule chose spéciale
a en dire est qu’il doit contenir une entrée avec les mots-clés. Ce se fait via le style
de paragraphe Keywords. Référez-vous au fichier d’exemple.
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3.2.1.5 Environnements supportés

Le format paper (A&A) supporte les environnements suivants pour structurer votre
texte :

— Standard

— Section

— SousSection
— SousSousSection
— ListePuces
— Enumération
— Description
— Légende

— Abstract

— Remerciement
— Bibliographie
— BTEX

3.2.1.6 Commandes non encore supportées par LyX

Quelques commandes ne sont pas encore supportées par le format paper (A&A)
de LyX. Quelques-unes ont déja été mentionnées. Par souci d’exhaustivité, elles sont
toutes listées ici :

— \and

— \authorrunning
— \object{}

— \titlerunning{}

Si vous voulez utiliser I'une de ces commandes, vous devez les taper vous-mémes.
N’oubliez pas de les signaler comme code TEX!

3.2.1.7 Figures et tableaux flottants

LyX fournit le support pour les environnements de flottants figure, figure*, table et
table*, nous n’en dirons donc pas beaucoup plus. Référez-vous au Guide de I’Utilisa-
teur. Rappelez-vous juste que les tableaux devront étre alignés a gauche. Pour cela,
sélectionnez le tableau et changez ’alignement dans Format> Paragraphe.

Il y a une seule chose spéciale : les figures avec la légende a coté. Pour créer une
telle figure, vous devez faire ceci :

1. Créez une grande figure flottante : faites Insertion> Flottants> Figure, puis un
clic droit sur la figure et cochez Plusieurs colonnes.

2. Entrez votre 1égende.
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3. Tapez Entrée pour déplacer le curseur au dessus de la figure.
4. Insérez votre figure.

5. Positionnez le curseur derriere la figure et insérez un ressort horizontal via :
Insertion > Typographie spéciale > Espacement horizontal...

6. Passez en mode I¥TEX : M-c t.
7. Entrez \parbox[b]{565mm}{. Ne fermez pas 1’accolade!

8. Positionnez le curseur derriere le texte de la légende, passez en mode KTEX et
insérez 'accolade fermante : M-c t }.

La encore, voyez les figures dans ’article en exemple.

3.2.1.8 Format de revue

Pour la soumission, la communication doit étre mise en forme dans un format spé-
cial a double interligne. Pour ce faire, vous devez donner a la classe de document 1’op-
tion referee. Il faut la mettre dans le champ Réglable, dans Document > Parametres
rubrique Classe de document > Options de classe. Entrez-y juste le mot referee.

3.2.1.9 Le fichier d’exemple

Le répertoire d’exemples contient un papier exemple écrit avec LyX. C’est ’exemple
venant du paquetage de macros d’origine, aa.dem dans le paquetage aa, traduit pour
LyX en utilisant le type abstract non structuré plus ancien. Utilisez-le comme source
d’inspiration, et comparez le code KTEX de aa.dem avec la fagon de 1’écrire avec LyX.

3.2.2 Article AASTEX

par MIKE RESSLER

3.2.2.1 Introduction

AASTEX est un ensemble de macros produit par I’American Astronomical Society
pour faciliter la soumission électronique de manuscrits aux trois journaux qu’elle pu-
blie : I’Astrophysical Journal (y compris les Letters et le Supplement), I’Astronomical
Journal, et les Publications of the Astronomical Society of the Pacific. IyX a besoin
de la version 5.0 (de préférence 6.0, version décrite ici, ou plus récente) de ces ma-
cros. Les versions antérieures a la 5.0 sont destinées a étre utilisées avec KTEX2.09
et sont fondamentalement incompatibles avec LyX. Le paquetage AASTEX peut étre
téléchargé depuis le site de 'AAS

https://aas.org/aastex/aastex-downloads
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Un guide de I'utilisateur complet est compris dans ce paquetage et il vaut mieux
que vous vous familiarisiez sérieusement avec avant de vous embarquer a écrire un
papier en LiyX. LyX ne va pas vous dispenser de comprendre toutes les commandes
AASTEX, il vous dispensera seulement de la corvée de toutes les taper. Il est de
votre responsabilité de vous assurer que le document final exporté en I¥TEX soit com-
pletement conforme aux recommandations du journal auquel vous soumettez votre
papier.

3.2.2.2 Commencer un nouveau papier

Je vous suggere vivement de commencer avec le fichier de modele AASTEX. Cli-
quez sur Fichier>Nouveau avec Modele> Articles> American Astronomical Society. Il
montrera les champs les plus courants dans un manuscrit. Ecrivez par dessus le texte
existant (y compris les crochets, <>) les informations correctes. Beaucoup des com-
mandes et environnements AASTEX peuvent étre implémentés directement dans IyX,
mais certains ne peuvent pas. Pour des commandes comme celles-1a, le code IXTEX
doit étre entré directement et signalé comme tel. De telles commandes sont dénom-
mées « code TEX ». J'essaye de minimiser la quantité de code TEX nécessaire dans
un document AASTEX.

3.2.2.3 Finir votre papier

Quand le papier est fini, que vous en étes satisfaits et qu’il se visualise / s’imprime
correctement, il y a quelques opérations de « post-production » a effectuer avant de
le soumettre aux journaux.

1. Exportez votre papier en tant que fichier TEX (Fichier>Exporter > ATEX).
2. Editez le fichier .tex résultant avec votre éditeur de texte favori.

a) enlevez les lignes de commentaire avant la commande \documentclass.

b) enlevez la ligne \usepackage...{fontenc} si elle apparait (en général
juste aprés \documentclass); enlevez aussi la ligne \secnumdepth si elle
est présente.

c) enlevez tout entre les commandes \makeatletter et \makeatother com-
prises, sauf les commandes que vous avez volontairement mises dans le
préambule BTEX (qui devraient apparaitre immédiatement apres le com-
mentaire « User specified WTEX commands » ¢ dans le fichier .tex).

3. Faites tourner XTEX sur ce fichier apres modifications pour s’assurer qu’il peut
encore étre compilé correctement.

4. Relisez les spécifications du journal pour vous assurer que vos noms de fichier
et vos formats sont corrects.

5. Soumettez-le.

6. NdT : « Commandes I#TEX spécifiées par 'utilisateur »
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3.2.2.4 Commentaires sur des commandes particuliéres

Je ne vais pas décrire 'emploi détaillé de chaque commande AASTEX : le Guide de
I'utilisateur ’AASTEX (aasguide.tex) en donne une bonne description. Il me sera
donc probablement plus facile de parcourir la liste telle qu’on la trouve dans le guide
et de la commenter si nécessaire. Allons-y...

Les choses qui fonctionnent comme prévu Puisqu’elles fonctionnent comme prévu,
j’en fais simplement la liste avec la section dans laquelle elles se trouvent : \documentclass
(2.1.1), \begin{document} (2.2), \title (2.3), \author (2.3), \affil (2.3), \abstract
(2.4), \keywords (2.5), \section (2.7), \subsection (2.7), \subsubsection (2.7),
\paragraph (2.7), \begin{displaymath} (2.11), \begin{equation} (2.11), \begin{eqnarray}
(2.11), \begin{mathletters} (2.11), \begin{thebibliography} (2.12.1), \bibitem
(2.12.2), \begin{table} (2.14.4), \begin{tabular} (2.14.4), \caption (2.14.4), \label
(2.14.4, entre autres), \tablerefs (2.14.5), \tablecomments (2.14.5), \url (2.15.4),
\end{document} (2.16).

Les options de style qui suivent marchent elles aussi correctement : preprint,
preprint2, eqsecnum, flushrt (3, 3.1, 3.2). Mettez-les simplement dans le champ
Options de Document > Parametres rubrique Classe de document.

Les choses qui fonctionnent, mais qui nécessitent un commentaire Les éléments
suivants fonctionnent, mais requierent un petit commentaire :

— ces éléments sont réservés a l'utilisation par les éditeurs du journal, mais vous
pouvez les mettre dans le préambule IXTEX si vous vous sentez tenu de le faire :
\received, \revised, \accepted, \ccc, \cpright (tous a partir de 2.1.3)

— ces éléments peuvent étre placés dans le préambule KTEX, et sont inclus comme
des blancs dans le fichier modele : \slugcomment (2.1.4), \shorttitle (2.1.5),
\shortauthors (2.1.5)

— \email (2.3) — peut seulement étre utilisé seul, pas au milieu d’un paragraphe.
Utilisez du Vilain Texte Rouge si vous devez l'insérer.

— \and (2.3) — aura un {} en trop apres. Ca ne devrait pas causer d’erreur.

— \notetoeditor (2.6) — peut seulement étre utilisé seul, pas au milieu d'un
paragraphe. Utilisez du Vilain Texte Rouge si vous devez l'insérer.

— \placetable (2.8) — ne peut pas insérer une marque de référence croisée, vous
devez la placer a la main

— \placefigure (2.8) — méme chose que pour \placetable

— \acknowledgements (2.9) — aura un {} en trop apres. Ca ne devrait pas causer
d’erreur.

— \appendix (2.10) —aura un {} en trop apres. Ca ne devrait pas causer d’erreur.

— \figcaption (2.13.2) — vous devrez éditer le parametre optionnel & la main
dans le fichier I¥TEX final.
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Les choses qui ne sont pas implantées, utilisez du code TEX \eqnum (2.11),
\setcounter{equation} (2.11), \citet (2.12), \citep (2.12), les abréviations des
noms de journaux (2.12.4), \figurenum (2.13.1), \epsscale (2.13.1), \plotone (2.13.1),
\plottwo (2.13.1), \tablenum (2.14.4), \tableline (2.14.4, insérez-le comme le pre-
mier élément dans la case la plus a gauche apres ’endroit ou vous voulez le placer.
Nutilisez pas les régles IyX dans le tableau ”), \tablenotemark (2.14.5), \tablenotetext
(2.14.5), pratiquement tout dans Divers (2.15, sauf \url et \email; voir ci-dessus),
\singlespace (3.1), \doublespace (3.1), \onecolumn (3.2), \twocolumn (3.2)

Les choses qui ne peuvent pas étre implantées ...au moins d’une fagon qui ait un
sens, et que je suggere donc d’ignorer. Ce sont I'environnement references (2.12.3)
et 'environnement deluxetable (2.14). Si vous avez vraiment, vraiment besoin d’uti-
liser deluxetable, je vous suggere de 'éditer avec un éditeur de texte dans un fichier
séparé, puis de faire Insertion > Fichier > Sous-document pour l'inclure dans votre docu-
ment LyX. Voyez Fichier> Ouvrir un exemple> Articles > American Astronomical Society
pour voir un exemple de cela.

3.2.2.5 FAQs, conseils, trucs et autres astuces

Faire coopérer LyX et AASTEX Il peut étre un peu difficile de faire reconnaitre
a IyX un nouveau format et une nouvelle classe de document. Quand tout le reste
échoue, faites ceci :

1. Assurez-vous que KTEX trouve AASTEX. Copiez sample.tex (et peut-étre
table.tex) de la distribution AASTEX vers un répertoire complétement in-
dépendant de BTEX ou d’AASTEX et faites tourner IXTEX sur sample.tex.

2. Assurez-vous que aastex63.layout apparait bien dans le répertoire de formats
(layout) de LyX.
3. Refaites Outils> Reconfigurer dans Iy X, puis redémarrez celui-ci.

4. Ouvrez un nouveau fichier normal, pas avec un modele. Est-ce que American
Astronomical Society (AASTex V.6.3.1) apparait dans Document > Paramétres >
Classe de document ?

Si vous obtenez un avertissement provenant d’'un document AASTEX existant vous
disant qu’il n’arrive pas a trouver le format AASTEX ou un message du genre « You
should not mix title layouts with normal ones » %, c’est que les choses n’ont pas été
installées correctement.

Erreur BTEX lors du traitement d’un tableau IyX, par défaut, tente de cen-
trer la légende/titre du tableau. Ca semble produire une interférence négative dans
AASTEX. Vous devez donc cliquer quelque part dans la légende/titre, puis faire Edi-
tion> Parametres de Paragraphe, et régler 1’Alignement sur Bloc. Pour moi ¢a a résolu
le probléeme.

7. NdT : Traduction incertaine.
8. NdT : « Il ne faut pas mélanger les formats de titre avec les formats normaux. »
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Références Quelques petites choses :

1. j’ai remarqué quelques espacements bizarres avec les entrées de bibliographie.
Quand vous entrez les données de bibliographie, assurez-vous qu’il n’y a pas
d’espace entre le dernier auteur et la parenthese indiquant I’année ; par exemple
tapez Ressler(1992) et non Ressler (1992).

2. je suis vraiment malheureux de ne pas pouvoir rendre \citet et \citep plus
automatiques, mais ¢a nécessiterait des changements au code source de LyX.
Pour le moment vous pouvez faire deux choses :

a) entrez toutes vos citations en utilisant le mécanisme prédéfini Insertion>
Citation ; au moins vous pourrez tirer avantage des insertions automatiques.
Puis éditez a la main le fichier E'TEX exporté avant de le soumettre, en
changeant les entrées \cite en commandes \citet ou \citep appropriées
(\cite est actuellement équivalent a \citet, donc vous n’avez pas abso-
lument besoin de changer ceux-1a).

b) ou vous pouvez simplement entrer toutes vos citations en Vilain Texte
Rouge en utilisant la méme clef pour parametre que celle que vous avez
utilisée dans la fenétre de bibliographie, par exemple \citet{clef}.

Aucun des deux choix n’est plaisant, mais nous aurons a faire avec jusqu’a ce
que le mécanisme de citation de [yyX ne comprenne natbib.

3. rien qu’entrer les références n’est pas du tout évident. La facon la plus facile est
de commencer a taper votre premiere référence a la fin du document, puis de la
marquer comme Citation. Ca mettra une petite boite grise devant ce que vous
venez de taper. Cliquez sur la boite pour remplir le reste. Pour de nouvelles
références, allez a la fin d'une référence existante et appuyez sur Entrée. Ca
créera une nouvelle ligne avec sa propre boite, etc.

Inclure des fichiers EPS Avec tout le respect qui est dii a Chris Biemesderfer et aux
autres qui ont contribué a écrire le paquetage AASTEX, le mécanisme de gestion des
figures est vraiment mal foutu. Vous pouvez insérer les commandes \plotone, etc. en
code TEX dans une Figure Flottante, mais je n’ai jamais vraiment réussi a obtenir une
apparence correcte. Mon conseil serait d’éviter toute inclusion de fichier EPS dans le
manuscrit que vous soumettez au journal, mais d’utiliser le mécanisme d’inclusion de
fichier EPS standard de IyX quand vous voulez imprimer vos propres tirés a part.
LyX va insérer une commande \usepackage{graphics} dans le préambule ETEX et
gérer les figures de la facon habituelle dans BHTEX 2¢. Ceux qui essaieront d’impri-
mer votre manuscrit AASTEX 5.0 doivent de toutes fagons avoir une installation de
KETEX 2¢, donc pourquoi ne pas profiter du mécanisme infiniment meilleur de gestion
de graphiques? S’ils se plaignent du choix de BKTEX2¢ ou du paquetage graphics,
faites valoir qu’il apparait dans la deuxiéme édition de Lamport (1994), et qu'il était
temps de faire la mise a jour il y a bien longtemps.

Les choses qui auraient pu étre faites, mais qui ne I'ont pas été Il y a quelques
choses « sympathiques » que j’aurais pu implémenter, mais que j’ai choisi de laisser
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de coté. Par exemple, je ne voyais pas 1'utilité d’afficher le texte en double interligne
dans la fenétre de LyX, méme s’il I'est dans le manuscrit imprimé. J’ai aussi choisi de
ne pas faire des formats séparés pour les styles preprint et preprint2. Comme je
suppose que vous passerez la plupart du temps en mode manuscrit simple, j'ai décidé
de ne pas bouffer plus d’espace disque avec tout ca.

3.2.2.6 Touche finale

J’al maintenant eu des papiers publiés aussi bien dans Apj que dans AJ avec 98%
du travail fait avec LyX; les 2% restants étant du post-traitement avec KTEX et un
peu de nettoyage. Je n’ai rencontré aucun probléme avec le processus de soumission,
et je suis stir que les journaux n’ont jamais eu conscience qu’il pouvait y avoir une
différence. Donc, allez-y et publiez !

3.2.2.7 Echecs (chess)

La classe de document Chess utilise la classe standard article avec le paquetage lyxs-
kak pour faciliter la description des parties d’échecs. Voir Fichier > Quvrir un exemple>
Articles> Echiquier ot vous trouverez Partie 1 et Partie 2.

3.2.3 Elsevier

La classe de document Elsevier fournit permet d’accéder a la classe KTEX elsarticle
pour les revues de la société éditrice Elsevier. Elle fournit les environnements supplé-
mentaires suivants : Note de bas de page (titre), Note de bas de page (auteur), Auteur
référent, Adresse, E-mail and Mots-clés.

Un modele est disponible via le menu Fichier>Nouveau avec modeler Articles>
Elsevier. IL a été enrichi avec d’autres environnements et contient toute 'information
nécessaire. Cependant, la documentation est également disponible depuis CTAN.

3.2.4 Paper

La classe de document Paper (classe standard) fournit une alternative a la classe
Article (classe standard). La fonctionnalité est similaire, mais vous pouvez préférer ce
format sans les sections sans empattements, les en-tétes et autres.

3.2.5 RevTgX4

par AMIR KARGER

La classe de texte RevTex (V.4) fonctionne avec la classe RevIEX 4.0 (version 5 de
mai 1999) de I’American Physical Society.

IyX a une classe de texte REVTex (obsolete), qui fonctionne avec RevIEX 3.1.
Cependant, la version 3.1 est périmée, car elle fonctionne avec BTEX 2.09. Ce qui
signifie qu’elle n’interagit pas tres bien avec Ly X, qui a besoin de KTEX 2¢, méme si
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on I'a trafiqué pour qu’elle marche. Comme RevTEX 4.0 a été étudiée pour marcher
beaucoup mieux avec ITEX 22, LyX avec la classe de texte RevTex (V.4) devrait étre
assez facile a utiliser.

Cette documentation est censée servir en plus de la documentation de RevTEX
4.0, nous ne décrirons donc aucune des macros spéciales RevIEX, et supposerons que
vous savez ce qu’il faut mettre dans le préambule si besoin.

3.2.5.1 Installation

Tout ce que vous avez a faire est d’installer RevIEX 4, comme c’est décrit dans le
fichier README du paquetage. Le paquetage est disponible sur le site de RevTEX
4 http://publish.aps.org/revtex4/. Installez-le quelque part ou IXTEX puisse le
voir. Testez-le en essayant de I{TEXer un court document RevTEX 4 dans un répertoire
au hasard (c’est-a-dire pas dans celui ot vous avez installé le fichier de classe). Ensuite,
si vous reconfigurez [5yX, il trouvera le fichier de classe et vous laissera utiliser la classe
de texte Revtex4.

Probablement la fagon la plus simple de démarrer est soit d’importer un document
RevTEX 4 avec tex21yx, soit d’utiliser le modele Revtex 4, qui se trouve dans Fichier >
Nouveau avec modéler> Articles.

3.2.5.2 Dans le préambule

Les parametres optionnels de \documentclass, comme « preprint » et « aps », vont
dans le champ d’Options de la fenétre Document > Parameétrest> Classe de document,
comme d’habitude. Rappelez-vous que dans RevTEX, il faut au moins un parametre
optionnel !

Le reste de ce qui va dans le préambule, comme \draft etc., va comme d’habitude
dans la fenétre Préambule ETEX.

3.2.5.3 Champs’®

Les champs correspondent basiquement aux commandes dans RevITEX 4.0. Par
exemple, le champ Email correspond a \email{}. Notez que (au moins pour RevITgX
4.0 Beta), les champs Adresse et Affiliation sont exactement équivalents, vous n’avez

donc pas besoin d’utiliser les deux '°.

3.2.5.4 Notes importantes

Il y a un ou deux aspects spécifiques de RevIEX 4 qui peuvent causer des erreurs
qui sont encore plus troublantes dans [yX.

9. NdT : Dans la section sur RevTEX, j’ai traduit « layout » par « champ » a de nombreux
endroits. Ce que l'auteur indiquait était peut-étre un environnement, mais ressemble de toute fagon
a un champ a remplir. N’ayant pas RevTEX, je ne peux pas aller vérifier.

10. Au cas ou ¢a vous intéresse, les deux sont inclus pour que tex2lyx puisse traduire a la fois
\address et \affiliation.
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Dans RevTgX, la commande \thanks va en dehors de la commande \author.
L’équivalent Iy X en est qu’il y a un champ Remerciements séparé. N’écrivez pas de
notes de bas de page dans le champ Auteur, ou des choses étranges apparaitront.
Voyez la documentation de RevTEX 4 pour plus de détails.

Egalement, les champs Email_Auteur (Author Email), URL_Auteur (Author URL)
et Remerciements (Thanks) doivent étre placés entre le champ Auteur et le champ
Adresse correspondant (ou son équivalent Affiliation). Si vous mettez les Remerciements
apres I’Adresse, la compilation KTEX échouera.

3.2.6 Revues Springer

Toutes les classe svj* ont été remplacées par une classe complétement nouvelle,
sn-jnl.cls. Veuillez trouver l'information pertinente en suivant le lien https://www.
springernature.com/gp/authors/campaigns/latex-author-support. L’intégration
a IyyX n’est pas encore disponible.

3.3 Livres

Voir également les classes de document dans les collections (section 3.1).

3.3.1 Memoir

Par JURGEN SPITZMULLER

3.3.1.1 Introduction

Memoir est une classe trés puissante et en constante évolution. Elle a été congue
pour la littérature de fiction comme de non-fiction. Son but est de donner a 1'utili-
sateur le maximum de contrdle sur la mise en forme de son document. Memoir est
basée sur la classe standard book, mais elle peut aussi émuler la classe article (voir
plus loin).

PETER WILSON, le développeur de Memoir est connu comme ’auteur de nombreux
et utiles paquetages dans le monde BTEX . La plupart ont été rassemblés avec Me-
moir. Il est donc beaucoup plus facile de mettre en forme la table des matieres, les
annexes, les chapitres et autres. LyX, ne gere pas de facon native la plupart de ces
fonctionnalités. Quelque-unes pourront étre ajoutées dans de prochaines versions !,
beaucoup ne le seront probablement jamais, a cause des limitations de la structure
de LyX. Bien stir, vous pouvez quand méme utiliser toutes les fonctions avec 1'aide
de quelques commandes WTEX (en code TEX '? ). Dans cette section, nous ne liste-
rons que les fonctions qui sont gérées par LyX de fagon native. Pour une description

11. Vous étes invités a faire des suggestions a 1lyx-devel@lists.lyx.org.
12. Voir la section 2.3 pour plus de détails.
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détaillée (et pour le reste des fonctions) nous recommandons de jeter un ceil au ma-
nuel détaillé de la classe Memoir '3, qui est non seulement un manuel de 1'utilisateur
de la classe, mais aussi a la fois une description complete de la bonne maniére de
typographier et un superbe exemple de bonne typographie en lui-méme.

3.3.1.2 Fonctions de base et restrictions

A la base, Memoir accepte toutes les fonctions de la classe standard book. Il y a
pourtant quelques différences, comme celles qui suivent :

Taille des polices : Memoir a une gamme plus large de taille de polices : 9, 10, 11,
12, 14, 17

Style de page : le style de page « sophistiqué » n’est pas géré, a cause d’un conflit
de commandes entre Memoir et le paquetage fancyhdr (ils définissent tous les
deux une commande avec le méme nom, ce qui perturbe IXTEX). A la place,
Memoir est fourni avec un paquet de ses propres styles de pages (voir Docu-
ment > Paramétres> Format de la page). Si vous voulez les utiliser pour les pages
de chapitre, vous devez utiliser la commande \chapterstyle dans le corps du
texte ou dans le préambule (par exemple \chapterstyle{companion}).

Sectionnement : les sections (chapitres, sections, sous-sections etc.) ont un para-
metre facultatif dans les classes standard. Avec ce dernier, vous pouvez donner
une version alternative du titre pour la table des matiére et les entétes (par
exemple, quand le titre est trop long). Dans LyX, vous pouvez le faire avec
Insertion> Titre court au début de la section/chapitre. Memoir a un deuxiéme
parametre facultatif qui permet de séparer la table des matieres et les entétes.
Vous pouvez donc définir trois variantes d’un titre : un pour le corps du texte,
un pour la table des matieres et un pour les entétes. IyX rend ceux-ci accessibles
via des variantes particulieres de Titre court dans le menu Insertion.

TdM/LdT/LdF : dans les classes standard (et dans beaucoup d’autres classes), la
table des matieres, la liste des tableaux et la liste des figures commencent au-
tomatiquement une nouvelle page. Memoir ne suit pas cette regle. Vous devez
insérer un saut de page vous-méme, si vous en voulez un.

Page de titre : pour quelque raison inconnue, Memoir utilise une pagination sur
la page de titre (dans les classes standard, les pages de titres sont « vides »,
c’est-a-dire sans numérotation). Si vous voulez une page de titre vide, tapez
\aliaspagestyle{title}{empty} dans le préambule.

Article : avec 'option de classe article (& ajouter dans Document > Paramétres > Classe de do-
cument > Options de classe > Réglable), vous pouvez imiter le style article. C’est-
a~dire que les compteurs (notes de bas de page, figures, tableaux etc.) ne seront
pas réinitialisés a chaque nouveau chapitre, les chapitres ne commenceront pas
sur une nouvelle page (mais — contrairement & la « vraie » classe article — ils

13. Voir CTAN:/macros/latex/memoir/memman.pdf.
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sont encore autorisés), les parties cependant utilisent leur propre page comme
dans book.

Anciennes commandes de polices : par défaut, Memoir n’autorise pas 'utilisation
des commandes de changement de police supprimées, qui étaient utilisée par
I'ancienne version KTEX 2.09 (par exemple \rm, \it). Il produit une erreur
et arréte TEX dés qu'une commande de ce genre apparait. L’option de classe
oldfontcommands autorise de nouveau ces commandes et set contente d’émettre
un avertissement (qui au moins ne stoppe pas KTEX). Puisque beaucoup de
paquetages KIEX et en particulier les fichiers de style BibTEX utilisent encore
ces commandes, nous avons décidé d’utiliser cette option par défaut.

3.3.1.3 Fonctions supplémentaires

Nous n’allons décrire que les fonctions qui sont gérées par [yX (ce qui ne fait
pas beaucoup pour U'instant). veuillez consulter le manuel de Memoir ' pour plus de
détails.

Abstract : Vous pouvez vous demander pourquoi un abstract est une fonctionnalité
supplémentaire. Hé bien, c’est une classe book. En principe, les classes book
n’ont pas d’abstract. Memoir, lui, en a une. Vous pouvez 1'utiliser quand vous
le voulez et autant des fois que vous le voulez.

Chapterprecis : Vous avez peut-étre déja vu cela dans la littérature : le contenu d’un
chapitre est brievement décrit sous le titre et aussi dans la table des matieres
(par exemple : Notre héros arrive a Troie ; il perd quelques amis ; il s’en fait des
nouveauz). Chapterprecis fait exactement cela. Cela n’a donc de sens qu’apres
un début de chapitre.

Epigraph : Une épigraphe est un joli slogan ou une devise placée au début d’un
chapitre. L’environnement epigraph fournit un moyen élégant de mettre en forme
une telle devise. Le texte de la devise (texte) et son auteur (facultatif) ou source
sont séparés par une petite ligne. L’auteur (source) peut étre saisi via Insérer >
Source épigraphique.

Poemtitle : Memoir offre de nombreuses possibilités pour mettre en forme de la poé-
sie (jusqu'a de trés complexes poemes figuratifs). IyX n’en geére que quelques-
uns. L'un d’eux est poemtitle, qui est un titre centré pour les poemes, qui sera
aussi ajouté a la table des matieres (I’environnement standard pour les poémes
est vers. Memoir a plusieurs versions améliorées de vers, mais vous aurez besoin
d’utiliser du code TEX, puisqu’ils doivent étre emboités a l'intérieur d’environ-
nements vers ordinaires, ce qui n’est pas possible avec IyX).

Poemtitle* : Comme poemtitle, mais il n’ajoute pas une entrée a la table des ma-
tieres.

14. Voir CTAN: /macros/latex/memoir/memman.pdf.
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3.3.2 Livre de recettes

La classe de document Livre de recettes utilise la classe de document Livre KOMA-
Script, mais ajoute deux environnements :

Recette est un environnement de section numéroté au niveau SousSousSection qui
engendre un en-téte gras centré au-dessus d’une regle horizontale double;

Ingrédients est un environnement Description ou Ingrédients sont ce qui est
décrit ; 'environnement se termine par une regle horizontale.

Fichier>Ouvrir un exempler Livres> Livre de recettes illustre son utilisation.

La classe set concue pour afficher une ou deux recettes par page. La table des
matieres dotées de liens hypertexte vers les numéros de page rend la navigation entre
les recettes pratique.

3.4 Curricula vitae

3.4.1 Europass (2013)

La classe de documents Europass (2013) fournit I'acces a la classe de documents
KTEX europasscv. cls, une implantation officieuse du « CV Europass » recommandé
par le Commission Européenne en 2013. Fichier > Quvrir un exempler> Curricula Vitae
Europass (2013) propose une aide a I'utilisation. La documentation est disponible via
CTAN.

3.4.2 Europe CV

La classe de documents Europe CV fournit I'acces a la classe de documents IXTEX
europecv.cls, une implantation officieuse du « CV Europass » recommandé par le
Commission Européenne en 2002. Fichiert> Ouvrir un exempler> Curricula Vitae> Europe
CV propose une aide a 'utilisation. La documentation est disponible via CTAN.

3.4.3 Modern CV

La classe de documents Modern CV fournit I'acces a la classe de documents IXTEX
moderncv.cls. Elle permet la création de CV personnalisables. Fichier>Quvrir un
exempler> Curricula Vitae> Modern CV propose une aide a 1'utilisation. La documenta-
tion est disponible via CTAN.

3.4.4 CV simple

La classe de documents CV simple fournit l'acces a la classe de documents IXTEX
simplecv.cls, développée a l'origine pour l'utilisation avec IyX. Fichier> Ouvrir un
exemple > Curricula Vitaer> CV simple propose une aide a 'utilisation. La documenta-
tion est disponible via CTAN
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3.5 Lettres

Voir aussi les classes KOMA-Script Letter (V. 2) (section 3.1.8.3), Letter (classe
standard avec tailles de polices supplémentaires) (section 3.1.2) et Lettre hébreu (sec-
tion 3.1.3).

3.5.1 DIN-Brief

La classe de documents DIN-Brief fournit 1'acces a la classe de documents KTEX
dinbrief.cls pour l’écriture de lettres conformes aux standards de l'institut al-
lemand de normalisation (Deutsches Institut fiir Normung, DIN). FichierNouveau
avec modeler Lettres> DIN-Brief propose une aide a l'utilisation. La documentation
est disponible via CTAN.

3.5.2 Lettre en francais (frletter)

La classe de documents Lettre en francais (frletter) fournit l'acces a la classe de
documents BTEX frletter.cls pour 'écriture de lettres conformes aux usages fran-
cais. Fichier>Nouveau avec modele> Lettrest> Lettres en francais (frletter) propose une
aide a l'utilisation.

3.5.3 Lettre en francais (lettre)

La classe de documents Lettre en francais (lettre) fournit l'acces a la classe de
documents KTEX lettre.cls, une autre classe pour ’écriture des lettres, mais aussi
des télécopies et des enveloppes. Fichier>Nouveau avec modeéle> Lettres> Lettres en
francais (lettre) propose une aide a 'utilisation. La documentation est disponible via
CTAN.

3.5.4 G-Brief (V.2)

La classe de documents G-Brief (V.2) fournit l'acces a la classe de documents
ITEX g-brief2.cls pour l'écriture des lettres en allemand. Fichier>Nouveau avec
modeéle > Lettres> G-Brief (V.2) propose une aide a l'utilisation. La documentation est
disponible via CTAN.

3.6 Présentations

3.6.1 Beamer

La classe de documents Beamer utilise la classe KTEX beamer.cls pour créer
des présentations. Fichierr>Nouveau avec modeéle> Présentations>Beamer ou Aider
Manuels spécifiques> Présentations Beamer proposent une aide a 1'utilisation. La do-
cumentation est disponible via CTAN.
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3.6.2 Foil TEX

Original par ALLAN RAE; mis a jour par I'équipe LyX.

3.6.2.1 Introduction

La classe de documents Foil TEX utilise la classe WTEX foils.cls pour préparer des
transparents pour rétroprojecteurs. Il y a deux classes de document qui le permettent :
la classe par défaut Diapos (section 3.6.5) et la classe FoilTeX. Cette section décrit
la seconde. La premiere est encore maintenue en 2023 alors que Foil TEX n’est plus
maintenue depuis 2008.

Si votre machine n’a pas la classe foils installée FoilTeX, il vous faudra stirement
utiliser la classe Diapos. Si vous voulez installer la classe de documents foils.cls
, elle est disponible via CTAN. Vous deviez lire également le chapitre Installer de
nouvelles classes du manuel de Personnalisation.

3.6.2.2 Pour commencer

Bien entendu, pour utiliser cette classe de document, il vous faut sélectionner
FoilTeX dans le champ Classe de la fenétre Document>Parameétres> Classe de docu-
ment. Il y a quelques autres réglages qui ont une signification spéciale avec cette
classe :

— ne changez pas les options Pagination et Colonnes dans la fenétre Document>
Parameétres. Elles sont ignorées par la classe foils.

— la taille par défaut est de 20 pt, les autres choix étant respectivement 17 pt,
25 pt et 30 pt.

— la police par défaut est Sans empattement mais toutes les équations mathéma-
tiques restent formatées dans la police habituelle Romain.

— Foil TEX accepte les formats de papier A4 et Letter, ainsi qu'un format particulier
pour travailler avec des diapos 35mm. Les tailles A5, B5, legal ou executive ne
sont pas supportées.

— ne vous occupez pas de Placement des flottants : I'option est de toute facon
ignorée. Tous les flottants apparaitront la ou ils sont définis dans le texte.

— les réglages Mise en page se comportent un peu différemment avec cette classe.
Foil TEX propose en effet des possibilités plus étendues pour les en-tétes et
pieds de page, comme l'insertion d'un logo défini par l'utilisateur. Voyez la
section 3.6.2.4 pour de plus amples détails. La page de titre est traitée diffé-
remment de toutes les autres pages du document et n’est jamais numérotée.
L’éventuel logo y est toujours centré au bas de la page. Les différentes mises en
page possibles sont les suivantes :

vide les diapos ne présenteront ni numéro de page, ni en-téte ou pied
de page (sauf évidemment les notes de bas de page).
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ordinaire les diapos auront un numéro de page centré en bas de la page.

Ni en-téte, ni pied de page (a part les notes).

foilheadings le numéro apparait en bas a droite. Les en-tétes et pieds de page

seront présents. C’est le choix par défaut.

sophistiqué vous donne acces au paquetage fancyheadings, et ce méme si son

utilisation est déconseillée par 'auteur de Foil TEX car certaines
incompatibilités apparaissent.

Options supplémentaires Les options suivantes peuvent étre activées dans le champ
Options de la fenétre Document > Parametrest> Classe de document.

35mmSlide regle le format de page a 7,33 pouces sur 11 pouces, ce qui donne le

headrule

footrule

dvips

landscape

legno

fleqn

méme rapport largeur/hauteur qu'une diapo 35mm, facilitant ainsi le
travail avec ce support.

trace une ligne horizontale le long de la page, au-dessous de 'en-téte,
sur toutes les pages sauf celle de titre.

trace une ligne horizontale le long de la page, au-dessus du pied de
page, sur toutes les pages sauf celle de titre.

indique a Foil TEX d’utiliser le pilote dvips pour effectuer les rotations
des pages en format paysage. (Elle est automatiquement activée a la
création d'un nouveau document foils).

change simplement la taille des pages au format paysage, mais sans
effectuer de rotation. Si vous utilisez cette option, vous aurez besoin
d’un programme externe pour effectuer une rotation de chaque page,
ou bien il vous faudra alimenter votre imprimante directement en for-
mat paysage. Remarquez que cette option renverse les roles respectifs
des environnements En-téte_Diapo et En-téte_Diapo_Tourné (ne vous
inquiétez pas, ils sont décrits plus loin).

numérote les équations a gauche.

aligne les équations a gauche.

3.6.2.3 Environnements supportés

La plupart des environnements courants sont supportés par la classe foils. Il y a
des environnements supplémentaires fournis par Foil TEX ainsi que deux apportés par
LyX. Les environnements suivants sont partagés avec d’autres classes :

— Standard — LyX-Code
— ListePuces — Vers

— Enumération — Cite

— Description — Citation
— Liste — Titre
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— Auteur — Bibliographie
— Date — Adresse
— Abstract — Adresse_A_Droite

En gros, il s’agit de tous les environnements principaux, mis a part ceux de section.
En effet, dans un diaporama, les sections sont en fait les diapos elles-mémes. Foil TEX
propose des commandes pour commencer de nouvelles diapos :

— En-Téte_Diapo (Foilhead)
— En-Téte_Diapo_Tourné (RotateFoilhead)
LyX a aussi des versions légerement modifiées de ces deux environnements :
— En-téte_Diapo_Court (ShortFoilhead)
— En-téte_Diapo_Court_Tourné (ShortRotateFoilhead)

Les différences seront expliquées dans une autre section.
De plus, les diapos sont souvent utilisées pour exposer des idées, ou de nouveaux
théoremes. De ce fait, Foil TEX fournit aussi un ensemble d’outils pour les présenter :

— Théoreme — Théoréme*

— Lemme C Lemme*

— Corollaire -
" — Corollaire

— Proposition

— Définition Proposition

— Preuve — Définition*

Les versions sans étoile sont numérotées, tandis que celles avec étoile ne le sont
pas. Il y a enfin des environnements de liste ajoutés par IyX :

— ListeCochés (TickList)
— ListeCroix (CrossList)

Foil TEXoffre aussi de nombreuses possibilités pour les en-tétes et pieds de pages, qu’il
vaut mieux définir dans le préambule, bien que vous puissiez le faire a tout moment
dans le document. Si vous souhaitez changer ces réglages en cours de document, il est
préférable de le faire au tout début d’une diapo, donc juste apres 1’En-téte_Diapo.
Pour ces réglages, vous disposez des environnements suivants [MARTIN VERMEER] :

— Mon_Logo (My_ Logo) — En-téte_Droite (Right Header)
— Restriction — En-téte_Gauche (Left_ Header)
— Pied_Droit (Right_ Footer)

Certaines commandes de Foil TEX ne sont pas directement supportées par [yX, mais
vous pourrez tout de méme les utiliser, comme 'explique la section 3.6.2.5.
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3.6.2.4 Création de diapos

Cette section est une rapide introduction aux différents environnements qui per-
mettent de construire un ensemble de diapos. Si vous voulez un exemple, ouvrez
Fichier>Quvrir un exemple > Présentations Foils.

Donner un titre de page A la différence des autres classes qui proposent les envi-
ronnements Titre, Auteur et Abstract, la classe foils crée le titre sur une page a part.
Si vous laissez 'environnement Date vide, KTEX lui substituera la date du jour (et
ce, a chaque fois que vous générerez le rendu).

Débuter une nouvelle diapo Comme il est dit plus haut, il existe quatre manieres
de commencer une nouvelle diapo. Pour les formats portrait, utilisez En-téte_Diapo
ou En-téte_Diapo_Court. La différence entre ces deux environnements est la quantité
d’espace entre le titre (I’'En-téte_Diapo) et le corps de la diapo.

Les diapos en position paysage seront créées via les environnements En-téte_ Diapo_Tourné
et En-téte_Diapo_Court_Tourné. A nouveau, la seule différence est I'espace entre le
titre et le corps. Les deux versions courtes ont 0,5 pouce de séparation en moins.

Il vous faut dvips pour générer des sorties PostScript de diapos en format paysage,
sans quoi la rotation de ces diapos ne sera pas exécutée. Il vous sera possible d’obtenir
des diapos en format paysage sans dvips, mais il vous faudra introduire les feuilles
en position couchée dans I'imprimante ;-)

Théoremes, lemmes, preuves et tutti quanti Deux de ces environnements ne
peuvent se suivre directement. Ils doivent étre séparés par quelque chose. Si vous
utilisez une rupture normale de paragraphe, vous allez juste allonger I’environnement
précédent comme si vous aviez fusionné les deux environnements. Plutét que de faire
cela, vous devez insérer un « séparateur ». Voyez la section intitulée E'mboitements
séparés dans le Guide de ['utilisateur.

Listes Vous pouvez profiter de tous les types de listes que I'on trouve dans les autres
classes plus deux nouvelles. Je ne décrirai ici que ces dernieres. Si vous voulez plus
d’informations sur les autres environnements de liste, voyez le Guide de [’Utilisateur.
Si vous voulez utiliser les listes a puce, lisez aussi le paragraphe sur le choix des puces,
a la section 6.

Les deux nouveaux environnements de liste, ListeCochés et ListeCroix, ont pour
but de faciliter 'utilisation de listes « A faire / A éviter » ou « Oui / Non », bref,
qui utilisent comme puces des coches ou des croix. Ces listes sont en fait des versions
spécialisées de ’environnement ltemize. Elles nécessitent cependant que vous disposiez
du paquetage psnfss.

Figures et tableaux Foil TEX redéfinit la notion de figures et tables flottantes afin
qu’elles apparaissent exactement la ou elles sont dans le texte plutét qu’en haut des
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pages ou en une quelconque autre position prédéfinie. En fait, si vous changez les
réglages de positionnement des flottants, ces modifications ne seront pas prises en
compte.

En-tétes et pieds de pages Les deux commandes Mon_Logo et Restriction servent
a définir le texte en pied de page a gauche. La premiere vous permet d’insérer un logo
sur vos diapos. Vous aurez implicitement comme logo « -Typeset by Foil TEX- ». La
seconde sert a classifier des documents en fonction du type de public, par exemple
« Confidentiel ». Par défaut elle ne contient rien.

Vous pouvez remplir les autres coins de la page avec Pied_Droite (qui par défaut
contient le numéro de page), En-téte_Droite et En-téte_ Gauche.

3.6.2.5 Fonctions de Foil TEX non-supportées

Toutes les commandes décrites ci-dessous doivent étre entrées dans un environne-
ment BTEX, ou en mode TEX dans un autre environnement.

Longueurs Toutes les longueurs sont ajustées en utilisant la commande \setlength-

{nom__longeur}{nouvelle_longeur} ou nom__longeur sera remplacé par le nom de la

variable de longueur que vous voulez modifier, et nouvelle longeur par la valeur de

la variable. Toutes les variables de longueur doivent étre indiquées dans des unités

comme le pouce (in), le millimetre (mm) ou le point (pt), ou bien dans une unité

dépendant du document ou de la police employée, comme \textwidth.
Il est possible de changer 'espacement entre ’en-téte et le corps d’une diapo en

ajustant la longueur spécifiée par \foilheadskip. Par exemple, pour rendre tous les

titres plus proches des corps de 0,5 pouce, mettez dans le préambule \setlength{\foilheadskip}{-0.5:
L’espacement autour des flottants peut étre modifié via ces variables :

\abovefloatskip séparation entre le texte et le haut du flottant ;
\abovecaptionskip séparation entre le flottant et sa légende;
\belowcaptionskip séparation entre la légende et le texte qui la suit;

\captionwidth vous permet de rendre les légendes plus étroites que le texte
alentour. Le mieux est stirement de la définir en fonction de
\textwidth.

Il y a aussi plusieurs variables de longueur relatives a la page de titre. Elles vous
seront utiles dans le cas d’un titre long, ou de plusieurs auteurs :

\abovetitleskip séparation entre les en-tétes et le titre (environnement Titre) ;
\titleauthorskip entre les environnements Titre et Auteur;
\authorauthorskip entre différentes lignes de I’environnement Auteur ;
\authordateskip entre 'auteur et la date;

\dateabstractskip entre la date et le résumé (Abstract).
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La derniere des commandes d’ajustement de longueur agit sur tous les environnements
de liste. Si vous placez \zerolistvertdimens dans un environnement de liste, tout
I’espacement vertical entre les éléments de la liste est supprimé. Remarquez qu’il
s'agit d'une commande et non d’une variable, donc on n’utilise pas ici \setlength.

En-tétes et pieds de page Les commandes \LogoOn et \LogoOff permettent de
préciser dans une page donnée si le logo de Mon_Logo apparaitra ou non. Si vous
mettez \LogoOff dans le préambule, aucune des diapos n’aura de logo. Si c¢’est uni-
quement sur une diapo particuliere que vous ne voulez pas de logo, mettez \LogoOff
juste apres le début de cette diapo et \LogoOn juste apres le début de la suivante.

Si vous voulez utiliser le style d’en-tétes sophistiqué dans la fenétre Document>
Parameétres > Format de la page, il vous faudra stirement ajouter \let\headwidth\textwidth
a votre préambule. Ainsi, en format paysage, les en-tétes et les pieds de page seront
positionnés correctement une fois les pages retournées. C’est obligatoire a cause d’in-
compatibilités entre le paquetage fancyheadings et la classe Foil TeX.

3.6.3 Powerdot

La classe de documents Powerdot utilise la classe KTEX powerdot.cls pour créer
des présentations. Fichier>Quvrir un exemple > Présentations > Powerdot propose une
aide a l'utilisation. La documentation est disponible via CTAN.

3.6.4 Seminar

La classe de documents Seminar utilise la classe BTEX seminar.cls pour créer des
présentations. Fichier> Ouvrir un exemple> Présentations>Seminar propose une aide a
I'utilisation. La documentation est disponible via CTAN.

3.6.5 Diapos Slides (alias SIiTEX)

par JOHN WEISS ; mise a jour par 1'équipe [y X

3.6.5.1 Introduction

Cette section décrit comment utiliser LyX pour préparer des transparents pour
rétroprojecteurs. Il y a deux classes de document qui le permettent : la classe Diapos et
la classe FoilteX. Cette section décrit la premiere. Si vous cherchez la documentation
de FoilTEX, voyez la section 3.6.2. En 2023, Diapos reste maintenue alors que la
maintenance de Foil TEX s'est arrétée en 2008.

3.6.5.2 Pour commencer

Avant tout, pour utiliser cette classe de document, vous devez sélectionner « Dia-
pos » comme Classe dans la fenétre Document > Paramétres. Il y a quelques particula-
rités qu’il faut connaitre a propos de cette classe :
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— ne vous fatiguez pas a changer les options Pagination et Colonnes dans Docu-
ment > Parameétres : de toute fagon, elles ne sont pas supportées par la classe
Diapos.

— l'option Mise en page de la fenétre Document > Paramétres a un comportement
un peu différent pour cette classe. Voici les choix possibles et leurs effets :

ordinaire le rendu final contient des numéros de page dans le coin inférieur
droit ;

en-tétes comme ordinaire, mais imprime aussi tous les marqueurs temporels
que vous aurez placés. C’est le choix implicite ;

vide le rendu final ne contient pas de numéros de page, de marqueurs temporels
ni de marqueurs d’alignement.

— La classe Diapos a une option supplémentaire : clock. Pour 'utiliser, mettez
« clock » dans les Options de la fenétre Document>Parameétrest> Classe de do-
cument.

Utiliser cette option vous permet d’ajouter des marqueurs temporels aux Notes.
Voir la section 3.6.5.4 pour plus de détails.

Vous pouvez aussi utiliser le fichier modele pour mettre en place automatiquement
un document de la classe Diapos (avec Fichiert> Nouveau avec modeéle> Présentations >
Diapos pour créer votre document). Le fichier modéle contient aussi quelques exemples
d’environnements de paragraphe spéciaux utilisés par cette classe. Je vais maintenant
décrire ces derniers.

3.6.5.3 Environnements de paragraphe

Environnements supportés La premiere chose que vous allez remarquer en com-
menc¢ant un nouveau document Diapos est la taille et le type de police : il est équi-
valent a la taille Grand (3) dans la police Sans empattement. C’est aussi la police qui
est utilisée pour le rendu final. Dites-vous que c’est un « indice visuel » pour vous
rappeler que c’est une diapositive. Vos transparents finaux utiliseront une grande
police, donc vous aurez moins de place. Bien sfir, la police plus grande a ’écran n’est
pas WYSIWYG, mais juste un aide-mémoire.

La deuxiéme chose qui frappe est le changement du menu des environnements (tout
a gauche de la barre d’outils). La plupart des environnements de paragraphe que vous
avez ’habitude d’y voir sont absents. Il y en a aussi cinq nouveaux. C’est parce que
la classe Diapos elle-méme ne supporte que certains environnements de paragraphe :

— Standard
— ListePuces
— Enumération
— Description
— Liste

— Citation
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— Cite
— Vers
— Légende
— LyX-Code
Tous les autres environnements standard, comme les en-tétes de section, ne servent

pas dans la classe Diapos.
D’autre part, vous remarquerez de nouveaux environnements :

— Diapo (Slide)
— Surcouche (Overlay)
— Note

— Texte_Invisible (InvisibleText)
— Texte_Visible (VisibleText)

Ces cing-la présentent des subtilités, dues a une « fonction » de LyX. LyX, voyez-
vous, ne vous autorise pas a inclure un environnement de paragraphe dans un envi-
ronnement vide. C’est sympa et marrant, mais cela signifie que vous ne pourrez pas
commencer une diapo par autre chose que du texte. Pour contourner cela, j’ai fait un
peu de « magie KTEX ».

Subtilités des nouveaux environnements Les cing nouveaux environnements de
paragraphe présentent tous des bizarreries, dues aux limitations inhérentes a la ver-
sion actuelle de LyX. Comme je viens de le dire, LyX interdit les environnements
qui commencent par un autre environnement. Pour contourner ceci, I’environnement
Diapo n’en est pas vraiment un, si I’on se fie a la description du Guide de [’Utilisateur.

Il faut considérer Diapo, Surcouche et Note comme des « pseudo-environnements ».
Ils ressemblent a des en-tétes de section ou a une Légende, mais en fait commencent
un environnement de paragraphe (et terminent le précédent si nécessaire). De la méme
maniere, considérez Texte_ Invisible et Texte_ Visible comme des « pseudo-commandes ».
Ces deux objets réalisent en effet des actions.

Un propriété commune aux cing environnements Diapo, Surcouche, Note, Texte_ Invisible
et Texte_Visible est un marqueur plutét longuet. Le texte suivant ce marqueur — d’or-
dinaire le contenu de ’environnement de paragraphe — n’est pas pris en compte par
Diapo, Surcouche, Note, Texte_Invisible et Texte_Visible. Iy’X I'ignore totalement. En
fait, vous pouvez laisser ces cinq environnements completement vides.

Bien qu’il ne soit pas obligatoire de mettre du texte apres ces marqueurs, vous
pouvez le faire. Ca peut étre une breve description du contenu de la Diapo, par
exemple. Dans ce cas, entrez votre description et tapez Entrée comme vous le feriez
normalement.

3.6.5.4 Réaliser une présentation grace a Diapo, Surcouche et Note

Utiliser I'’environnement Diapo Si vous espérez apprendre dans cette section com-
ment faire une présentation orale, vous serez amerement décu. Naturellement, je vais

46



CHAPITRE 3. CLASSES DE DOCUMENT 3.6. PRESENTATIONS

vous décrire en quoi la classe Diapos pourra vous aider a préparer les supports de
la présentation. En revanche, le contenu de celle-ci est entierement de votre ressort.
(C’est ga aussi, la philosophie Iy X1)

Sélectionnez l'environnement Diapo (de la maniere décrite a la section 3.6.5.3)
pour dire & [yX de commencer une nouvelle diapo (eh oui). Le marqueur pour cet
environnement / « pseudo-commande » est une « ligne ASCII » en bleu, suivie de
I'indication « NewSlide : ». Tout texte ou paragraphe qui suivra cette derniere fera
partie de la nouvelle diapo. C’est aussi simple que ca.

Les diapos sont stirement les seules fois dans LyX ou vous aurez a forcer la fin
des pages (vous pouvez toujours le faire dans Edition > Parametres de Paragraphe). En
fait, vous devrez le faire une fois vous aurez fini d’entrer le contenu d’une diapo. Si
vous avez entré plus de texte qu'un transparent ne peut physiquement en contenir, le
surplus débordera sur une nouvelle diapo. Je vous déconseille de le faire, cependant,
car la diapo « de surplus » ne présentera aucun numéro de page. De plus, elle peut
interférer avec une Surcouche que vous aurez préparé pour accompagner la Diapo trop
remplie.

Les environnements Surcouche et Note fonctionnent comme ’environnement Diapo.
Tous deux créent une « ligne ASCII » suivie par un marqueur (« NewOverlay : »
et « NewNote : », respectivement). La couleur n’est plus le bleu, mais un magenta
éclatant et la « ligne ASCII » se présente différemment, dans son style et sa longueur.
Les trois marqueurs different par leur police.

Comme pour 'environnement Diapo, si le contenu d’une Note ou d’une Surcouche
dépasse la taille physique d'un transparent ou d'une feuille de papier, le surplus
sera disposé sur une nouvelle page. A nouveau, je vous le déconseille, les Notes et
Surcouches n’auraient plus aucune utilité.

Utiliser des Surcouches avec des Diapos L’idée d’une Surcouche est de créer une
diapo qui vienne se superposer a une autre. Vous pouvez vouloir présenter une figure
sur la Diapo principale avant d’afficher le texte qui va avec. Une fagon de faire est de
poser une feuille de papier noire sur la partie de la Diapo que vous souhaitez cacher.
Cette méthode, cependant, n’est pas valable si vous voulez par exemple superposer
un graphique a un autre. Vous auriez alors a vous bagarrer, tout en parlant, avec
les deux Diapos pour que les graphiques se superposent. L’utilisation des Surcouches
rend les choses bien plus faciles.

Chaque Surcouche recoit le numéro de page de la Diapo « parent », agrémenté
d'un « -a »!%. En effet, vous voulez que la Diapo et sa Surcouche paraissent n’en
former plus qu’'une! Vous pouvez considérer une Surcouche comme « faisant partie »
d’'une Diapo. En fait, la classe Diapos le laisse voir~ : le marqueur qui débute un
environnement Surcouche est moins long que celui d’une Diapo. Enfin, sur le document
imprimé apparaitront des marques d’alignement aux quatre coins de la Surcouche et
de la Diapo. Ces marques vous aideront a aligner les deux transparents.

Le principal probléme de la superposition de transparents est d’aligner les contenus

15. Des Surcouches multiples auront donc « -b », « —c », etc. accolé au numéro de page.
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de ces diapos. Quel espace devez-vous laisser pour le graphique sur la deuxieme diapo ?
Pire encore : que faire si sur le deuxiéme transparent vous voulez un graphique et
du texte, mais qu'une phrase du premier doit venir s’intercaler entre les deux ? Vous
pourriez essayer d’insérer un espace vertical de la bonne taille entre les deux, mais le
meilleur moyen est d’utiliser les environnements Texte_ Visible et Texte_ Invisible.

Comme leur nom l'indique, Texte_Visible et Texte_Invisible sont deux environne-
ments de paragraphe, qui rendent le texte respectivement visible et invisible. Remar-
quez a la section 3.6.5.3 que vous ne placez rien dans ces environnements. Lorsque
vous créez un Texte_|Invisible, Iy/X insere un marqueur centré, bleu clair, indiquant
« <Invisible Text Follows> ». Les paragraphes suivant ce marqueur ne seront pas
affichés sur la diapo (ou la Surcouche), mais 'espace qu’ils auraient occupé sera laissé
vide.

Pour Texte_Visible, I'étiquette centrée sera « <Visible Text Follows> », en vert.
Les paragraphes qui suivent cette étiquette se comporteront normalement. Remarquez
qu’au début d’une nouvelle Diapo, Note, ou Surcouche, la fonction Texte_Invisible est
automatiquement désactivée. Il n’est donc pas nécessaire d’utiliser Texte_ Visible a la
fin d’'une Diapo.

Maintenant, voyons comment utiliser les commandes Texte_ Visible et Texte_ Invisible
avec les environnements Diapo et Surcouche pour créer des diapos superposées :

1. Créez une Diapo (environnement Diapo) avec tout ce qui devra apparaitre au-
tant sur la Diapo elle-méme que sur les Surcouches.

2. Avant chaque figure ou paragraphe qui ne devra apparaitre que sur la Surcouche,
insérez un environnement Texte_ Invisible. Si nécessaire, insérez un environne-
ment Texte_Visible la ou le texte devra de nouveau apparaitre sur la Diapo
principale.

3. Commencez un environnement Surcouche juste apres I’environnement Diapo.
4. Copiez le contenu de I’environnement Diapo dans I’environnement Surcouche.

5. Dans la Surcouche, changez tous les Texte_Invisible par des Texte_Visible et vice
versa.

C’est bon, vous avez votre superposition.

Il reste un probleme avec la facon dont j’ai congu la classe Diapos de Iy X : vous ne
pouvez pas rendre invisible du texte au milieu d'un paragraphe, ni rendre visible du
texte au milieu d’un paragraphe invisible. Pour ce faire, vous devrez insérer du code

IATEX 1.

16. Les commandes en question sont :

— {\invisible ...}
— {\visible ...}

. et devront étre entrées en mode TEX. Le texte dont vous voulez changer la « visibilité » sera
a lintérieur des accolades, derriére la commande \invisible ou \visible. Si vous ne savez pas
comment entrer du TEX sous LyX, voyez la section appropriée dans le Guide de I’Utilisateur.
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Utiliser des Notes avec des Diapos Comme une Surcouche, une Note est toujours
associée a une Diapo « parent ». Ici aussi, la classe Diapos de LyX fournit des indices
visuels. Le marqueur d’une Note est magenta éclatant, comme celui d’'une Surcouche;
et en longueur, il est intermédiaire entre celui d’une Diapo (qui est plus long) et celui
d’une Surcouche (qui est plus court). De plus, une fois imprimée, une Note aura le
numéro de page de sa Diapo « parent » avec « -1 », « -2 » « -3 » etc. accolé. Vous
pouvez avoir plusieurs Notes associées a une seule Diapo, et, comme pour les Diapos
et les Surcouches, vous voudrez stirement couper les longues Notes de maniere a ce
qu’elles tiennent sur une seule page.

L’utilité d'une Note est évidente : elle contient toute sortes d’informations que vous
voulez ajouter a propos d’une Diapo. Elle peut aussi servir d’aide-mémoire pour une
Diapo donnée. Dans ce dernier cas, vous serez peut-étre intéressé par les marqueurs
temporels. Actuellement, la classe Diapos de LyX ne supporte pas d’origine les mar-
queurs temporels, qui sont une fonction SLITEX. Il faudra donc passer par le code

BTEX.

Pour utiliser des marqueurs temporels, spécifiez avant tout 'option supplémentaire
« clock » (voir la section 3.6.5.2). Cette option active les marqueurs temporels qui
apparaitront alors dans le coin inférieur gauche de toutes les Notes que vous générerez.
Pour choisir ce qui apparaitra dans ces indicateurs, utilisez les commandes KTEX
« \settime{} » et « \addtime{} ». Le parametre de chacune de ces commandes est
un temps mesuré en secondes. « \settime{} » sert a indiquer le temps voulu, tandis
que « \addtime{} » est utilisé pour ajouter une certaine durée. En utilisant les Notes
et les marqueurs temporels, vous pouvez vous rappeler combien de temps vous voulez
passer sur chaque Diapo.

Il reste une fonction a décrire. Vous voudrez forcément imprimer toutes vos Dia-
pos et Surcouches sur des transparents et toutes vos Notes sur des feuilles blanches.
Cependant, une Note doit suivre la Diapo a laquelle elle est associée. Comment faire ?

Heureusement il existe deux commandes ETEX qui vous permettent de sélection-
ner ce qu’il faut imprimer. Toutes deux doivent étre placées dans le préambule de
votre document. La commande « \onlyslides{\slides} » n'imprimera que les Dia-
pos et les Surcouches. De méme, la commande « \onlynotes{\notes} » n’impri-
mera que les Notes. Je vous conseille de mettre les deux commandes en commentaire
dans votre préambule et de « décommenter » celle dont vous avez besoin a l'im-
pression. J’ai I’habitude de : décommenter « \onlyslides{\slides} », imprimer
dans un fichier dont le nom contient « -slides », la recommenter et décommenter
« \onlynotes{\notes} » et imprimer dans un fichier « *-notes ». Je peux ensuite
envoyer I'un ou l'autre fichier a I'imprimante, en mettant des transparents ou des
feuilles blanches selon le cas.

Vous pouvez aussi donner d’autres parametres a « \onlyslides{} » et « \onlynotes{} ».
Reportez-vous a un bon livre sur IXTEX pour plus de détails.
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3.6.5.5 Le fichier modele pour la classe Diapos

J’ai aussi créé un fichier modele avec la classe Diapos. Pour 'utiliser, créez votre
document avec Fichier>Nouveau avec modele > Présentations> Diapos. Votre nouveau
fichier de présentation IyX contiendra un exemple du triplet Diapo — Surcouche —
Note. De plus, la Diapo et la Surcouche contiennent un exemple de Texte_Invisible et
de Texte_Visible. Enfin, le préambule contient :

% Uncomment to print out only slides and overlays'’
b
%\onlyslides{\slides}

% Uncomment to print out only notes'®
)
%\onlynotes{\notes}

Un dernier point : j’ai créé cette classe pour l'utilisation de la classe de TEX 2¢
« émulation de SLITEX ». Ni moi ni le reste de P'Equipe LyX n’impose d’utiliser ou
de ne pas utiliser cette classe. Elle est 1a si vous en avez besoin. Il y a d’autres classes
de ITEX 2¢ pour créer des présentations, comme la classe Foils (cf. la section 3.6.2)
ou le paquetage seminar (présent sur certaines distributions TEX). Essayez-les pour
voir quelles alternatives elles représentent.

3.7 Rapports

Les classes Rapports constituent en quelque sorte une hybridation entre les classes
Livres et les classes Articles : comme les livres, elles proposent des parties, des cha-
pitres et des sections, mais ne prévoient pas de préliminaires (frontmatter), de corps
principal (mainmatter) et de compléments (backmatter); comme les articles, elles
proposent des styles pour le résumé et sont implicitement en recto seul. En outre,
elles ne positionnent pas un nouveau chapitre en page impaire, méme en mode recto-
Verso.

Toutes le classes Rapports en maintenance externe qui sont reconnues officiellement
par LyX sont décrites dans les Collections (section 3.1) :

— pour Rapport japonais (classe standard, écriture verticale), Rapport japonais (classe
standard) et les autres classes pour le japonais, voir la section 3.1.4.

— pour Report KOMA-Script, voir la section 3.1.8.

— pour Report (classe standard avec tailles de police supplémentaires), voir la sec-
tion 3.1.2.

— pour Rapport polonais (paquet MW), voir la section 3.1.9

17. NdT : Décommentez pour n’imprimer que les diapos et les sur-couches
18. NdT : Décommentez pour n’imprimer que les notes
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3.8 Scripts

Dans la catégorie Scripts, nous rassemblons les classes de documents permettant
d’écrire des pieces de théatre ou des scénarios de films. Cette catégorie est également
ouverte pour d’autres scripts, comme des scripts de cours, pour lesquels aucune classe
n’est encore reconnue par [yX cependant.

3.8.1 Broadway

par GARST REESE

3.8.1.1 Introduction

Broadway est destiné a I’écriture de pieces de théatre. Le format est plus décoratif
que Hollywood, et beaucoup moins standardisé. Ce format devrait convenir a des
ateliers.

3.8.1.2 Problemes particuliers

Les mémes que dans Hollywood.

3.8.1.3 Fonctions particuliéres

Entrez les noms des personnages comme étiquettes puis faites des références croi-
sées sur ces étiquettes pour insérer le nom. La fenétre de référence croisée montrera
I’ensemble des personnages.

3.8.1.4 Taille de papier et marges
USLetter, gauche 1,6 in, droite 0,75 in, haut 0,5 in, bas 0,75 in.

3.8.1.5 Environnements

Les environnements suivants sont disponibles. Vous pouvez utiliser broadway .bind
pour accéder aux touches de raccourci indiquées a droite.

— Standard
Vous ne devriez pas avoir a 'utiliser, mais il est 1a pour tout ce qui n’a pas sa
place ailleurs.

— Narrativeby M-z n
Utilisé pour décrire le décor et I'action. La premiere occurrence des noms des
personnages en MAJUSCULES.

— ACT (Acte) M-z a
Automatiquement numéroté. A I’écran sera en chiffres arabes, mais imprimé en
chiffres romains.
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— ACT* (Acte*) M-z S at
Sous-titre pour ACT. C’est juste du texte centré.
— SCENE M-z S-S

Pas automatiquement numéroté. Vous donnez le numéro. C’est parce que je
n’ai pas trouvé comment faire.

— AT _RISE (Lever de Rideau) M-z S-R
Un cas particulier de Narrative pour décrire le décor et I'action quand le rideau
se leve.

— Speaker M-z s
Le nom du personnage, centré en MAJUSCULES.

— Parenthetical (Didascalies) M-z p

Instructions au personnage. Les () sont insérées automatiquement, mais seule la
( sera affichée dans IyX. Les deux seront imprimées. Cet environnement n’est
utilisé qu’a l'intérieur de Dialogue.

— Dialogue M-z d
Ce que dit le personnage.

— CURTAIN (Rideau) M-z S-C
Le rideau tombe.

— Titre M-z 5-T

— Auteur M-z S-A

— Right_Address M-z r

Salut tout le monde.

3.8.2 Hollywood (scripts d’Hollywood)

par GARST REESE

3.8.2.1 Introduction

Maitriser le format d’un script d’Hollywood est un « rite de passage ». Ce format
est destiné a laisser le lecteur se concentrer sur le contenu et a étre facile a lire et
familier pour les acteurs. Chaque page d’'un script doit représenter une minute de
film. Il n’y a rien dans le script qui ne soit pas visible ou audible a 1’écran. La police
courier 12 pt doit étre utilisée tout le long. Pas d’italiques.

3.8.2.2 Problémes particuliers

Les lignes de dialogue ne doivent JAMAIS étre coupées au milieu d’une phrase. Si

le texte d’un personnage ' franchit un saut de page, repétez le nom du personnage
suivi de (Cont’d) .

19. NdT : Speaker
20. NdT : (suite)
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3.8.2.3 Fonctions particuliéres

Entrez les noms des personnages comme étiquettes, puis faites des références croi-
sées sur ces étiquettes pour insérer le nom. La fenétre de référence croisée montrera
I’ensemble des personnages. Vous pouvez utiliser cette méthode également pour in-
sérer le nom d’un personnage dans les parties narratives.

3.8.2.4 Taille de papier et marges

USLetter, gauche 1,6 in, droite 0,75 in, haut 0,5 in, bas 0,75 in.

3.8.2.5 Environnements

Les environnements suivants sont disponibles. Vous pouvez utiliser hollywood.bind
pour accéder aux touches de raccourci indiquées a droite.

— Standard
Quand rien d’autre ne convient. Essayez de 1’éviter.

— FADE_IN (Fondu?') : M-z S-|
Suivi en général de quelque chose comme « sur Sally qui se leve ».

— INT : M-z i

Introduit une nouvelle séquence INTERIEUR. Toujours suivi par JOUR ou
NUIT, ou quelque chose d’approchant pour définir ’éclairage nécessaire. Toute
cette ligne en MAJUSCULES.

— EXT : M-z e
Introduit une nouvelle séquence EXTERIEUR. Toute cette ligne en MAJUS-
CULES.

— Speaker M-z s
Le personnage qui parle.

— Parenthetical M-z p
Instructions au personnage intervenant. Les () sont insérées automatiquement.

— Dialogue M-z d
Ce qui dit le personnage.

— Transition M-z t
Instruction de mouvement de caméra.

— FADE OUT : M-z S-I

— Auteur M-z S-A

— Titre M-z S-T

— Right_Address M-z r

21. NdT : Incertain.
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3.8.2.6 Jargon de script

— (0.8S) — off screen (hors écran)
— (V.O) — voice over (voix off)

— b.g. — background (arriere-plan)
— C.U. — close-up (plan rapproché)
— PAN — mouvement de caméra

— INSERT - insérez un plan rapproché
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4 Modules

4.1 Particularités d’'un domaine académique

4.1.1 Chimie : mentions de danger et conseils de prudence

Ce module fournit deux inserts et un style de paragraphe pour imprimer les nombres
et les phrases des mentions de danger et des conseils de prudence pour la chimie. Pour
une description, voir Fichiert>Ouvrir un exempler>Modules> Chimie : mentions de dan-
ger et conseils de prudence et Aider>Manuels spécifiques> Chimie : mentions de danger
et conseils de prudence.

4.1.2 Chimie : énoncés de risque et sécurité

Ce module fournit deux inserts , numéro R-S et phrase R-S, accessibles via le menu
Insertion > Inserts personnalisables et un environnement pour imprimer les énoncés de
risque et sécurité. Ces énoncés sont devenus obsoletes, voir les mentions de danger et
conseils de prudence ci-dessus.

4.1.3 Linguistique

Ce document décrit quelques fonctionnalités de Iy X utiles aux linguistes. Il montre
comment utiliser ces fonctionnalités de base pour produire des exemples numérotés,
des gloses interlinéaires, des tableaux résultant de la théorie de I'optimalité, un ba-
lisage sémantique, des structures arborescentes, des structures de représentation du
discours (DRS) et des symboles phonétiques (API). Vous pouvez trouver des infor-
mations sur ce module via Aider>Manuels spécifiquest> Linguistique et Fichier>Ouvrir
un exemple> Modules> Linguistique.

4.2 Accessibilité

4.2.1 Braille

Ce module permet I’écriture du Braille. Il requiert le paquetage IXTEX braille.sty.
Ce paquetage et sa documentation sont accessibles via CTAN. Voir Aide>Manuels
spécifiques> Braille and Fichier> Quvrir un exempler> Modules > Braille.
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4.3 Annotation & revue

4.3.1 Notes FiXme

Ce module fournit des annotations (marginales) « FiXme » pour les besoins de
la revue de documents. Une liste d’annotations peut étre produite en utilisant la
rubrique du plan « Fixme ». Les annotations sont paramétrables via le préambule
ETEX, voir la documentation fixme qui peut étre obtenue via CTAN.

Note : implicitement, les annotations ne sont imprimées qu’en mode « draft »
(si l'option « draft » a été insérée dans Document > Paramétres > Classe de document >
Option de classe > Réglable). Pour les imprimer dans tous les cas, insérer \fxsetup{draft}
dans Document > Paramétres > Préambule IKTEX.

4.3.2 Commentaires PDF

Ce module fournit diverses sortes d’annotations pour I'impression PDF. Voir Aide >
Manuels spécifiques> Commentaires PDF et Fichier> Quvrir un exemple> Modules > Commentaires PDF.

4.3.3 Formulaires PDF

Ce module fournit champs et boutons pour les formulaires PDF. Voir la documenta-
tion hyperref, Aide > Manuels spécifiquest> Formulaires PDF et Fichier > Quvrir un exemple >
Modules> Formulaires PDF.

4.3.4 Ruby (Furigana)

Ce module définit un insert pour imprimer des aides a la lecture (ruby, furigana)
des caracteres chinois. Il utilise les paquetages okumakro, luatexja-ruby ou ruby
(en fonction du moteur TEX) ou une définition de secours.

4.3.5 Notes TODO

Ce module fournit des inserts adaptés a la saisie d’éléments TODO dans votre
document. Une liste des notes TODO peut étre produite en utilisant la rubrique
du plan « TODO ». L’insertion de final dans Document > Paramétres> Classe de do-
cument > Option de classe > Réglable supprime I'impression des notes TODO. Voir la
documentation todonotes.

4.4 Bibliographie
4.4.1 Style APA avec Natbib

Ce module ajoute les fonctionnalités utiles pour utiliser natbib avec apacite (le
style bibliographique n’a pas a étre nécessairement apacite — il peut étre apacite,
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apacitex, ou n'importe quel style qui fonctionne avec a la fois les paquetages natbib
et apacite).

4.5 Boites

4.5.1 Boites colorées sophistiquées

Ce module ajoute dix inserts personnalisés produisant des boites colorées a 'aide
du paquetage tcolorbox. Voir Aider>Manuels spécifiques> Boites colorées, Fichierr
Ouvrir un exemple> Modules> Boites colorées sophistiquées et la documentation tcolor-
box pour les détails.

4.5.2 Boites graphiques

Ce module fournit les inserts personnalisés BoiteMiroir, BoiteRetaillée, BoitePivotée
et BofteEchelle pour mettre & 1’échelle et faire pivoter le contenu.

BoiteMiroir offre un moyen simple de mettre le texte en miroir sans autre amélio-
ration.

vswlisf m1o3eoW 3s910)

(Vous devrez utiliser Ctrl-R (visionner) pour afficher I'un quelconque de ces exemples).

BoiteRetaillée vous permet de spécifier les dimensions du texte ou de I'image; les
unités possibles sont em, ex, in, pt, pc, cm, mm, dd, cc, nd, nc, bp, or sp; si vous
saisissez ! pour Hauteur la mise a ’échelle utilise le facteur de largeur :

Great Western Railway

BoitePivotée vous permet de faire tourner son contenu autour du point de référence
de la boite. Si vous voulez la faire tourner autour d’un point différent, placez le curseur
dans la boite et sélectionnez Insérer > Origine; origin est précisée via les lettres c, 1,
r, b, t ou une combinaison signifiante de celles-ci, et ’angle de rotation dans le sens
contraire des aiguilles d'une montre est en degrés. Par exemple :

Vous pouvez combiner les boites comme ici :

B[ .

BoiteEchelle met le contenu a 'échelle ; sélectionnez Insérer > Facteur-V pour ajouter
un multiplicateur vertical. Si ce multiplicateur est omis, le facteur horizontal est

utilisé. Insérer des facteurs différents crée un distorsion comme ici :

Great Western Railway.
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Une valeur négative horizontale met le texte en miroir sur I’axe horizontal, une
valeur négative verticale sur 1’axe vertical, et vous obtenez donc

yswlisf moeoW 3s910

et

CL69f MERFELT IT[MIN

4.5.3 Section Boxes

Ce module définit les boites avec un en-téte de section. Il sert essentiellement pour
la classe de documents SciPoster.

4.5.4 Minipages a largeur variable

Ce module ajoute un insert Minipage (larg. variable) a Insertionr>Inserts personna-
lisables en utilisant la paquetage IIEX varwidth. Ce paquetage fournit une mi-
nipage a largeur variable, dont la largeur résultante est celle de son contenu (si
elle n’excede pas la largeur maximum spécifiée). L'insert a deux arguments facul-
tatifs qui peuvent étre ajoutés en placant le curseur dan la minipage et en sai-
sissant Insertion> Ajustement vert. (c|t|b) ou Insertion> Largeur max. (implicitement
\linewidth). Voir Fichier>Ouvrir un exemple>Modules>Minipages a largeur variable.

4.6 Solutions & astuces

4.6.1 Polices Computer Modern corrigées

Ce module utilise le paquetage fix-cm pour améliorer I’apparence des polices Com-
puter Modern et les rendre disponibles avec des tailles arbitraires. Voir la documen-
tation fix-cm.

4.6.2 Corrections du noyau BTEX (obsoléte)

Ce module charge le paquetage fixltx2e qui contient quelques corrections de
bogues pour I¥TEX. Si vous utilisez ce module, 'impression du document peut varier,
en fonction de la version importée de fixltx2e.

Note : les noyaux ITEX récents (depuis le 01/01/2015) incluent la fonctionnalité
de fix1ltx2e, en conséquence le module fixltx2e est obsolete avec des distributions
KTEX postérieures.

4.6.3 Inserts minimalistes

Ce module redéfinit plusieurs inserts (Index, Branche, URL) sous forme minima-
liste.
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4.6.4 Astuces pour le titre et le préambule

Ce module propose deux styles de paragraphe nouveaux :

1. Dans le préambule met tout ce qui est saisi dans le préambule. Ceci peut étre
utilisé, a la demande, pour inclure du code de préambule dans le corps d’un
document LyX.

2. Dans le titre met tout son contenu dans le corps du document I¥TEX, mais avant
que la commande \maketitle soit émise. Ceci est utile pour créer des branches
et des notes dans le matériau relatif au titre. (Cependant, si vous les mettez
en Format standard, ceci demande a LyX d’émettre \maketitle, qui peut alors
venir trop tot.)

4.7 Flottants & légendes

4.7.1 Flottant d’Algorithm2e

Ce module utilise le paquetage algorithm2e pour les flottants d’algorithme plutot
que le flottant d’algorithme maison de IyX. Utiliser le style de paragraphe Algorithme
pour saisir et indenter 1’algorithme. Voir la documentation algorithm2e.

4.7.2 Légendes bilingues (multilingues)

Ce module fournit le style de paragraphe Mise en forme légende permettent d’im-
primer des légendes bilingues. Dans ce style de paragraphe Insertion>Langue vous
permet de saisir la seconde langue désirée en utilisant son nom babel. Voir Fichier
Ouvrir un exemple > Modules > Légendes multilingues et Aide > Manuels spécifiques > Légendes mul-
tilingues pour plus d’information sur son utilisation.

4.7.3 Numérotation des figures par section

Ce module remet a zéro le numéro de figure au début de chaque section et précede le
numéro de figure par le numéro de section, comme dans « Figure 2.1. ». (Implicitement
les classes livre et rapport numérotent par chapitre et les classes article ont une seule
séquence de numéros.)

4.7.4 Numérotation des tableaux par section

Ce module remet a zéro le numéro de tableau au début de chaque section et précede
numéro de tableau par le numéro de section, comme dans « Tableau 2.1. ». (Implici-
tement les classes livre et rapport numérotent par chapitre et les classes article ont
une seule séquence de numéros. )
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4.8 Notes de bas de page et notes en fin de document

4.8.1 Notes en fin de document (basiques)

Ce module ajoute un insert endnote en plus des notes de bas de page. Il utilise la pa-
quetage endnotes, qui a quelques limitations mais fonctionne également avec les ver-
sions anciennes de I{TEX. Utiliser Insertion > Inserts personnalisables > Notes en fin de do-
cument pour insérer un note et Insertion > Listes/Matieres /Références> Notes en fin de do-
cument pour insérer la liste des notes ou vous voulez qu’elle apparaisse. Voir aussi
Aide> Objets insérés, section 4.2 Notes en bas de page.

4.8.2 Notes en fin de document (étendues)

Ce module ajoute un insert endnote en plus des notes de bas de page. Il utilise
la paquetage enotez, qui est plus puissant et plus paramétrable que le paquetage
endnotes, mais qui requiert une distribution ITEX plutét moderne (avec IXTEX3).
Utiliser Insertion > Inserts personnalisables>Notes en fin de document pour insérer un
note et Insertion > Listes/Matiéres/Références> Notes en fin de document pour insérer
la liste des notes ou vous voulez qu’elle apparaisse. Voir aussi Aider Objets insérés,
section 4.2 Notes en bas de page.

4.8.3 Notes de bas de page renvoyées en fin de document
(basiques)

Ce module transforme les notes de bas de page en notes en fin de document.
Il utilise la paquetage endnotes, qui a quelques limitations mais fonctionne égale-
ment avec les versions anciennes de IXTEX. Utiliser Insertion > Inserts personnalisables >
Notes en fin de document pour insérer un note et Insertion > Listes/Matiéres /Références>
Notes en fin de document pour insérer la liste des notes ou vous voulez qu’elle appa-
raisse. Voir aussi Aider> Objets insérés, section 4.2 Notes en bas de page.

4.8.4 Notes de bas de page renvoyées en fin de document
(étendues)

Ce module transforme les notes de bas de page en notes en fin de document. Il utilise
la paquetage enotez, qui est plus puissant et plus paramétrable que le paquetage
endnotes, mais qui requiert une distribution IXTEX plutot moderne (avec TEX3).
Utiliser Insertion > Inserts personnalisables>Notes en fin de document pour insérer un
note et Insertion > Listes/Matieres/Références> Notes en fin de document pour insérer
la liste des notes ou vous voulez qu’elle apparaisse. Voir aussi Aide> Objets insérés,
section 4.2 Notes en bas de page.
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4.9 Loisirs, sport et musique

4.9.1 Echiquier

Ce module permet d’accéder au paquetage chessboard pour imprimer des par-
ties d’échecs. Voir Fichier>Ouvrir un exempler> Articlest> Echiquier, ot vous trouverez
Partie 1 et Partie 2, et le lien vers la documentation de chessboard .

4.9.2 Notation du format musical Lilypond

Ce module fournit un insert via Insertion> Inserts personnalisables®> Lilypond dans
lequel saisir du code adapté a 1’éditeur de musique LilyPond. Ce code sera en-
suite traité dans la sortie imprimable. Voir AiderManuels spécifiquest Lilypond et
Fichier>OQuvrir un exempler>Modules> Lilypond. I ne peut pas étre utilisé si les mo-
dules Rnw (knitr) ou Sweave ont été chargés.

4.10 Améliorations des listes

4.10.1 Listes personnalisables

Ce modulez utilise le paquetage enumitem pour permettre le paramétrage de divers
environnements de liste.

4.10.1.1 Paramétrage des énumérations

La numérotation implicite des énumérations peut étre modifiée pour ajouter un argu-
ment facultatif (menu Insertion > Options d'énumération) au premier élément de chaque
niveau de la liste. Vous ajoutez la commande

label=\roman{enumi}

en code TEX Code (raccourci ).

enumi est le premier niveau de compteur de I’énumération. Pour modifier la numé-
rotation des sous-niveaux de liste, remplacer le « i » de la commande par le numéro
romain du niveau concerné (enumi, enumii, enumiii, enumiv).

La commande \roman produit un numéro romain en bas de casse. Pour obtenir une
numérotation romaine en capitales, remplacer \roman par \Roman dans la commande
ci-dessus. Pour les chiffres arabes, utiliser \arabic. Pour « numéroter » les éléments
avec des lettre latines en capitales ou en bas de casse, utiliser \Alph ou \alph, respec-
tivement.

Note : vous ne pouvez numéroter que 26 éléments avec des lettres latines, parce que
cette numérotation ne peut utiliser qu’une seule lettre.

Voici une liste paramétrée :

#A# Niveau 1
A.1 Niveau 2
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A.2 Niveau 2
1 Niveau 3
i) Niveau 4

Pour cette liste, les commandes suivantes ont été utilisées :
label=\#\Alph{enumi}\#
label=\Alph{enumi}.\arabic{enumii}
label=\bfseries{\ arabic{enumiii} }
label=\emph{\roman{enumiv})}

ou la commande \emph{} met le numéro en évidence et la commande \bfseries{}
le met en gras.

Note : si vous modifiez la numérotation d’un niveau de liste, cette numérotation
sera utilisée jusqu’a ce que vous le redéfinissiez.

4.10.1.2 Paragraphes numérotés dans les rapports

4.10.1 Les rapports officiels incluent souvent des paragraphes numérotés ; vous pouvez
faire cela via une variante de ’approche proposée a la section 6.3. Remplacez
dans chaque élément item par enum.

4.10.2 Les paragraphes numérotés ici ont été créée en insérant le code
\renewcommand{\labelenumi}{\thesection.\arabic{enumi}}
avant le début de la section; \thesection utilise le compteur de section KTEX
pour engendrer le début du numéro..

4.10.3 L’en-téte de subsection a été ignoré dans cet exemple parce que, avec des pa-
ragraphes numérotés de cette facon, les subsections sont moins susceptibles
d’utilisation.

4.10.1.3 Reprise d’énumération

Les énumérations peuvent étre reprises apres des paragraphes intermédiaires :
1. premier
2. second
texte standard
3 reprise

Pour reprendre une énumération, utiliser le style Enumeration-Reprise.

Note : s’il n’y a pas d’énumération a reprendre, il y aura une erreur KTEX.

Vous voudrez peut-étre reprendre une liste avec un numéro différent du prochain.
Ou vous désirez une énumération avec un numéro défini. Ceci est possible en ajoutant
un argument facultatif a un élément de la liste d’une énumération normale. Ici, insérez
la commande

start=numéro

ou numéro est la valeur que vous souhaitez pour reprendre la liste. Un exemple :
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1 premier élément
2 second élément
Enumération démarrant a une valeur donnée :

4 Lénumération commence a 4

4.10.1.4 Espacement dans les listes

Dans certains cas, vous désirez laisser plus ou moins d’espace entre les éléments
d’une liste. Par exemple, si 'espacement implicite est trop grand dans ce cas :

— Une liste a puces
— avec espacement standard

Vous pouvez diminuer cet espace en ajoutant un argument facultatif au premier
élément la liste. Ajouter dans celui-ci la commande nolistsep pour ne pas ajouter
d’espacement de liste comme dans cet exemple :

— Une liste a puces

— sans espacement vertical

— additionnel
Pour ajouter de I’espace, vous pouvez utiliser plusieurs autres commandes fournies par
le paquetage enumitem. Pour plus d’information, voir la documentation enumitem.

Des nombreuses autres commandes sont également disponibles pour modifier 1’es-
pacement horizontal et I'indentation. Voici un exemple ou I'on a imposé I'indentation
des paragraphes du document et positionné la séparation de I'étiquette a 2cm de sorte
que le numéro soit dans la marge :

Une énumération

avec indentation négative

4.10.1.5 D’autres personnalisations

Vous pouvez également modifier le style des listes descriptives. La commande

font=definition

modifie la police de I’étiquette de la description, la commande

style=definition

regle le style de la liste.

Un exemple d’utilisation de la commande

font=\itshape, style=nextline

Radiations ionisantes :

Une radiation ionisante est constituée de particules ou d’ondes électromagné-
tiques dotées d’assez d’énergie pour arracher des électrons aux atomes et aux
molécules, les ionisant de ce fait ;

Comptage de référence :
en informatique, le comptage de référence est une technique pour enregistrer
le nombre de références, pointeurs ou poignées vers une ressource comme un
objet, un bloc de mémoire, un espace disque ou autres.
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Il existe de nombreuses autres commandes et fonctionnalités fournies par le paquetage
enumitem. Pour plus d’information, voir la documentation enumitem.

4.10.2 Listes de paragraphe

Ce module utilise le paquetage paralist pour fournir neuf nouveaux environnements
de liste. Les listes a puces et les énumérations peuvent étre saisies a 'intérieur de pa-
ragraphes, en tant que paragraphes et en version compacte. La plupart des environne-
ments ont des arguments facultatifs pour mettre ne forme les étiquettes. De plus, les
environnements liste a puce et énumération IXTEX sont augmentées pour utiliser des
arguments optionnels similaires. Pour les détails, voir Fichier>Quvrir un exemple
Modules> Listes de paragraphe (paralist), Aider>Manuels spécifiquesi> Listes de para-
graphes et la documentation paralist.

4.11 Programmation littéraire

4.11.1 Noweb

Ce module permet 'utilisation de Noweb en tant qu’outil de programmation litté-
raire. Les fichiers et la documentation de Noweb sont accessible via CTAN. La pro-
grammation littéraire est décrite a la section 11.3 et il existe trois fichiers d’exemple :
Fichier>Ouvrir un exemple>Modules>NoWeb, Fichier>Ouvrir un exempler> Modulesr
Liste d’erreurs Noweb et Fichier > Ouvrir un exemple>Modules > Noweb2LyX.

4.11.2 Rnw (knitr)

Ce module utilise les paquetages knitr et includernw. Le paquetage knitr de
R pour la génération dynamiques de rapports doit étre insllé pour que ce module
fonctionne : install.packages("knitr").

Note

— il dépend de R >= 2.14.1. Pour plus d’information voir http://yihui.name/
knitr;
— le paquetage includernw doit éfgalement étre installé;

— il ne peut pas étre utilisé si les modules Notation du format musical LilyPond ou
Sweave ont été chargés.

Voir Aide > Manuels spécifiques > Knitr, Fichier > Ouvrir un exemple> Modules > Rnw (knitr)
et la section 11.3 pour de I'information au sujet de la programmation littéraire.

4.11.3 Sweave

Ce module utilise le langage statistique S/R en tant qu’outil de programmation
littéraire. Il requiert le paquetages includernw et fancyvrb. includernw et fancyvrb
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sont accessibles via CTAN. Il ne peut pas étre utilisé si le module Notation du for-
mat musical LilyPond a été chargé. Voir Aide>Manuels spécifiques>Sweave, Fichierr
Ouvrir un exempler> Modules > Sweave et la section 11.3 pour de I'information au sujet
de la programmation littéraire.

4.12 Maths

4.12.1 Théorémes AMS

Ces modules définissent les environnements de théoreéme et de preuve en utilisant le
mécanismes AMS. Les types numérotés et non numérotés sont fournis. Implicitement,
les théoremes sont numérotés consécutivement a travers tout le document. Ceci peut
étre modifié en chargeant I'un des modules Théorémes AMS (numérotés par ...). Ils
ne peuvent pas étre utilisés si les modules Théoremes standard ou Théoremes stan-
dard (non numérotés) ont été chargés.

4.12.2 Théorémes AMS (étendu)

Ce module définit quelques environnements de théoreme supplémentaires pour une
utilisation avec le module Théoremes AMS (qui doit étre chargé). Il inclut Critere,
Algorithme, Axiome, Condition, Note, Notation, Résumé, Conclusion, Fait, Hypotheése,
Cas et Question a la fois sous forme numérotée et non numérotée.

4.12.3 Théorémes AMS (étendu, numérotation par type et par
chapitre)

Ce module définit quelques environnements de théoréme supplémentaires pour une
utilisation avec le module Théoremes AMS (numérotation par type et par chapitre)
(qui doit étre chargé). Il inclut Critere, Algorithme, Axiome, Condition, Note, Notation,
Résumé, Conclusion, Hypothese, Cas et Question a la fois sous forme numérotée et non
numérotée.

A Tinverse du module Théoremes AMS (étendu), les différents types de théoréme
fournis ont chacun leur compteur, qui redémarre a chaque chapitre (e.g., Critére 1.1,
Critére 1.2, Aziome 1.1, Hypothése 1.1, Critére 2.1, Critere 2.2, Axiome 2.1, ...,
contrairement a Critére 1, Critére 2, Axiome 3, Hypothése 4, . ..).

4.12.4 Théoréemes AMS (étendu, numérotation par type)

Ce module définit quelques environnements de théoréme supplémentaires pour
une utilisation avec le module Théoremes AMS (numérotation par type) (qui doit
étre chargé). Il inclut Critére, Algorithme, Axiome, Condition, Note, Notation, Résumé,
Conclusion, Hypothése et Cas la fois sous forme numérotée et non numérotée.
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A Tinverse du module Théoremes AMS (étendu), les différents types de théoréme
fournis ont chacun leur compteur (e.g. Critére 1, Critére 2, Axiome 1, Hypothése 1,
Critére 3, ..., contrairement a Critére 1, Critére 2, Aziome 3, Hypothése 4, ...).

4.12.5 Théoremes AMS (numérotation par type et par chapitre)

Ce module définit les environnements de théoreme et de preuve en utilisant le
mécanismes AMS. Les types numérotés et non numérotés sont fournis.

A T'inverse du module Théoremes AMS, les différents types de théoréme fournis ont
chacun leur compteur (e.g., Théoréme 1.1, Théoréme 1.2, Lemme 1.1, Proposition 1.1,
Théoreme 1.3, Lemme 1.2, ..., contrairement a Théoreme 1, Théoréme 2, Lemme 3,
Proposition 4, ...). La numérotation redémarre a chaque chapitre : Théoréme 1.1,
Théoreme 2.1, ...

Il ne peut pas étre utilisé si les modules Théoremes AMS, Théoremes standard,
Théorémes standard (numérotés par type) or Théorémes standard (non numérotés) ont
été chargés.

4.12.6 Théoremes AMS (numérotation par type)

Ce module définit les environnements de théoreme et de preuve en utilisant le
mécanismes AMS. Les types numérotés et non numérotés sont fournis.

A Tinverse du module Théoremes AMS, les différents types de théoreme fournis
ont chacun leur compteur (e.g. Théoréme 1, Théoréme 2, Lemme 1, Proposition 1,
Théoreme 3, Lemme 2, ..., contrairement a Théoréeme 1, Théoréeme 2, Lemme 3, Pro-
position 4, . ..). La numérotation s’étend sur tout le document. Pour une numérotation
par chapitre ou par section, voyez les modules appropriés.

Il ne peut pas étre utilisé si les modules Théoremes AMS, Théoremes standard,
Théorémes standard (numérotés par type) or Théorémes standard (non numérotés) ont
été chargés.

4.12.7 Numéroter les équations par section

Ce module remet la numérotation des équations a zéro au début de chaque section
et pré-ajoute le numéro de section au numéro d’équation, comme dans (2.1).

4.12.8 Théorémes standard

Ce module définit quelques environnements de théoréme supplémentaires pour une
utilisation avec des classes non-AMS. Implicitement, les théoremes sont numérotés
consécutivement a travers tout le document. t. Ceci peut étre modifié en chargeant
I'un des modules Théorémes standard (numérotés par . ..).

Il ne peut pas étre utilisé si les modules Théoremes AMS ou Théorémes stan-
dard (non numérotés) ont été chargés.
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4.12.9 Théorémes standard (nommables)

Ce module facilite 'utilisation de théoremes nommés. Le nom du théoreme peut
étre saisi via Insertion> Texte de théoréme complémentaire.

4.12.10 Théorémes standard (numérotés par chapitre)

Ce module numérote les théorémes et assimilés par chapitre (i.e. le compteur est
remis a zéro au début de chaque chapitre). N'utiliser ce module qu’avec des classes
de document comportant I’environnement chapitre.

L’un des modules Théoremes AMS ou Théorémes standard doit étre chargé.

Il ne peut pas étre utilisé si le module Théorémes standard (numérotation par section)
a été chargé.

4.12.11 Théorémes standard (numérotation par section)

Ce module numérote les théoremes et assimilés par section (i.e. le compteur est
remis a zéro au début de chaque section).

L’un des modules Théoremes AMS ou Théorémes standard doit étre chargé.

I ne peut pas étre utilisé si le module Théoremes standard (numérotation par cha-
pitre) a été chargé.

4.12.12 Théorémes standard (numérotation par type et par
chapitre)

Ce module définit quelques environnements de théoréme supplémentaires pour une
utilisation avec des classes non-AMS. Contrairement aux modules Théoréemes AMS et
Théorémes standard, les différents types de théorémes ont un compteur séparé (e.g.
Théoreme 1, Théoreme 2, Lemme 1, Proposition 1, Théoreme 3, Lemme 2, ..., contrai-
rement & Théoréme 1, Théoréme 2, Lemme 3, Proposition 4, ...). La numérotation
redémarre a chaque début de chapitre.

L'un des modules Théoremes AMS (numérotation par type) or Théorémes stan-
dard (numérotation par type) doit étre chargé.

Il ne peut étre utilisé si I'un quelconque des modules Théoremes AMS, Théo-
remes standard, Théorémes standard (non numérotés), Théorémes standard (numéro-
tation par section) ou Théorémes standard (numérotation par type et par section) ont
été chargés.

4.12.13 Théorémes standard (numérotation par type et par
section)

Ce module définit quelques environnements de théoreme supplémentaires pour une
utilisation avec des classes non-AMS. Contrairement aux modules Théoréemes AMS et
Théorémes standard, les différents types de théorémes ont un compteur séparé (e.g.
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Théoreme 1, Théoréeme 2, Lemme 1, Proposition 1, Théoréme 3, Lemme 2, . . ., contrai-
rement & Théoréme 1, Théoréme 2, Lemme 3, Proposition 4, ...). La numérotation
redémarre a chaque début de section.

L'un des modules Théoréemes AMS (numérotation par type) or Théorémes stan-
dard (numérotation par type) doit étre chargé.

Il ne peut étre utilisé si 'un quelconque des modules Théoremes AMS, Théo-
remes standard, Théorémes standard (non numérotés), Théorémes standard (numéro-
tation par chapitre) ou Théorémes standard (numérotation par type et par chapitre) ont
été chargés.

4.12.14 Théorémes standard (numérotation par type)

Ce module définit quelques environnements de théoréme supplémentaires pour une
utilisation avec des classes non-AMS. Contrairement aux modules Théoremes AMS
et Théoremes standard, les différents types de théoremes ont un compteur séparé
(e.g. Théoréme 1, Théoréeme 2, Lemme 1, Proposition 1, Théoréme 3, Lemme 2, ...,
contrairement a Théoréme 1, Théoréme 2, Lemme 3, Proposition 4, ...). La numéro-
tation s’étend sur la totalité du document. Pour une numérotation par chapitre ou
par section, voyez les modules appropriés.

Il ne peut pas étre utilisé si les modules Théoremes AMS, Théoremes standard,
Théorémes standard (numérotés par type) or Théorémes standard (non numérotés) ont
été chargés.

4.12.15 Théorémes standard (non numérotés)

Ce module ne définit que les environnements de théoreme et de preuve non numé-
rotés en utilisant le mécanismes AMS. Il ne peut pas étre utilisé si 'un des modules
Théoremes AMS ou Théorémes standard a été chargé.

4.12.16 Sous-équations

Ce module fournit une méthode simple pour séparer les sous-équations en IyX.
Voir Aide>Mathsr>Numérotation des formules > Sous-équations.

4.13 Format de la page

4.13.1 Personnalisation en-tétes/pieds de page

Ce module requiert que 'option Style de page de la fenétre Document > Paramétres >
Format de la page soit positionnée sur sophistiqué. Il ajoute six environnements aux
classes de document qui reconnaissent la paquetage fancyhdr :

— En-téte gauche

— En-téte central
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— En-téte droit
— Pied gauche
— Pied central
— Pied droit

4.13.1.1 En-tétes et pieds de page sur mesure

Le format de page implicite est assez banal : pour un document avec la classe
article, tout ce que vous obtenez se limite au numéro de page en bas de la feuille. Ce
document-ci est de la classe « Book KOMA script » (livre), donc il est un peu plus
fourni.

Une fois le Style de page de in Document > Paramétres > Format de la page positionné
sur « sophistiqué », vous allez découvrir que l'en-téte est divisé en trois champs,
appelés logiquement « gauche », « centre » et « droit ». Le bas de page aussi a ces
trois divisions. Les commandes KTEX pour éditer ces champs de la maniere la plus
simple sont \lhead, \chead, \rhead, \1foot, etc. Si vous voulez mettre votre nom
dans le coin en haut a gauche de chaque page, insérez simplement cette commande
dans le préambule :

\lhead{Jean D. Rédacteur}

Vous verrez désormais votre nom dans le coin supérieur gauche. Si un champ a une
entrée par défaut que vous souhaitez supprimer (comme le numéro de page apparais-
sant en bas, centré), insérez simplement une commande avec un parametre vide, par
exemple :

\cfoot{}

Il y a cependant une maniere plus simple de faire ces modifications : si vous chargez
le module Document>Paramétres>Modules>Format dela pager> Personnalisation en-
tétes/pieds de page, vous aurez six nouveaux environnements comme indiqué dans la
section précédente.

Maintenant, plus difficile : mettons le mot « Section » et le numéro de la section
en cours (par exemple Section 3) dans le coin supérieur gauche, le numéro de page
en haut a droite, votre nom en bas a gauche et la date en bas a droite. Utilisez ces
nouveaux environnements (accessible via le menu déroulant des styles) pour ajouter
ces éléments :

En-téte gauche : Section \thesection
En-téte central :

En-téte droit : Page \thepage

Pied gauche : Jean D. Rédacteur

Pied central :

Pied droit : \today

Saisissez bien les commandes \thesection, \thepage et \today en code TEX. Les
commandes \thesection et \thepage permettent d’accéder aux compteurs IXTEX
de section et de page, et d’afficher ainsi les numéros de la section et de la page en
cours. \today affiche simplement la date d’aujourd’hui.
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L’épaisseur de la barre horizontale dessinée au dessous de ’en-téte et au dessus du
pied de page peut elle aussi étre modifiée. Si vous n’en voulez pas, mettez sa largeur a
0. Implicitement, la barre d’en-téte a une épaisseur de 0,4 pt, et celle de pied de page
une épaisseur de 0. Pour régler I’épaisseur, utilisez les commandes \renewcommand-
{\headrulewidth}{0.4pt} et \renewcommand{\footrulewidth}{0.4pt}.

Vous pouvez activer ou désactiver les parametres d’en-téte et de pied de page pour
une page donnée avec, par exemple : \thispagestyle{empty}, \thispagestyle-
{plain}, et \thispagestyle{fancy}. Insérez simplement ces commandes dans le
texte de la page que vous voulez modifier, et mettez-les en mode TEX. En fait, impli-
citement, les pages de titre sont en « ordinaire » (plain), alors que les autres sont
en « sophistiqué » (fancy).

Si vous désirez qu'un en-téte ou un pied de page soit du coté externe dans un
document recto/verso, vous devez utiliser ceci :

\fancyfoot{}
\fancyfoot [LE,R0O]{\thepage?}

La premiere commande vide tous les pieds de page existants pour éviter tout conflit
avec la nouvelle commande.

Vous pouvez saisir toutes ces commandes, soit en utilisant les nouveaux environne-
ments introduits pas le module, soit pour les plus compliquées en saisissant du code
TEX a n’importe quel endroit du document, elles prendront effet a la page suivant la
directive.

Enfin, il est possible d’insérer une image dans I’en-téte ou le pied de page. Si vous
voulez insérer un logo dans le coin supérieur gauche, vous pouvez essayer quelque
chose comme ceci dans le préambule :

\lhead{\resizebox{1in}{!}{\includegraphics{logo.eps}}}

(il vous faudra peut-étre pré-ajouter \usepackage{graphics} avant si aucun autre
fichier EPS n’est inséré dans votre document).

Pour plus de détails sur les en-tétes et pieds de page sophistiqués, vous pouvez
consulter la documentation de fancyhdr via CTAN.

4.13.2 Parties du document en format paysage

Ce module imprime des parties du document en format paysage en utilisant Inser-
tion > Inserts personnalisablest> Paysage ou Insertion > Inserts personnalisables > Paysage (flot-
tant).

4.13.3 Multi-colonnes

Cette fonctionnalité est indépendante de 'option Document sur deux colonnes du
menu Document>Paramétres dans la rubrique Format du texte. Si vous désirez une
présentation sur deux colonnes dans tout le document, vous devez utiliser 'option
Document sur deux colonnes. Pour tous les autres cas, utilisez la fonctionnalité décrite
ici.
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Pour activer les colonnes multiples dans votre document, vous devez charger le
module Multi-colonnes (menu Document > Paramétrest>Modules) et vous devez avoir

installé le paquetage ETEX multicol.

Dans chaque colonne, vous pouvez insérer ce que vous voulez, avec une limitation :
pour les flottants, vous devez utiliser I'option Plusieurs colonnes. Les notes de bas de
page provenant de colonnes multiples seront placées sur toute la largeur de la page

et non pas sous chaque colonne.

4.13.3.1 Les bases

Si vous souhaitez présenter un texte sur deux colonnes, insérez un insert multi-
colonnes via Insertion > Inserts personnalisables > Multi-colonnes 1a ot les colonnes doivent
débuter. Saisissez tout le texte qui doit étre affiché sur deux colonnes dans cet insert.

Voici un exemple :

The Adventure of the Empty House
by Sir Arthur Conan Doyle

It was in the spring of the year 1894 that
all London was interested, and the fashion-
able world dismayed, by the murder of the
Honourable Ronald Adair under most un-
usual and inexplicable circumstances. The
public has already learned those particulars
of the crime which came out in the police in-
vestigation, but a good deal was suppressed
upon that occasion, since the case for the
prosecution was so overwhelmingly strong
that it was not necessary to bring forward
all the facts. Only now, at the end of nearly
ten years, am I allowed to supply those miss-
ing links which make up the whole of that
remarkable chain. The crime was of inter-
est in itself, but that interest was as noth-

ing to me compared to the inconceivable se-
quel, which afforded me the greatest shock
and surprise of any event in my adventur-
ous life. Even now, after this long inter-
val, I find myself thrilling as I think of it,
and feeling once more that sudden flood of
joy, amazement, and incredulity which ut-
terly submerged my mind. Let me say to
that public, which has shown some interest
in those glimpses which I have occasionally
given them of the thoughts and actions of a
very remarkable man, that they are not to
blame me if I have not shared my knowledge
with them, for I should have considered it
my first duty to do so, had I not been barred
by a positive prohibition from his own lips,
which was only withdrawn upon the third of
last month.

Pour avoir 3 colonnes ou plus, positionnez le curseur dans I'insert multi-colonnes et
utilisez le menu Insertion > Nombre de colonnes. Le nombre de colonnes est saisi dans

cet insert (pour 3 colonnes, saisir « 3 »).
Voici un exemple avec 3 colonnes :

It can be imagined that

problems which came before the

There was none, however, which

my close intimacy with Sher-
lock Holmes had interested me
deeply in crime, and that after
his disappearance I never failed

to read with care the various

public. And I even attempted,
more than once, for my own
private satisfaction, to employ
his methods in their solution,

though with indifferent success.
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evidence at the inquest, which
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or persons unknown, I realized
more clearly than I had ever
done the loss which the commu-
nity had sustained by the death
of Sherlock Holmes. There were
points about this strange busi-
ness which would, I was sure,

have specially appealed to him,

and the efforts of the police
would have been supplemented,
or more probably anticipated,
by the trained observation and
the alert mind of the first crimi-
nal agent in Europe. All day, as
I drove upon my round, I turned

over the case in my mind and

found no explanation which ap-
peared to me to be adequate.
At the risk of telling a twice-
told tale, T will recapitulate the
facts as they were known to the
public at the conclusion of the

inquest.

Vous pouvez avoir jusqu’a 10 colonnes si vous le désirez, mais ¢a risque de ne pas

étre agréable a la lecture. ..
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4.13.3.2 Des colonnes dans des colonnes

Vous pouvez également créer des colonnes dans des colonnes :

The Honourable Ronald Adair was the second
son of the Earl of Maynooth, at that time gov-
ernor of one of the Australian colonies. Adair’s
mother had returned from Australia to undergo
the operation for cataract, and she, her son
Ronald, and her daughter Hilda were living to-
gether at 427 Park Lane.

The youth moved
in the best society —
had,

known, no enemies and

so far as was

no particular vices. He
had been engaged to
Miss Edith Woodley,
of Carstairs, but the
engagement had been
broken off by mutual
consent some months
before, and there was
no sign that it had left
any very profound feel-
ing behind it. For the

rest {sic} the man’s life
moved in a narrow and
conventional circle, for
his habits were quiet
and his nature unemo-
tional. Yet it was upon
this easy-going young
aristocrat that death
came, in most strange
and unexpected form,
between the hours of
ten and eleven-twenty
on the night of March
30, 1894.

4.13.3.3 Exemples plus compliqués

Ronald Adair was fond of cards — playing con-
tinually, but never for such stakes as would hurt
him. He was a member of the Baldwin, the
Cavendish, and the Bagatelle card clubs. It was
shown that, after dinner on the day of his death,
he had played a rubber of whist at the latter club.
He had also played there in the afternoon. The
evidence of those who had played with him — Mr.
Murray, Sir John Hardy, and Colonel Moran —
showed that the game was whist, and that there
was a fairly equal fall of the cards. Adair might
have lost five pounds, but not more. His fortune
was a considerable one, and such a loss could
not in any way affect him. He had played nearly
every day at one club or other, but he was a cau-
tious player, and usually rose a winner. It came
out in evidence that, in partnership with Colonel
Moran, he had actually won as much as four hun-
dred and twenty pounds in a sitting, some weeks
before, from Godfrey Milner and Lord Balmoral.
So much for his recent history as it came out at
the inquest.

Les exemples proposés dans cette section illustrent quelques fonctionnalités plus
particulieres de I'insertion de colonnes multiples.
Pour découvrir d’autres fonctionnalités, référez-vous a le documentation du paque-

tage multicol.

Préface Pour ajouter un texte en préface pour plusieurs colonnes, positionnez le
curseur dans l'insert multi-colonnes et appelez le menu Insertion > Préface. Saisissez
votre texte de préface dans cet insert.
Voici un exemple avec un texte en préface :

And the story continues and continues and continues and continues. . .

On the evening of the crime, he returned a relation.

The servant deposed that she

from the club exactly at ten. His mother and heard him enter the front room on the sec-
sister were out spending the evening with ond floor, generally used as his sitting-room.
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She had lit a fire there, and as it smoked
she had opened the window. No sound was
heard from the room until eleven-twenty, the
hour of the return of Lady Maynooth and
her daughter. Desiring to say good-night,
she attempted to enter her son’s room. The
door was locked on the inside, and no an-

swer could be got to their cries and knock-
ing. Help was obtained, and the door forced.
The unfortunate young man was found lying
near the table. His head had been horribly
mutilated by an expanding revolver bullet,
but no weapon of any sort was to be found
in the room.

Vous pouvez également utiliser une en-téte de section en tant que préface si vous
insérez une commande de section en code TEX : par exemple, la commande

\subsection{subsection title}

crée une sous-section. Et dans I'exemple suivant, la préface est une sous-sous-

section :

4.13.3.4 This is a subsubsection heading as a preface

A minute examination of the circum-
stances served only to make the case more
complex. In the first place, no reason could
be given why the young man should have fas-
tened the door upon the inside. There was
the possibility that the murderer had done
this, and had afterwards escaped by the win-
dow. The drop was at least twenty feet, how-
ever, and a bed of crocuses in full bloom lay
beneath. Neither the flowers nor the earth
showed any sign of having been disturbed,
nor were there any marks upon the narrow

strip of grass which separated the house from
the road. Apparently, therefore, it was the
young man himself who had fastened the
door. But how did he come by his death?
No one could have climbed up to the window
without leaving traces. Suppose a man had
fired through the window, he would indeed
be a remarkable shot who could with a re-
volver inflict so deadly a wound. Again, Park
Lane is a frequented thoroughfare; there is
a cab stand within a hundred yards of the
house. No one had heard a shot.

S’il reste un espacement vertical inférieur a 6 lignes de texte avant le début de

la zone multi-colonnes, un saut de page sera inséré automatiquement. Vous voudrez
peut-étre changer ce réglage en fonction de du nombre de lignes du texte en préface :
ceci peut se faire en positionnant le curseur dans l'insert multi-colonnes apres la pré-
face (si elle existe) et en appelant le menu Insertion > Espacement avant saut de page.
Saisissez alors I'espacement désiré, e.g. « Hem »”.

Dans I’exemple qui suit, 'espacement est réglé a 7 lignes de texte en saisissant « 7\ba-
selineskip » (ou la commande \baselineskip doit atre insérée en code TEX) :

On the evening of the crime, he returned
from the club exactly at ten. His mother and
sister were out spending the evening with
a relation. The servant deposed that she
heard him enter the front room on the sec-

ond floor, generally used as his sitting-room.

She had lit a fire there, and as it smoked
she had opened the window. No sound was
heard from the room until eleven-twenty, the
hour of the return of Lady Maynooth and
her daughter. Desiring to say good-night,
she attempted to enter her son’s room. The
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door was locked on the inside, and no an-
swer could be got to their cries and knock-
ing. Help was obtained, and the door forced.
The unfortunate young man was found lying

Espacements environnants

near the table. His head had been horribly
mutilated by an expanding revolver bullet,
but no weapon of any sort was to be found
in the room.

L’espacement avant et apres un bloc de colonnes mul-

tiples peut étre réglé via la longueur \multicolsep. Par exemple la commande en code

X
\setlength{\multicolsep}{3cm}

regle la valeur a 3cm. La modification doit étre faite avant le début de 'insert multi-

colonnes. La valeur prédéfinie est 13pt.
Ici \multicolsep est réglé a 2.5cm :

All day I turned these facts over in my
mind, endeavouring to hit upon some the-
ory which could reconcile them all, and to
find that line of least resistance which my
poor friend had declared to be the starting-
point of every investigation. I confess that I
made little progress. In the evening I strolled
across the Park, and found myself about six
o’clock at the Oxford Street end of Park
Lane. A group of loafers upon the pave-
ments, all staring up at a particular window,
directed me to the house which I had come to

Nota :

see. A tall, thin man with coloured glasses,
whom I strongly suspected of being a plain-
clothes detective, was pointing out some the-
ory of his own, while the others crowded
round to listen to what he said. I got as near
him as I could, but his observations seemed
to me to be absurd, so I withdrew again in
some disgust. As I did so I struck against an
elderly, deformed man, who had been behind
me, and I knocked down several books which
he was carrying.

les valeurs réglées via \setlength seront utilisées pour tous les environne-

ments multi-colonnes suivants jusqu’a la prochaine modification de la valeur.
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Sauts de colonne Un saut de colonne peut étre forcé en insérant la commande
\columnbreak{} en code TEX 1a ou la colonne doit étre interrompue. Notez bien que
des zones vides seront créées la plupart du temps lorsque cette commande est utilisée.

Voici un exemple :

“You’re surprised to see me, sir,” said he,
in a strange, croaking voice.

I acknowledged that I was.

“Well, I've a conscience, sir, and when I
chanced to see you go into this house, as I
came hobbling after you, I thought to myself,
TI’ll just step in and see that kind gentleman,
and tell him that if I was a bit gruff in my
manner there was not any harm meant, and
that I am much obliged to him for picking
up my books.”

“You make too much of a trifle,” said
I. “May I ask how you knew who I was?”
APRES CETTE PHRASE UN SAUT DE
COLONNE EST IMPOSE.

“Well, sir, if it isn’t too great a liberty,
I am a neighbour of yours, for you’ll find
my little bookshop at the corner of Church
Street, and very happy to see you, I am
sure. Maybe you collect yourself, sir. Here’s
BriTisH BIRDS, and CATULLUS, and THE
HorLy WAR — a bargain, every one of them.
With five volumes you could just fill that gap
on that second shelf. It looks untidy, does it
not, sir?”

Séparation entre colonnes La largeur des colonnes est calculée automatiquement,
mais vous pouvez modifier I'espacement entre colonnes. Ceci est possible grace a
la longueur \columnsep. Sa valeur implicite est 10pt. Voici un exemple dans lequel

I’espacement est fixé a 3cm :

My observations of No. 427 Park
Lane did little to clear up the prob-
lem in which I was interested. The
house was separated from the street
by a low wall and railing, the whole
not more than five feet high. It was
perfectly easy, therefore, for anyone
to get into the garden, but the win-
dow was entirely inaccessible, since
there was no water pipe or anything
which could help the most active
man to climb it. More puzzled than

ever, I retraced my steps to Kens-
ington. I had not been in my study
five minutes when the maid entered
to say that a person desired to see
me. To my astonishment it was none
other than my strange old book col-
lector, his sharp, wizened face peer-
ing out from a frame of white hair,
and his precious volumes, a dozen of
them at least, wedged under his right
arm.

Filets verticaux Entre les colonnes est placé un filet de largeur \columnseprule. Si
cette largeur est fixée a Opt (c’est la valeur implicite), le filet n’apparait pas. Dans
I’exemple suivant, le filet a une largeur de 2pt :
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“You're surprised to see me, sir,” said he,
in a strange, croaking voice.

I acknowledged that I was.

“Well, I've a conscience, sir, and when I
chanced to see you go into this house, as I
came hobbling after you, I thought to myself,
I’ll just step in and see that kind gentleman,
and tell him that if I was a bit gruff in my
manner there was not any harm meant, and
that T am much obliged to him for picking
up my books.”

“You make too much of a trifle,” said L.
“May I ask how you knew who I was?”

“Well, sir, if it isn’t too great a liberty,
I am a neighbour of yours, for you’ll find
my little bookshop at the corner of Church
Street, and very happy to see you, I am
sure. Maybe you collect yourself, sir. Here’s
BriTIisH BIRDS, and CATULLUS, and THE
HoLy WAR — a bargain, every one of them.
With five volumes you could just fill that gap
on that second shelf. It looks untidy, does it
not, sir?”

Le filet peut étre mis en couleur en redéfinissant la commande \columnseprulecolor.

Ceci est fait en insérant la commande

\renewcommand{\ columnseprulecolor} {\color{red } }

en code TEX, avant 'insert multi-colonnes. Remplacez dans cette commande red par la
couleur de votre choix. Vous pouvez utiliser les couleurs prédéfinies ou celles que vous
avez définies vous-méme, voyez le Manuel des objets insérés, section Tableauz colorés
pour les détails sur la définition des couleurs. Pour revenir a la couleur implicite,

insérez la commande

\renewcommand{\ columnseprulecolor } {\ normalcolor}

Dans I'exemple qui suit, sont définis un filet magenta et une séparation de colonnes

de lem :

“You're surprised to see me, sir,” said
he, in a strange, croaking voice.

I acknowledged that I was.

“Well, I've a conscience, sir, and when
I chanced to see you go into this house,
as I came hobbling after you, I thought to
myself, I’ll just step in and see that kind
gentleman, and tell him that if I was a bit
gruff in my manner there was not any harm
meant, and that I am much obliged to him
for picking up my books.”

“You make too much of a trifle,” said 1.

“May I ask how you knew who I was?”

“Well, sir, if it isn’t too great a lib-
erty, I am a neighbour of yours, for you’ll
find my little bookshop at the corner of
Church Street, and very happy to see you,
I am sure. Maybe you collect yourself,
sir. Here’s BRITISH BIRDS, and CATUL-
LUs, and THE HoLy WAR — a bargain, ev-
ery one of them. With five volumes you
could just fill that gap on that second shelf.
It looks untidy, does it not, sir?”
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4.14 Styles de paragraphe

4.14.1 Paragraphes de forme inhabituelle

ETEX, a l'instar des autres générateurs de texte, utilise implicitement des paragraphes
rectangulaires. Pour des cas particuliers comme des affiches, des cartes d’invitation ou
des poemes, vous pouvez modifier la forme des paragraphes a volonté. Ceci est possible
grace au paquetage IXTEX shapepar qui est chargé en utilisant dans les parametres du
document le module Formes de paragraphe paramétrables.

4.14.1.1 Formes prédéfinies

shapepar fournit les formes suivantes :

Nom Description Annotation

. . PR Pas de mise a ’échelle
Disque avec un trou circulaire (&

CDlabel la taille d'uin CD/DVD) possible. Attentl.on‘, 9uant1te
de texte limitée
Circle Disque Fraglle,/ le calcul peut
échouer
Diamond Rhombmde? (symbolisant un i
« diamant »)
Heart Forme en cceur -
Hexagon Hexagone -
Nut Ecrou (hex.agone‘ avec un trou i
circulaire)
Square Carré -
Star Etoile & 5 branches -
Candle Chandelle allumée -
Drop Goutte de pluie normale/inversée Fraglle,/ le calcul peut
down/up échouer
TEX Le logo TEX -
Triangle Triangles avec des orientations
up/down/ différentes i
left /right

Pour utiliser une forme pour votre paragraphe, sélectionnez simplement la forme
souhaitée dans le menu déroulant des styles.
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Voici un exemple de paragraphe en forme d’écrou :

Lorem ipsum dolor sit
amet, consetetur sadipscing
elitr, sed diam nonumy eirmod
tempor invidunt ut labore et dolore

magna aliquyam erat, sed diam
voluptua. At vero eos et ac-
cusam et ju- sto duo do-
lores et ea re- bum. Stet cli-
ta kasd guber- gren, no sea ta-
kimata sanc- tus est Lorem
ipsum  dolor sit amet. Lo-
rem ipsum dolor sit amet, conse-

tetur sadipscing elitr, sed diam nonu-
my eirmod tempor invidunt ut la-
bore et dolore magna aliquyam
erat, sed diam voluptua.

Nota: les paragraphes mis en forme via shapepar ne peuvent pas franchir une limite

de page.

shapepar prend soin de préserver la forme, quelle que soit la quantité de texte du
paragraphe. De ce fait la taille du paragraphe change avec cette quantité. Ceci peut
conduite a des paragraphes qui empietent dans les marges. Pour illustrer cette mise
a ’échelle, voici le méme paragraphe avec deux fois plus de texte :
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Lorem ipsum dolor sit amet, consete-
tur sadipscing elitr, sed diam nonumy eir-
mod tempor invidunt ut labore et dolore ma-
gna aliquyam erat, sed diam voluptua. At vero
eos et accusam et justo duo dolores et ea rebum.
Stet clita kasd gubergren, no sea takimata sanctus est

Lorem ipsum dolor sit amet. Lorem ipsum
dolor sit amet, con- setetur  sadipscing
elitr, sed diam no- numy eirmod tem-
por invidunt ut la- bore et dolore ma-
gna aliquyam erat, sed diam voluptua.
Lorem ipsum dolor sit amet, consete-
tur sadipscing eli- tr, sed diam nonu-
my eirmod tempor invidunt ut labo-
re et dolore magna aliquyam erat, sed
diam voluptua. At vero eos et accusam

et justo duo dolores et ea rebum. Stet clita kasd guber-
gren, no sea takimata sanctus est Lorem ipsum dolor
sit amet. Lorem ipsum dolor sit amet, consete-
tur sadipscing elitr, sed diam nonumy eirmod
tempor invidunt ut labore et dolore ma-
gna aliquyam erat, sed diam voluptua.

La forme CDlabel est une exception : elle ne peut pas étre mise a 1’échelle puisqu’elle

doit correspondre a une étiquette de CD/DVD. De ce fait, la quantité de texte que
I’on peut mettre en forme est limitée.
Les formes drop et circle sont fragiles, ce qui veut dire que le calcul de la taille
peut échouer, en fonction de la quantité de texte. Vous aurez alors une erreur IXTEX
« Arithmetic overflow ». Dans ce cas, essayez d’ajouter ou d’enlever du texte; si rien
ne fonctionne, vous devez utiliser une autre forme. ..

Pour les formes pointues, vous verrez peut-étre un échec de I'algorithme de césure
de IXTEX dans les coins. Il est alors souvent nécessaire d’ajouter des points de césure
explicites () dans les parties de texte correspondantes.

Les paragraphes mis en forme par shapepar sont toujours ou bien centrés ou bien
alignées au fer a gauche. Le menu de dialogue des paragraphes ne peut donc pas
étre utilisé pour aligner ce type de paragraphe. Une solution consiste a mettre le
paragraphe en forme dans une minipage ou une parbox et a aligner la boite. Le
probleme est alors de trouver la bonne largeur pour la boite, parce que si elle est
trop large et que vous la centrez, le paragraphe n’est pas centré parce qu’il est au
fer a gauche dans la boite. Vous devrez alors jouer un peu avec la largeur de la boite
jusqu’a satisfaction. Voici deux paragraphes en forme de coeur, le premier est non
aligné, le second est aligné a droite :
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Lorem ipsum
dolor sit amet, consetetur sa-
dipscing elitr, sed diam nonumy eir-
mod tempor invidunt ut labore et do-
lore magna aliquyam erat, sed diam
voluptua. At vero eos et accusam
et justo duo dolores et ea rebum.
Stet clita kasd gubergren, no
sea takimata sanctus est
Lorem ipsum dolor
sit  amet.

Q

Lorem ipsum
dolor sit amet, consetetur sa-
dipscing elitr, sed diam nonumy eir-
mod tempor invidunt ut labore et do-
lore magna aliquyam erat, sed diam
voluptua. At vero eos et accusam
et justo duo dolores et ea rebum.
Stet clita kasd gubergren, no
sea takimata sanctus est
Lorem ipsum dolor
sit  amet.

Q©

4.14.1.2 Formes personnalisées

Vous pouvez définir vos propres formes. Le faire a la main demande beaucoup de
travail parce qu’il faut spécifier chaque coordonnée, mais il est possible de confier le
travail a 'ordinateur :

1 Installer le programme Jpgfdraw.

2 Dans Jpgfdraw , aller au menu TeX/LaTeX> Settingst>Set Normal Size et sélec-
tionner la taille de police utilisée dans le document. Par exemple, le présent
document utilise un police 12pt.

3 Tracer une forme.

4 Utiliser le menu TeX/LaTeX>Shapepar pour exporter la forme en coordonnées.
Dans le menu de dialogue qui s’ouvre, utiliser soit le squelette, soit le chemin
proprement dit *.

Les coordonnées ont copiées dans un fichier TEX. Pour I'utiliser avec le document :

1. Pour plus d’information voir http://www.dickimaw-books.com/apps/jpgfdraw /manual /shapepar.html
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1 Placer le curseur avant le premier caractére du paragraphe concerné (ou dans

un nouveau paragraphe vide).

2 Ouvrir dans Iy X le menu Insertion > Fichier > Sous-document, sélectionner le fi-
chier exporté par Jpgfdraw et utiliser Inclus (include).

Nota : le changement de forme ne s’applique qu’au paragraphe concerné; tout
redevient normal pour le paragraphe suivant. De ce fait la définition de forme doit
étre répétée pour chaque paragraphe dont on veut imposer la forme personnalisée.

Voici un exemple :

Lorem ipsum dolor sit
scing elitr, sed diam no-
por invidunt ut labo-
gna aliquyam erat,
tua. At vero eos et

sto duo dolores et

clita kasd guber-
kimata sanctus est

dolor sit amet. Lo-

lor sit amet, con-
scing elitr, sed diam
tempor invidunt ut
magna aliquyam erat,

amet, consetetur sadip-
numy eirmod tem-
re et dolore ma-
sed diam volup-
accusam et ju-

ea rebum. Stet
gren, no sea ta-
Lorem ipsum

rem ipsum do-
setetur  sadip-
nonumy eirmod
labore et dolore
sed diam voluptua.

Une astuce : pour tracer des formes vraiment complexes avec Jpgfdraw , vous
pouvez tracer la forme a l'aide d’un logiciel de votre choix et importer 'image cor-
respondante dans Jpgfdraw. Il vous suffit ensuite de tracer une ligne ou un spline le

long du squelette de I'image.

Le module Formes de paragraphe paramétrables fournit également les deux styles
shapepar et Shapepar , qui peuvent étre utilisés pour définir de nouvelles formes co-
ordonnée par coordonnée?. Pour en savoir plus quant & l'utilisation de ces styles
et a d’autres possibilités de personnalisation, voir la documentation du paquetage

shapepar.

4.14.2 Paragraphes en renfoncement

CE module ajoute un style pour les pragraphes en renfoncement, c’est-a-dire quand
toutes les lignes sauf la premiere sont identées. Ceci peut ne pas apparaitre dans

2. Ces commandes sont utilisées de maniere interne pour toutes le formes décrites ici,
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la fenétre [y X de votre document mais apparaitra dans la version imprimée.

4.14.3 Initiales (lettrines)

CE module ajoute un style de paragraphe Lettrine que vous pouvez utiliser la ou
vous en avez besoin. Vous avez alors trois nouvelles entrées dans le menu Inser-
tion :

— Lettrine qui crée un insert pour la capitale initiale ;
— Résidu de lettrine qui crée un insert pour le reste du mot ;
— Options qui vous permet de configurer la mise en page de la capitale initiale.

Pour personnaliser cette derniere, voir Aide > Objets insérést> Objets entourés par du texte >
Lettrines.

4.15 Balisage du texte

4.15.1 Balisage du texte césurable (soul)

Ce module définit des styles de texte pour mettre en évidence, espacer, barrer,
souligner et mettre en petites capitales du texte en utilisant le paquetage soul.

Contrairement au balisage fourni par le bouton Propriétés du texte, les mots balisés
avec soul sont propices a la césure. Voir la documentation soul.

4.15.2 Balisage logique

Ce module définit quelques styles de caracteres pour le balisage logique : Nom
PROPRE, en évidence, fort, et code qui sont accessible via le menu Edition > Style de texte per-
sonnalisé.
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5 Personnaliser une bibliographie
avec BibTgX ou Biblatex

L’essentiel des bases de l'utilisation de BibTEX ou Biblatex sont décrites dans le
paragraphe Les bases de données bibliographiques du Guide de l’utilisateur. Les pa-
ragraphes qui suivent détaillent les fonctionnalités bibliographiques particulieres qui
sont accessibles depuis LyX.

5.1 Autres styles de citation

Le style standard de BibTgEX utilise des nombres (par exemple « [12] ») pour
faire référence a un ouvrage cité. Cependant, dans de nombreuses disciplines scienti-
fiques, on utilise d’autres styles de citations. Le plus courant et le style auteur-année
(par exemple « Knuth 1984a »). IyX gere trois paquetages qui fournissent ce style,
biblatex, natbib et jurabib. Chacun de ces paquetages a ses avantages et ses in-
convénients qui ne peuvent étre listés ici en détail. Si vous voulez seulement avoir un
simple style auteur-année (ou auteur-nombre) ou si vous voulez utiliser un des innom-
brables fichiers de styles pour natbib, alors vous choisirez probablement le paquetage
natbib qui est réputé. Si vous cherchez des styles de citation adaptés aux documents
juridiques, vous pouvez envisager d’utiliser le paquetage plus récent jurabib. Si vous
voulez contréler complétement la mise en forme ou si vous cherches des fonctionnalités
sophistiquées comme ibidem, citations en notes de bas de page, citations plein titre,
formats de dates évolués (comme 400 AC) ou une internationalisation complete dans
d’autres langues que ’anglais, vous devriez vraiment utiliser biblatex, qui surpasse
tous les autres paquetages en termes de fonctionnalités, mais qui est également assez
lourd et consommateur de ressources.

L’utilisation de ces paquetages avec Ly X est sensiblement la méme. Allez dans le
menu Document > Paramétres et choisissez dans la rubrique Bibliographie le Format du
style Basique (BibTeX), Biblatex, Biblatex (mode Natbib), Natbib (BibTeX) ou Jurabib
(BibTeX) (voir la section 6.5.3 du Guide de l’utilisateur pour les détails au sujet de
ces choix). Avec ces tous ces paquetages, vous aurez des options supplémentaires dans
le dialogue Citation et vous pourrez choisir le style de la référence (« Knuth 1984 »,
« Knuth (1984), « Knuth, 1984 », « 1984 » etc.). Notez que chaque paquetage nécessite
des fichiers de style spécifiques (ils sont tous fournis avec leur propres fichiers, mais on
peut trouver beaucoup de fichiers de style supplémentaires et méme un programme
interactif pour construire des fichiers de style! pour natbib).

1. Voyez ftp://ctan.tug.org/tex-archive/macros/latex/contrib/custom-bib/
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5.2 Bibliographies subdivisées

Parfois vous avez besoin de diviser votre bibliographie en plusieurs sections. Si par
exemple, vous étes un historien, la possibilité de séparer les sources et les travaux
scientifiques est vraisemblablement une possibilité « indispensable ». Malheureuse-
ment, BibTEX ne vous permet pas lui-méme de faire cela. La bonne nouvelle : avec
I’'aide de quelques paquetages EIEX, on peut étendre BibTEX pour satisfaire vos
besoins historiques.

LyX fournit un support natif d'un de ces paquetages, bibtopic?. L’avantage de
ce paquetage (comparé a d’autres comme multibib) est que n’avez pas besoin de
définir de nouvelles commandes de citation. A la place, vous aurez & préparer des
bases de données bibliographiques différentes pour les différentes sections de votre
bibliographie. Par exemple, si vous voulez diviser votre bibliographie en deux sec-
tions « sources » et « travaux scientifiques », vous devez d’abord créer deux bases de
données, par exemple sources.bib et scientifique.bib.

Dans IyX, allez dans le menu Document > Parametres dans la rubrique Bibliographie.
Activez 'option Bibliographie subdivisée. Vous pouvez maintenant insérer plusieurs
bibliographies BibTEX, une par section de votre bibliographie. Pour revenir a notre
exemple : insérez une bibliographie BibTEX pour la base de donnée sources.bib et
une deuxieme pour la base de données scientifique.bib. Vous étes libres d’utiliser
le méme style ou un style différent pour chaque section. En plus, vous pouvez choisir
que votre section bibliographique contienne « toutes les références citées » de la base
de données utilisée (ce qui est le comportement implicite), « toutes les références non
citées » ou encore « toutes les références ». Ceci put étre utile si vous voulez séparer
votre bibliographie en trois sections : « Sources citées », « Sources non citées » et
« Travaux scientifiques ». Les titres des sections peuvent étre ajoutés comme des
entétes de section ou de sous-section ordinaires. Puisque bibtopic supprime le titre
de la bibliographie, vous devez aussi le remettre manuellement ( comme un chapitre*
ou une section®, par exemple).

Avec Biblatex, la procédure est un peu différente. Puisque bibtopic ne fonctionne
pas avec Biblatex, I'option Bibliographie subdivisée est désactivée si vous utilisez Bi-
blatex. Cependant, Biblatex inclut ses moyens propres pour créer des bibliographies
subdivisées. Vous pouvez : soit ajouter des mots-clés aux entrées bibliographiques
a l'aide de 'entrée keywords, puis filtrer les sections bibliographiques par mot-clé
(en ajoutant keyword=monMotClé au champ Options de la fenétre de dialogue qui
apparait si vous faites un clic gauche sur le bouton Bibliographie Biblatex) ; soit filtrer
par type d’entrée (comme book ou article) en saisissant par exemple type=book ou
nottype=collection au champ Options mentionné ci-dessus; soit créer des « catégo-
ries bibliographiques » auxquelles vous pouvez affecter des entrées bibliographiques
individuelles. Voyez le manuel Biblatex, sous-section Subdivided Bibliographies de la
section Usage Notes, pour les détails.

2. Disponible sur ftp://ctan.tug.org/tex-archive/macros/latex/contrib/bibtopic/
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5.3 Bibliographies multiples

Les bibliographies multiples, par exemple une bibliographie pour chaque partie,
chapitre, section, sous-section or sous-document du document, sont également pos-
sibles avec Iy X. Pour les activer, allez a Document > Paramétres > Bibliographie et sé-
lectionnez le sectionnement requis (e.g. « par section ») dans le sous-menu Bibliogra-
phies multiples. Puis ajoutez une bibliographie Bib(la)TEX a chaque élément (e.g.,
section) de votre document. Dans le résultat imprimable, une bibliographie séparée
ne contenant que les références du sectionnement considéré sera créée.

Si vous utilisez BibTEX, Le paquetage chapterbib ou le paquetage bibtopic est
utilisé pour créer des bibliographies multiples. Le premier est utilisé si vous sélection-
nez « par sous-document » et si vous ne sélectionnez pas Bibliographie subdivisée. Dans
tous les autres cas, c’est bibtopic qui est utilisé® .Avec bibtopic, IyX encapsule les
entités spécifiées entre les commandes \begin{btUnit} et \end{btUnit} pour créer
les bibliographies. Notez que cette approche a quelques limitations. D’abord, chaque
référence de citation doit se trouver dans une btUnit. Les citations en-dehors d'une
entité défini (par exemple, avant la premiére section si vous utilisez « par section »)
apparaitront comme « 7 7?7 ». Vous pouvez cependant créer vos propres entités en sai-
sissant \begin{btUnit} et \end{btUnit} en code TEX (par exemple pour contour-
ner la présente limitation). Notez bien que les btUnits ne peuvent inclure d’autres
btUnits. Une seconde limitation vient du fait que bibtopic parcourt toujours toutes
les références d’une base bibliographique, méme celles qui ne sont pas citées. Ceci
peut créer des citations bizarres (e.g. « Martin 2014b » si deux ceuvres de cet auteur
publiées en 2014 sont dans la base, alors qu'une seule est citée).

Si vous utilisez Biblatex, I'option refsection est utilisée a la place du choix dé-
roulant. Si vous avez besoin d’entités spécifiques, vous pouvez insérer au début
\newrefsection ou \newrefsegment respectivement, en codeTEX. Si vous voulez
aussi préciser la fin de l'entité, utilisez I'environnement \begin{refsection} ...
\end{refsection} a la place. Notez cependant que les refsections ne peuvent
contenir d’autres refsections. En plus de la bibliographie individuelle de I'entité
considérée, Biblatex permet aussi d’émettre toutes le bibliographies, les unes apres les
autres, a un endroit particulier (e.g., a la fin du document). Sélectionnez « toutes les
entités de références » dans le menu déroulant Contenu de la fenétre de dialogue de
I'insert de bibliographie pour obtenir ceci.

3. Une autre approche, si vous étes prét a utiliser un peu de CopE TEX (voir section 2.3),
consiste a utiliser le paquetage bibunits.
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6 Choix de puces dans ListePuces

par ALLAN RAE

6.1 Introduction

LyX fournit 216 motifs de puces qui sont accessibles par une simple fenétre. Vous
pouvez facilement y sélectionner la puce souhaitée pour chaque niveau de profondeur
dans I'environnement ListePuces. Ces choix sont valables pour tout le document, donc
vous ne pouvez pas spécifier différents types de puces pour différents paragraphes!.

6.2 A quoi elles ressemblent

Allez dans la rubrique Puces de la fenétre Document > Parametres.

La fenétre vous présente un tableau avec des formes de puces. A gauche du tableau,
une colonne de boutons vous donne accés aux six panneaux possibles. La rangée de
boutons du haut sert a choisir le niveau de profondeur sur lequel vous agissez.

Si vous sélectionnez Puce personnalisée, une zone de texte sera activée au-dessous
du tableau dans laquelle vous pourrez saisir I’équivalent I¥TEX d’une forme de puce.
Si vous modifiez le texte vous devrez également spécifier dans le préambule IXTEX les
paquetages nécessaires.

Les six panneaux sont répartis selon les paquetages qu’ils nécessitent. Le tableau
suivant vous montre la correspondance entre le nom des boutons et les paquetages

BTEX.

’ Bouton \ Paquetages Requis ‘

Standard ETEX de base
Maths amssymb. sty
Dingl pifont.sty
Ding2 pifont.sty
Ding3 pifont.sty
Ding4 pifont.sty

LyX ne vous empéche pas d’utiliser les puces correspondant a des paquetages que
vous n’avez pas. Si vous obtenez des erreurs KTEX lorsque vous essayez de visionner
ou d’imprimer le fichier, c’est stirement qu’il vous manque un paquetage. [y X ne vous

1. En fait, c’est possible mais il faut le faire a la main.
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empéche pas d’agir car vous pourriez vouloir éditer quelque part et imprimer avec un
autre systeme.

6.3 Comment s’en servir

Sélectionnez le niveau de profondeur sur lequel vous voulez agir, puis le motif de
puce et la taille. Les changements ne seront pas visibles dans LyX, mais seulement
lors du visionnement..

Vous pouvez remettre une puce a sa valeur par défaut, en cliquant avec le bouton
droit de la souris sur la profondeur de la puce en question.

Si vous voulez réellement avoir des paragraphes avec des puces différentes dans
chacun d’eux, vous devez mettre les mains dans le cambouis. La fenétre dont nous
venons de parler est cependant utile car elle montre en méme temps ’aspect de la
puce et son code IXTEX, ceci pour un grand nombre de puces. Pour personnaliser vos
paragraphes, vous avez le choix :

# utiliser la commande KTEX \renewcommand{}{} pour spécifier un nouveau for-
mat de puce pour une profondeur donnée. Vous aurez aussi besoin d’enregistrer
le format actuel pour le restaurer plus tard. Dans cette liste a puces, le code
ETEX suivant a été utilisé pour changer les puces de profondeur 1 :
\let\savelabelitemi=\labelitemi
\renewcommand\labelitemi [0]{\small\ (\sharp\)}

Remarquez que la profondeur de puce est donnée en chiffres romains comme
partie intégrante de la commande \labelitem.

* agir sur chaque entrée individuellement en écrivant le motif de la puce dans un
insert « Elément paramétrable » (accessible via Insertion > Elément paramétrable)
et en code TEX. Par exemple, cet élément a commencé par \ (\star\).

Vous aurez besoin de remettre le labelitem a sa valeur d’origine pour que les
autres puces retrouvent les réglages globaux. Nous avons donc ici :
\renewcommand\labelitemi[0]{\savelabelitemi}.
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7 Outils supplémentaires

7.1 Documents en plusieurs fichiers

7.1.1 Généralités

Quand on travaille sur un gros fichier avec de nombreux chapitres, il est souvent
pratique de diviser le document en plusieurs fichiers; par ailleurs, il arrive qu’un
élément comme un tableau soit susceptible de modifications ultérieures, alors que le
reste du texte ne changera plus. Dans ces cas-la, il est judicieux d’utiliser les pos-
sibilités de segmentation de documents. Ainsi, les communications scientifiques ont
souvent cing chapitres principaux : introduction, observations, résultats, discussion,
conclusion. Chacun d’entre eux peut constituer un fichier IyX séparé, avec un fichier
« maitre » qui contient le titre, les auteurs, le résumé, les références, etc. Il convient de
noter que chacun des fichiers est un fichier IyX en lui-méme, qui peut aussi bien étre
mis en page et imprimé seul, qu’étre inclus dans le document maitre. Tous ces fichiers
doivent cependant avoir la méme classe de document — n’essayez pas de mélanger la
classe book avec la classe article. Il est également possible d’inclure des fichiers IXTEX :
cependant, ces fichiers doivent alors étre sans leur préambule (c’est-a-dire sans la par-
tie jusqu’a la ligne \begin{document} incluse, et sans la ligne \end{document}) pour
éviter des erreurs a la création du fichier DVI.

LyX permet l'inclusion de fichiers en sélectionnant Insertion > Fichier > Sous-document,
ce qui positionne une balise a I’endroit du curseur. Un clic sur cette balise ouvre une
fenétre qui permet de saisir le nom du fichier et la méthode d’inclusion.

Les trois méthodes d’inclusion sont « Inclus (include) », « Incorporé (input) », et
« Verbatim ». Les méthodes « inclus (include) » et « incorporé (input) » se ressemblent
sur de nombreux points, mais different notablement sur d’autres :

1 les fichiers « Inclus » commenceront sur une nouvelle page, alors que ceux « in-
corporés » commenceront sur la page en cours.

2 les fichiers « Inclus (include) » ne peuvent pas eux-mémes « inclure » d’autre
fichiers (sous-sous-documents). Avec « Incorporé (input) », en revanche, la sous
incorporation est illimitée.

3 «Inclus (include) » permet I’émettre la sortie imprimable d’un sous-ensemble de
fichiers « inclus » tout en conservant la valeur correcte des compteurs (pagina-
tion et autres) et des références (voyez la section Sous-documents du manuel
des Objets insérés pour les détails).

De ce fait, « Inclus (include) » est la méthode appropriée pour des chapitres rédigés a
part comme des sous-documents, alors que « Incorporé (input) » convient mieux pour
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un héritage de fichiers arbitraires.

Un fichier inclus en « verbatim » vous permet d’insérer un texte mis en forme
exactement comme il apparait dans le fichier d’origine. Normalement, les espaces
dans ce fichier sont invisibles, cependant, deux espaces consécutives sont conservées, a
contrario des regles habituelles de [y X. Cependant, cocher I'option Marquer les espaces
résout toute incertitude en matérialisant chaque espace par un symbole.

D’une maniere générale, le fichier maitre est converti en un seul fichier BTEX avant
la typographie, alors que les fichiers inclus sont convertis en fichiers IXTEX dépourvus
de préambule.

7.1.2 Références croisées entre fichiers

Ce paragraphe est quelque peu obsolete. Il faudrait décrire les documents maitres
implicites et comment les sous-documents s’ouvrent en méme temps que le docu-

ment maitre. [[AFAIRE]] Il

est possible de faire des références croisées entre différents fichiers. D’abord, il faut
ouvrir tous les fichiers concernés : appelons-les A et B pour un exemple avec deux
fichiers, avec B inclus dans A. Supposons que nous ayons inséré une étiquette dans
A, a laquelle nous voulons faire référence dans B. Il faut ouvrir la fenétre de référence
croisée a partir de B, et il est alors possible de choisir le « tampon » a utiliser.

7.1.3 Listes bibliographiques dans tous les sous-documents

Lorsque vous travaillez avec un sous-document, vous pouvez préférer avoir une
seule bibliographie principale a la fin, tout en conservant la possibilité d’avoir une
bibliographie sélectionnée pour le sous-document si vous affichez la sortie de ce sous-
document seul. Voici comment procéder.

Dans le document maitre, vous insérez simplement un insert bibliographique la ou
la bibliographie principale doit apparaitre, que ce soit dans le document maitre ou
dans un sous-document. Si la bibliographie est dans le document maitre, les références
seront héritées par tous les sous-documents : elles sont donc disponibles dans la fenétre
de dialogue des citations dans chacun d’entre eux.

Pour le bibliographies particulieres aux sous-documents, saisir des inserts bibliogra-
phiques la ou la bibliographie doit apparaitre quand le sous-document est compilé a
part. Cependant, 1’astuce consiste a la saisir dans une branche (Insertion>Branche >
Insérer une nouvelle branche), appelée par exemple « SousDocSeul ». Dans le sous-
document, activer la branche (Document > Paramétres> Branches). Dans le document
maitre, désactiver la branche (Documentr>Parameétres> Branches). La bibliographie
du sous-document sera alors ignorée dans le document maitre, mais présente dans le
sous-document.

S’il vous faut des bibliographies multiples (une par sous-document dans le document
maitre, par exemple), voyez la section 5.3.

92



CHAPITRE 7. OUTILS SUPPLEMENTAIRES 7.2. ARCHIVES LyX

7.2 Archives LyX

Les utilisateurs ont parfois besoin de « relier » un fichier IyX avec toutes les images
(et d’autres fichiers dont il dépend, soit pour I’envoyer a un éditeur, soit pour le par-
tager avec un co-auteur. LyX inclut un script Python (lyxpak.py) qui automatise le
processus. Pour l'utiliser, il faut que I'un des modules Python zipfile ou tarfile
soit installé sur votre systeme. Implicitement, le script préfere ’archive tar compres-
sée par gzip sur les systemes Unix et le format zip sur Windows.

La procédure de configuration de IyyX positionne le script pour qu’il exporte une
« Archive LyX », et ce format sera disponible via Fichier>Exporter.

Indépendamment du systeme d’exploitation, la création d’un format d’archive par-
ticulier peut étre imposée en ajoutant soit I'option -t (pour le format tar ) soit
l'option -z (pour le format zip) au convertisseur IyX >Archive IyX dans Outils>
Préférences>Gestion des fichiers>Convertisseurs (veillez bien & ajouter 'op-
tion apres le nom du script, pas avant).
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8 LyX et le Web

LyX inclut depuis longtemps l'exportation de documents vers divers formats ap-
propriés au monde du Web, comme HTML. Avant la version 2.0, le format HTML
était obtenu par l'utilisation de convertisseurs externes !. Ceux-ci se divisent en deux
groupes principaux : certains convertisseurs utilisent KTEX comme format intermé-
diaire, comme htlatex, html2latex, et plastex, en créant le code IXTEX a partir de
LyX; et il existe un convertisseur qui travaille directement sur le code LyX, elyXer.
Chacun d’eux présente des avantages et des inconvénients.

Les convertisseurs fondés sur IXTEX présentent 1’avantage qu’il connaissent (en prin-
cipe) les mémes informations que BKTEX concernant le document exporté. Il ne sont
pas concernés par le fait qu'un morceau de code soit créé par LyX ou par un insert de
code TEX. Ils comprennent les fichiers aux, les compteurs et les références, et peuvent
souvent tirer parti des fichiers bbl engendrés par BibTEX. En contrepartie, KTEX est
un langage vraiment difficile a analyser — on dit souvent que seul TEX comprend
TEX — et les convertisseurs fondés sur IXTEX échouent souvent sur des construc-
tions apparemment simples; des constructions compliqués peuvent les faire avorter
totalement, et actuellement par exemple, le manuel des Objets insérés ne s’exporte
pas via htlatex, bien que les autres le fassent. L’autre préoccupation provient de la
maniere dont les formules mathématiques sont traitées : ces convertisseurs traduisent
habituellement les formules en petites images qui sont liées dans le document HTML.
Puisque celles-ci sont créées par IXTEX, la typographie est précise. mais elles ne se
mettent pas a 1’échelle facilement, et la tache de les faires s’insérer harmonieusement
dans le document comme si elles en faisaient partie nativement — avec des polices
de taille similaire — peut étre a elle seule un défi.

Le logiciel elyXer (http://pinchito.es/elyxer/) créé par Alex Fernandez résout cer-
taines de ces problemes. En particulier, les formules produites se mettent parfai-
tement a 1’échelle, car il traduit les mathématiques en utilisant une combinaison de
HTML et CSS plutét que de convertir les formules en images. mais méme les formules
modérément compliquées sont moins bien rendues qu’avec htlatex : ceci révele les
limitations de HTML 2. Plus important (du moins pour la version 1.1.1), elyXer ne
comprend pas bien les macros mathématiques et pas du tout les styles de paragraphes
définis par I'utilisateur et les styles de caracteres. Ces limitations rendent elyXer peu
approprié pour de nombreux documents créés par les utilisateurs de LyX. En prin-
cipe, ces problemes peuvent bien siir étre résolus, mais les développeurs de Lyx ont

1. Pour les détails sur 'utilisation des convertisseurs externes depuis LyX, voir la section Conver-
tisseurs de manuel de Personnalisation.

2. Ceci dit, elyXer peut également utiliser JSSMATH et MATHJAX pour les équations, mais ce
réglage ne peut étre que global et nécessite 'accés a un serveur qui exécute le code de conversion.
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choisi une autre voie et ont rendu IyX lui-méme capable d’écrire en XHTML, de la
méme fagon qu’il peut écrire en KTEX, en DocBoook ou en texte brut.

A T'heure actuelle, 'exportation XHTML est encore en développement et doit pro-
bablement étre considérée comme « expérimentale ».? Cependant, les développeurs
ont chois cette approche car elle posséde plusieurs avantages potentiels sur les deux
autres.

Les avantages sont dus principalement au fait que les fonctions d’exportation en
XHTML, comme elles font partie de Lyx, connaissent du document considéré les
mémes choses que LyX.? Elles connaissent donc la table des matieres (telle qu’affi-
chée dans le plan), les compteurs associés aux différents styles de paragraphes stan-
dard et aux styles de paragraphe définis par I'utilisateur. Les fonctions d’exportation
XHTML connaissent les mémes choses que LyX du point de vue de I'internationali-
sation également, et elles traduiront « Chapter 1 » ou « Kapitel 1 » en fonction de la
langue définie localement.

D’un maniere générale, les fonctions d’exportation connaissent le format du do-
cument, c’est-a-dire la maniere d’afficher le document a 1’écran : cette information
est exploitée pour I'exportation en XHTML. En particulier, yX engendre automa-
tiquement les informations CSS correspondant aux informations de format utilisées
pour l'affichage a I'écran : si les en-tétes de section sont supposées étres sans em-
pattement et gras dans IiyX, ils seront implicitement sans empattement et gras dans
un navigateur Web. Et ceci est vrai non seulement pour les styles prédéfinis, comme
Section, mais pour tout style, y compris défini par 1'utilisateur,. De fait, les procé-
dures d’exportation en XHTML ne font pas de distinction entre les paragraphes et
les styles de texte définis par l'utilisateur et ceux prédéfinis par LyX, puisque dans
tous les cas, tout ce que connait IiyX se trouve dans les fichiers de format. Ceci s’ap-
plique également aux inserts textuels comme les notes de bas de page et divers inserts
personnalisés.

De ce fait, le résultat XHTML peut étre adapté et étendu exactement de la méme
facon que le résultat IATEX : au moyen des fichiers de format et des modules; voir le
chapitre 5 du manuel de Personnalisation pour les détails.

Le reste de ce chapitre décrit plus en détail 'exportation XHTML, ses limitations
et les moyens de contourner celles-ci.

8.1 Formules mathématiques en XHTML

[yX propose quatre méthodes d’affichages des formules mathématiques, qui ont
divers avantages et inconvénients :

3. Le fichier development/HTML/HTML.notes, qui se trouve dans l'arborescence des sources LyX
ou qui peut étre consultée en ligne (en anglais), contient normalement des informations & jour sur
I’état de développement de I’exportation XHTML. Voir également la liste des bogues sur le suivi de
bogues.

4. Un autre avantage réside dans le fait que, puisque ces fonctions sont internes a Lyx, elle sont
insensibles aux changements de format des fichiers LyX, ou aux modifications de la sémantique des
inserts existants.
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— MathML

MathML est in dialecte de XML développé spécifiquement pour afficher les
formules mathématiques sur le web, et il offre un excellent rendu dans les na-
vigateurs qui le reconnaissent. L’inconvénient est que tous les navigateurs ne
reconnaissent pas MathML, et que le support est incomplet méme dans les na-
vigateurs fondés sur Gecko comme Firefox.

Si Iy X ne sait pas afficher un formule en MathML — par exemple, la formule
utilise le paquetage xymatrix ou du code TEX — il affichera la formule sous la
forme d’une image.

— HTML

Comme on l'a vu plus haut, elyxer exporte les formules mathématiques en
HTML, mis en forme par CSS®. Pour des formules simples, ceci fonctionne
correctement, mais a tendance a échouer pour des formules plus compliquées.
Cette méthode a cependant I'avantage d’étre largement reconnue et peut donc
étre utilisée pour des documents contenant peu de formules, et qui soient suffi-
samment simples.

Si Lyx ne sait pas afficher un formule en HTML — par exemple, la formule
utilise le paquetage xymatrix ou du code TEX — il affichera la formule sous la
forme d’une image.

— Images
Comme htlatex,yX exportera les formules comme des images, les mémes
images en fait que celles utilisées par la fonction d’apercu sur le vif®.
Comme indiqué plus haut, I'avantage de cette méthode réside dans la
grande précision des images puisqu’elles sont engendrées par EITEX. En
contrepartie, ces images ne sont pas vectorielles, et par conséquent elles
ne se mettent pas bien a 1’échelle, elles ne peuvent pas étre copiées, etc.
La taille des images peut étre réglée via le parametre Mise da [’échelle
des images mathématiques dans le menu Document > parameétres > Sortie>
HTML".
Si LyX ne peut créer un image d'une formule pour une raison ou une autre
(e.g., si un paquetage IXTEX requis n’est pas installé), alors il émettra le
code latex brut de la formule.

— BIEX
Enfin, [yX peut heureusement émettre les formules en KTEX. Bien que 1'on ait
recours a cette méthode qu’en dernier ressort, elle peut étre utilisée avec des
outils externes comme jsMath, qui utilise JavaScript pour afficher le code IXTpX
inclus dans les documents HTML. LyX encapsule le code ETEX soit dans un
insert de type span (pour les formules en ligne) soit dans un insert de type div

5. LyX a emprunté a elyxer quelques unes des feuilles de style CSS utilisées dans son exportation
HTML.

6. L’apercu sur le vif n’a pas besoin d’étre actif pour que les images soient créées, cependant.

7. Pour ceux que cela intéresse, la résolution est définie en points par pouce et vaut implicitement
75 dpi.
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(pour les formules hors ligne) marqué par class=’math’, comme requis par
jsMath.

Une des ces méthodes d’affichage doit étre sélectionnée dans la fenétre Document >
Parametres > Sortie. Implicitement, Iy X émet en MathML. Ceci est un réglage global
pour le document.

LyX offre également le choix d’'une méthode différente pour un insert particulier,
s’il est par exemple mal affiché via MathML. 8

8.2 Bibliographie et citations

L’exportation XHTML traduit parfaitement les bibliographies et les citations.

Les étiquettes de citation sont créées par le méme mécanisme qui produit le éti-
quettes apparaissant dans ’écran Iy X : les citations se présenteront donc aussi bien
que dans IyX si ce n’est mieux. Si vous utilisez des citations numériques, [y X émettra
des étiquettes numériques, comme [1] ou [17], plutdt que d’afficher simplement la clé
de la citation comme a I’écran. Si vous utilisez des citations auteur-année, IyX ajou-
tera des lettres en bas de casse a 'année, comme le fait BibTEX, s’il trouve plus d'une
citation du méme auteur dans le méme année. Les étiquettes seront imprimées avec
les entrées bibliographiques. Notez cependant qu’il n’est pas actuellement possible de
modifier 'apparence des étiquettes, en choisissant par exemple entre parentheses et
crochets.

L’affichage de la bibliographie est régie par le méme mécanisme que celui qui gere
le présentation des références dans la fenétre de dialogue des citations, vous verrez
donc dans le résultat XHTML a peu pres les mémes choses que ce que vous voyez
en consultant un entrée dans cette fenétre. La présentation peut étre personnalisée
dans le fichier de format, ou de préférence dans un module, voyez le manuel de
Personnalisation pour les détails.

Le plus gros défaut actuel réside dans I'affichage des informations croisées dans
chaque entrée a laquelle elles sont associées, vous pouvez donc voir ceci :

Jason Stanley, “Context and Logical Form”, in Language in Context: Se-
lected Essays (Oxford: Oxford University Press, 2007), pp. 30-68.

Jason Stanley, “Semantics in Context”, in Language in Context: Selected
FEssays (Oxford: Oxford University Press, 2007), pp. 201-30.

Ceci devrait étre corrigé rapidement.

Il n’y a actuellement aucun support pour les les bibliographies par sections. Si vous
avez des bibliographies multiples, Iy X exportera la méme bibliographie partout.

8. Ceci dit, puisque LyX se rabat sur les images quand la formule contient du code TEX, il est
possible de forcer 'affichage par une image en insérant un code TEX innocent, par exemple a = b.
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8.3

Index

LyX exporte heureusement les index ne XHTML, avec quelques limitations pour
le moment.

L’exportation des index sera fiable si vous n’essayez pas d’utiliser les constructions
sophistiquées décrites dans le paragraphe consacré aux index dans le Guide de ['uti-
lisateur.® Nous décrivons ici comment elles sont gérées en utilisant les en-tétes de
sous-section de cette section.

8.4

Rassembler les entrées d’index (c’est-a-dire, sous-entrées) : Iy X essaye de les
traduire, mais les entrées doivent étre séparées par « ! », il doit y avoir des
espaces autour du point d’exclamation. Ceci est dii au fait qu’il est difficile au-
trement de les différencier des points d’exclamation affectés d’un échappement,
de ceux des expressions mathématiques, etc.

Ensembles de pages consécutives : il n’y a aucune traduction possible pour ces
ensembles, puisqu’ils n’ont aucun sens en XHTML. A la place, vous obtiendrez
deux entrées d’index, une a chaque extrémité.

Références croisées : les références croisées ne sont pas traduites. Si LyX trouve
une entrées contenant « |see. .. », il I'ignore cette indication, et le reste est traité
comme une entrée ordinaire.

Ordre des entrées d’'index : LyX essaie de gérer l'ordre de tri. Il prend ce qui
est avant le premier « @ » qu’il trouve et I'utilise pour trier, en considérant ce
qui est apres le premier « @ » comme l'entrée effective. Pour le moment, IxX
ne vérifie pas si « @ » fait 'objet d’un échappement, n’essayez donc pas de trier
des adresses électroniques.

Format des entrées d’index : vous pouvez mettre les entrées en forme en utilisant
la fenétre de choix des styles de caracteres, ou par une autre méthode proposée
par LyX. Les constructions telles que « entrée|textbf » ne sont pas traduites.
En fait, si IyX trouve un caractére tube (« | ») dans une entrée, il I'ignore ainsi
que tout ce qui le suit.

Index multiples : les index multiples ne sont pas traduits, toutes les entrées
d’index seront considérées comme un seul grand index. Pour éviter d’exporter
plusieurs versions du méme index, [yX n’exporte que 'index principal, assurez-
vous d’en créer un.

Nomenclatures et glossaires

Il n’y a actuellement pas d’exportation des glossaires. Il serait trivial de les ajouter,
et ce serait bienvenu.

9. Le principal probleme ici vient du fait que LiyX ne gere pas vraiment ces entrées d’index, il se
contente de vous laisser saisir le code ETEX.
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9 Exportation DocBook

En plus de XHTML, IyX peut créer des documents avec le vocabulaire XML
de Docbook. Avec les versions 2.3 et antérieures, IyX ne disposait que de modeles
sélectifs pour engendrer des documents DocBook (version 4 seulement). A partir de
la version 2.4 de IyX, la plupart des formats peuvent créer des documents DocBook
valides (version 5 uniquement). Cette fonctionnalité est intégrée a Ly X et ne requiert
pas 'usage d’outils externes.

De ce fait, les exportations DocBook peuvent étre personnalisées et enrichies exac-
tement de la méme fagon que le résultat de la compilation KTEX peut étre personnalisé
et enrichi : via les fichiers de format et les modules. Voir le chapitre « Installer de
nouvelles classes » du Manuel de Personnalisation pour les détails.

La plupart des fonctionnalités de LyX sont accessibles poue DocBook :

— les affichages mathématiques sont obtenus essentiellement en MathML (avec
comme exception principale les constructions qui ne sont pas reconnues par
LyX, comme les ERT). Toutes les formules sont également disponibles en TEX
natif dans le résultat DocBook pour un traitement ultérieur ;

— les bibliographies et les citations sont interprétées, y compris avec un fichier Bib-
TeX externe. Les entrées bibliographiques ne sont pas pré-affichées quand une
information détaillée est disponible,; mais plutot exportées avec les construc-
tions standard DocBook. Le processeur externe DocBook est supposé gérer le
rendu des entrées ;

— les index sont interprétés, y compris les index multiples. Les regroupements
(avec «!»), les portées de pages et les références croisés (avec |see) sont re-
connus, en exceptant 1’évitement des symboles identiques. L’ordre d’affichage
(@) et les types de caractéres (|mathbf) ne sont pas reconnus. Il n'y a pas de
support pour I’échappement des entrées d’index ;

— les glossaires sont interprétés.
Deux parametres essentiels peuvent étre réglés au niveau du document :

— le format des tableaux : IxyX peut déclarer les tableaux soit en HTML (réglage
implicite), soit au format CALS, en fonction des desiderata de l'utilisateur. La
plupart des processeurs DocBook acceptent les deux formats.

— le préfixe MathML : avec DocBook, MathML est inclus au sein des son propre
espace-nom, au contraire de HI'ML. En conséquence, il doit uy avoir une in-
dication des balises appartenant au standard MathML. Trois possibilités sont
offertes :
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— en ligne : I'espace-nom MathML est défini pour chaque formule (en utili-
sant l'attribut xmlns pour chacune);

— avec le préfixe m (implicite) : 'espace-nom MathML est défini au niveau du
document (en utilisant l'attribut xmlns:m & la racine). Chaque MathML
recgoit le préfixe m :, par exemple m:math;

— avec le préfixe mml : comme 'option m, mais avec mml.

Cette option est particulierement utile si vous voulez que LyX se conforme a
votre style personnel ou si vous avez a travailler avec un logiciel véreux qui
n’accepte qu’'un seul préfixe pour MathML.
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10 Le Serveur LyX

10.1 Introduction

Le « serveur IyX » est une méthode implantée dans IiyX qui permet a d’autres
programmes de dialoguer avec LyX, d’invoquer des commandes Iy X et d’obtenir de
I'information a propos de son état interne. Tout ceci n’est destiné qu’aux utilisateurs
avancés, qui devraient le trouver utile. C’est grace au serveur Iy X, par exemple, que
des gestionnaires de bibliographies comme JabRef peuvent permettre de « pousser »
des citations dans LyX.

10.2 Démarrer le Serveur LyX

Le serveur IyX fonctionne par l'intermédiaire d’une paire de tubes. IlIs sont ha-
bituellement disposés dans votre répertoire utilisateur MonRép (sauf sur Windows,
ou des tubes nominatifs locauz sont des objets spéciaux localisés dans \\.\pipe) et
portent les noms « .lyxpipe.in » et « .lyxpipe.out ». Les programmes externes
écrivent dans .lyxpipe.in et lisent les données dans .lyxpipe.out. La racine de ces
deux noms peut étre définie dans la fenétre Edition > Préférences > Entrées > Répertoires,
par exemple « /home/mon_home/.lyxpipe », ou « \\.\pipe\lyxpipe » avec Win-
dows (ou n’importe quel chemin admissible peut étre utilisé a la place de lyxpipe, par
exemple "\\.\pipe\my\lyx\pipe" fonctionnerait également). Vous devez configurer
ceci manuellement pour que le serveur puisse démarrer.

LyX ajoutera les suffixes « .in » et « .out » pour créer les tubes. Si l'un des ces
tubes existe déja, [y X supposera qu'un autre processus [y X est déja en route et ne
démarrera pas le serveur. Sur les systémes POSIX (similaires a Unix), si pour d’autres
raisons un tube inutilisé et « dormant » existe a la fermeture de LyX, LyX essaiera
de le supprimer. Si ceci échoue pour une raison ou une autre, vous devrez supprimer
les tubes a la main et redémarrer LyX. Sur Windows, les tubes sont supprimés par le
systéme a la fermeture du programme ou apres un crash, ainsi les tubes « dormants »
ne peuvent exister.

Pour faire tourner plusieurs processus [yX avec des serveurs en méme temps, vous
devez utiliser différentes configurations, peut-étre en utilisant des répertoires utilisa-
teurs différents, avec leurs propres préférences, pour chaque processus.

Si vous développez un programme client, il vous sera peut-étre utile d’activer les in-
formations de déboguage du serveur Iy X. Pour cela, démarrez Iy X avec la commande
lyx -dbg 8192.
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Vous pouvez trouver un exemple complet de client écrit en C++ dans la distribution
source sous le nom development/server_monitor.cpp.

Un autre outil utile est un client en ligne de commande que vous trouverez dans
src/client/lyxclient.

10.3 Communication normale

Pour émettre un appel LyX, le client écrit une ligne de texte ASCII dans le tube
d’entrée, selon le format suivant :

LYXCMD:nom_client : fonction :paramétre

nom_client est un nom que le client peut choisir arbitrairement. IyyX rappelle ce
nom s’il envoie une réponse — un client peut donc répartir les réponses aux
différentes requétes.

fonction est la fonction que vous voulez faire exécuter a LyX. C’est la commande
que vous auriez entrée dans le minibuffer.

paramétre est un parametre optionnel qui n’est utile que pour certaines fonctions
(par exemple, le LFUN « self-insert » qui inseére le parametre comme du texte
a la position du curseur).

La réponse de IxyX arrive dans le tube de sortie sous la forme :
INFO:nom_client : fonction :données

ou nom_client et fonction sont les mémes que dans la requéte, tandis que données
contient des informations plus ou moins utiles selon la fagon avec laquelle la com-
mande s’est exécutée. Certaines commandes renvoient des informations a propos de
I’état interne de Iy X, comme « font-state », tandis que d’autres ne renvoient rien. Ca
signifie alors que 'exécution s’est bien passée.

En cas d’erreurs, la réponse de LyX aura la forme :

ERROR:nom_client : fonction :message_d’erreur

ol le message_d’erreur doit expliquer pourquoi la commande a échoué.
Exemples :

echo "LYXCMD:test:beginning-of-buffer:" >~/.lyxpipe.in
echo "LYXCMD:test:get-xy:" >~/.lyxpipe.in

read a <~/.lyxpipe.out

echo $a

10.3.1 AppleScript (Mac OS X)

Depuis IyX 2.1, LyX inclut les interactions de base avec AppleScript pour les
communications normales via I'exécution d’'une commande. Cette commande prend
un argument direct (la fonction a exécuter) et un argument facultatif. Elle retourne
soit le résultat de la fonction, soit un message d’erreur et le code correspondant.

Exemple :
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tell application "IyX"
try
—-- Stores the current file name into f
set f to (run "server-get-filename" with argument "")
on error the error_message number the error_number
display dialog "Error: " & the error_number & ". " -
& the error_message buttons {"OK"} default button 1
end try
end tell

10.4 Notification

LyX peut notifier aux clients les événements qui se produisent de maniere asyn-
chrone. Pour l'instant il ne le fait que si I'utilisateur associe une séquence de touches
a la fonction « notify ». Voici le format de ce que IyX envoie :

NOTIFY:séquence_touches

ol séquence_touches est la représentation imprimée de la séquence de touches
réellement tapée par 1'utilisateur.

Ce mécanisme peut servir pour étendre l’ensemble des commandes [yX et implé-
menter des macros : associez certaines séquences de touches a « notify », démarrez
un client qui écoute le tube de sortie, traite la commande selon la séquence et dé-
marre une fonction qui peut utiliser des appels et des requétes LyX pour envoyer une
commande ou une série de commandes a LyX.

10.5 Le protocole serveur LyX
LyX implémente un protocole simple qui peut servir a la gestion de session. Tous
les messages sont de la forme :
LYXSRV:nom_client :message_protocole

ol message_protocole peut étre « hello » ou « bye ». Si un client regoit « hello »,
c’est que Iy X l'informe qu’il écoute ses messages, s’il recoit « bye », c’est que LyX
est en train de s’arréter.

10.6 Recherche inversée DVI/PDF

Quelques visionneuses DVI/PDF ! assurent la fonction de recherche inversée. Ceci
signifie que vous pouvez demander a IyX de positionner le curseur sur une ligne
particuliere en cliquant sur la méme ligne dans le résultat imprimable DVI/PDF. Pour

1. Les visionneuses suivantes proposent la fonction de recherche inversée en PDF : Okular sur
KDE/Linux, Qpdfview sur Unix, Skim sur Mac OSX et SumatraPDF sur Windows.
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que ceci soit possible, il faut que la visionneuse puisse communiquer avec IyX. C’est
la cas par le serveur LyX soit par un tube nommé (lyzpipe), soit par un connecteur
de domaine (lyzsocket) créé par LyX dans son répertoire temporaire (c’est comme
ceci que le programme lyxclient communique avec LyX). Dans certains cas, vous
aurez besoin d’un script auxiliaire qui interface la visionneuse et IxX, dans d’autres
cas, la visionneuse peut communiquer directement avec IyX : ceci dépend de la
visionneuse sélectionnée et de votre systeme d’exploitation. La méme considération
s’applique pour la configuration des visionneuses et pour le méthode d’implantation
de la recherche inversée. Dans ce qui suit, nous allons donc décrire comment configurer
la recherche inversée pour des visionneuses particulieres. mais auparavant, nous allons
expliquer d’'une maniere générale ce qu’il faut faire pour activer la recherche inversée
depuis le résultat imprimable DVI/PDF.

10.6.1 Activation automatique

Le plus souvent, [yX démarrera le serveur pour vous en appuyant sur le bouton de
la barre des outils. Une alternative consiste a activer la fonctionnalité en cochant Syn-
chroniser avec la sortie imprimable dans Document > Parametres> Sortie> LaTeX. Dans
ce cas, IyX insérera automatiquement la macro SyncTEX (pour PDF) ou chargera le
paquetage srcltx (pour DVI). Cette option peut étre facilement atteinte depuis la
barre d’outils Visionner/Mettre & jour.

S’il vous faut un réglage différent, vous pouvez sélectionner ou saisir une macro
personnalisée dans la liste déroulante située juste a c6té de Document > Parametres >
Sortie> Synchroniser avec la sortie imprimable. Notez que la méthode \synctex=1
active la compression gzip. Si votre visionneuse ne la supporte pas, vous devez utiliser
a la place\synctex=-1.

Notez également que la l'inclusion des paquetages srcltx ou src-specials a
quelquefois un impact imprévu sur la typographie. Vous devrez donc supprimer la
synchronisation avec la sortie imprimable pour la compilation finale du document si
vous utilisez srcltx ou src-specials.

Si vous avez besoin de réglages particuliers qui ne sont pas couverts par la réglage
automatique, lisez les paragraphes suivants consacrés a la synchronisation manuelle.
Si la configuration automatique vous convient, allez directement au paragraphe 10.6.3,
ou sont décrites les étapes de la configuration dans votre visionneuse, — que la mise
en oeuvre soit automatique ou manuelle.

10.6.2 Activation manuelle

ETEX fournit plusieurs méthodes pour la recherche inversée. Certaines sont in-
hérentes au programme latex/pdflatex, d’autres sont fournies par des paquetages
externes. Votre choix dépendra du fait que votre distribution BKTEX fournisse déja
une méthode donnée (les méthodes inhérentes sont assez récentes) et du fait que votre
visionneuse puisse le gérer. Les méthodes disponibles dont décrites dans la suite.
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Recherche inversée DVI inhérente via src-specials (DVI uniquement)

Cette méthode équipe le fichier DVI de I'information nécessaire pour la recherche
inversée. Elle est disponible en IXTEX depuis quelque temps (n’importe quelle distri-
bution suffisamment récente devrait I'inclure) et elle est fiable. Pour Iactiver, mod-
ifier la commande dans le convertisseur LATEX (STANDARD)->DVT ou le conver-
tisseur LATEX (STANDARD)->DRAFTDVI dans Préférencesr> Gestion des fichiers>
Convertisseurs comme ceci: latex -src-specials $$i. Si cela ne fonctionne pas,
vérifiez les options votre moteur TEX (la syntaxe peut différer dans quelques distri-
butions).

Paquetages externes (PDFSync et scritx)

Les paquetages pdfsync and scritz fournissent la fonctionnalité de recherche inver-
sée pour les sorties imprimables PDF (via pdflatex) et DVI, respectivement. Pour
I’activer, charger les paquetages dans le préambule LyX:

— \usepackage{pdfsync} pour la recherche inversée depuis le PDF
— \usepackage[active] {srcltx} pour la recherche inversée depuis le DVI.

Si vous souhaitez effectuer la recherche inversée depuis les deux formats, vous pouvez
saisir les lignes suivantes dans le préambule:

\usepackage{ifpdf}
\ifpdf
\usepackage{pdfsync}
\else
\usepackage [active] {srcltx}
\fi

De cette fagon, vous pourrez visionner les fichiers soit en DVI, soit en PDF (pdflatex)
et le paquetage adéquat sera chargé.

Notez bien que PDFSync peut affecter la mise en page du document, il vaut mieux
le désactiver lors des passes finales de compilation du document.

Recherche inversée DVI inhérente via SyncTgX (DVI et PDF)

Les versions récentes de (pdf)latex offrent un support inhérent pour la recherche
inversé en PDF et DVI. Cette fonctionnalité dénommée SyncTgX résulte a la base
de l'intégration du paquetage PDFSync dans le programme pdftex et de sa fusion
avec 'approche scr-specials. Il vous faut au moins TEXLive 2008 ou une distribu-
tion MikTEX récente pour pouvoir l'utiliser 2. Notez également que seules quelques

2. Pour certaines raisons, MikTEX ne comprend ou n’exécute pas la commande que IyX insere
dans le préambule quand vous cochez le bouton “Activer la recherche directe/inversée” de la barre
d’outils et ne crée pas 'information nécessaire.

La création de cette information peut étre forcée en modifiant le convertisseur “INTEX (pdflatex)
-> PDF (pdflatex)” dans Préférences->Gestion des fichiers->Convertisseurs de la valeur implicite
'pdflatex $$i" & "pdflatex -synctex=1 $$i" (i.e., en ajoutant le commutateur -synctex=1).
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visionneuses (comme Okular et Qpdfview sur Unix, Skim sur Mac, SumatraPDF sur
Windows; voir la section suivante pour les détails) supportent actuellement SyncTEX.

Pour activer SyncTEX pour le résultat imprimable DVI, modifier le convertisseur
LATEX (STANDARD) -> DVTI ou le convertisseur LATEX (STANDARD) -> DRAFT-
DVTI dans Préférences > Gestion des fichiersi> Convertisseurs en latex -synctex=1 $$i,
et pour le résultat imprimable PDF, modifier le convertisseur LATEX (PDFLATEX)
-> PDF (PDFLATEX) en pdflatex -synctex=1 $$i. Si votre visionneuse n’est
pas décrite dans ce qui suit, ou en cas d’échec, vérifiez la documentation de votre
visionneuse pour ce qui concerne la configuration pour SyncTEX 3.

10.6.3 Configuration et utilisation de visionneuses particulieres
Xdvi (toutes plate-formes)

Si vous utilisez xdvi, vous n’avez rien de plus a faire pour utiliser la recherche
inversée, puisque LyX fournit les ancres nécessaires pour l'utilisation automatisée
de lyxclient. Il vous suffit de paramétrer votre document comme indiqué plus
haut (la recherche inversée est déclenchée par Ctrl-clic ou Alt-clic sur Mac OSX,
respectivement).

Cependant, si pour quelque raison vous préférez utiliser le tube nommé au lieu
du connecteur pour la communication avec LyX, modifiez simplement la vision-
neuse DVI dans Préférences> Gestion des fichiersi> Convertisseurs en* xdvi -editor
"lyxeditor.sh %f %1", ou lyxeditor.sh est un script approprié. Par exemple, un
script minimal est le suivant:

#!/bin/sh

LYXPIPE="/path/to/lyxpipe"
COMMAND="LYXCMD:revdvi:server-goto-file-row:$1 $2"
echo "$COMMAND" > "${LYXPIPE}".in || exit

read TMP < "${LYXPIPE}".out || exit

ou /path/to/lyxpipe est le chemin d’acces au tube LyXServer spécifié dans Préférences>
Paths.®

MacDviX (Mac OSX)

A la fin du script /Applications/MacDviX _Folder/calleditor.script, ajoutez
les lignes suivantes:

/Applications/LyX.app/Contents/Mac0S/lyxeditor "$2" $1
exit 1

3. L’option -synctex=1 active la compression gzip. Si votre visionneuse ne la comprend pas,
vous devez saisir a la place -synctex=-1.

4. Sur Mac OSX vous devez utiliser DISPLAY=:0.0 xdvi -editor "lyxeditor.sh %f %1"

5. Dans le répertoire development/tools de la distribution des sources LiyX, vous trouverez un
script lyxeditor, capable de trouver le lyxzpipe de vos préférences.
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Adaptez ces lignes si vous installez [yX ailleurs que dans le répertoire Applications.
La recherche inversée est déclenchée par Alt-clic (OPTION-clic).

Skim (Mac OSX)

Saisir open -a Skim.app $3$i dans le réglage de la visionneuse Préférences > Gestion

des fichiers> Formats de fichiers> PDF (pdflatex), et ensuite dans Skim> Préférencesr>

Sync choisissez la présélection custom et saisissez la commande / APPLICATIONS /Ly X .ApP/CONTENTS /M.
La recherche inversée est déclenchée par COMMAND-SHIFT-clic.

Evince (GNOME)

La recherche inversée ne fonctionne pas directement avec evince, mais elle peut étre
obtenue a l'aide de scripts auxiliaires externes: voir https://wiki.lyx.org/LyX/SyncTeX
pour les détails.

Okular (KDE)

Aller a Configuration > Configurer Okular > Editeur et sélectionner Ly X en tant qu’éditeur.
Ceci insére la commande appropriée (lyxclient -g %f %1).

La recherche inversée est déclenchée par SHIFT-clic. Notez que ceci ne fonctionne
que si Okular est en mode “Navigation” (i.e. le symbole de main est cliqué).

Qpdfview (Unix)

Qpdfview fonctionne avec SyncTEX depuis la version 0.3.5. Allez a Modifier>
Paramétres > Comportement, cliquer dans le champ de I’Editeur de source et ajoutez
la commande lyxclient -g %1 %2.

La recherche inversée est activée par un clic double.

YAP (Windows)

Activer Yap, choisir le menu View > Options et sélectionner 'onglet “Recherche in-
versée DVI”. Cliquer sur le bouton “New...” et, dans la fenétre qui s’ouvre, saisir
“LyX Editor” (ou un autre nom de votre choix) dans le champ “Name:”. Main-
tenant cliquer sur le bouton identifié par “...” pour ouvrir une fenétre de choix de
fichier et aller jusqu’au répertoire contenant le fichier exécutable lyxeditor.bat (voir
ci-dessous). Sélectionner lyxeditor.bat et spécifier les arguments du programme
comme suit: %f %1. Le conteneur lyxeditor.bat est utilisé pour communiquer avec
LyX via lyzpipe et se présente ainsi

Q@echo off
echo LYXCMD:revdvi:server-goto-file-row:%~1 %2> \\.\pipe\lyxpipe.in
type \\.\pipe\lyxpipe.out

109


https://wiki.lyx.org/LyX/SyncTeX

10.6. RECHERCHE INVERSEE DVI/PDF CHAPITRE 10. LE SERVEUR LyX

Vérifier que le chemin d’acces au tube LyXServer spécifié dans Iy X est bien \\.\pipe\lyxpipe,
sinon adapter le conteneur lyxeditor.bat.
Avec Yap, la recherche inversée est déclenchée par double-clic.

SumatraPDF (Windows)

Pour utiliser SumatraPDF en recherche inversée, saisir SumatraPDF -inverse-search
"lyxeditor.bat "%f" %1" dans les réglages de la visionneuse dans Préférences>
Gestion des fichiers > Formats de fichiersi> PDF (pdflatex), ou 1yxeditor.bat est le con-
teneur indiqué ci-dessus. Si SumatraPDF.exe ne figure pas dans la liste des chemins
des commandes, utiliser le nom complet.

La recherche inversée est déclenchée par double-clic.

YAP (Cygwin)

D’abord, vérifier que Yap est la visionneuse DVI implicite de I’environnement Win-
dows, puis le lancer, choisir le menu View > Options et sélectionner ’onglet “Recherche
DVT inversée”. Cliquer sur le bouton “New...” et, dans la fenétre qui s’ouvre, saisir
“Editeur LyX” (ou un autre nom de votre choix) dans le champ “Name:”. Main-
tenant cliquer sur le bouton identifié par “...” pour ouvrir une fenétre de choix
de fichier et aller jusqu’au répertoire contenant le fichier exécutable lyxeditor.exe
(qui est implicitement installé dans Cygwin avec I'exécutable IyX) . Sélectionner
lyxeditor.exe et spécifier les arguments du programme comme suit: -g %f %1.
De cette fagon, vous utiliserez le lyzsocket pour communiquer avec IyX. Si pour
quelque raison, vous souhaitez utiliser lyzpipe, omettez l'option -g et spécifiez le
chemin d’acces au tube LyXServer dans les préférences.

Avec Yap, la recherche inversée est déclenchée par double-clic.

SumatraPDF (Cygwin)

Pour utiliser SumatraPDF en recherche inversée, saisir SumatraPDF.sh dans les
réglages de la visionneuse dans Préférencest> Gestion des fichiers> Formats de fichiers>
PDF (pdflatex), ouSumatraPDF.sh est le script suivant (& rendre accessible dans le
chemin d’acces aux commandes, /usr/local/bin étant le meilleur choix):

#!/bin/bash
cd $(dirname $1)
SumatraPDF -inverse-search "lyxeditor -g %f %1" $(basename $1)

Ce conteneur et nécessaire parce que SumatraPDF est une application Windows
native et ne comprend pas les chemins POSIX utilisés par la version Cygwin de
LyX. Si SumatraPDF.exe n’est pas dans votre chemin d’acces, utiliser le chemin
complet dans le script ci-dessus. L’option -g active la communication via lyzsocket.
De nouveau, I'omettre —g pour utiliser lyzpipe, et spécifier le chemin d’acces au tube
LyXServer dans les préférences LyX.

La recherche inversée est déclenchée par double-clic.
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10.7 Recherche directe

La recherche directe est, comme son nom l'indique, “’opposé” de la recherche in-
versée. Elle vous permet de positionner le curseur dans la visionneuse directement
depuis IyX. Si le recherche inversé est active (comme décrit ci-apres), vous pouvez
positionner le curseur ou vous voulez dan le document IyX, et sélectionner Naviga-
tion > Recherche directe (ou sélectionner Recherche directe dans le menu contextuel par
un clic droit), et la visionneuse sera positionnée au méme emplacement. Ce suppose
bien entendu que la visionneuse interprete cette fonctionnalité.

Pour rendre la recherche directe active, vous devez d’abord créer le fichier PDF/DVI
avec les informations supplémentaires concernant les source TEX: ceci peut étre fait
par les méthodes décrites dans la section 10.6.1.

De plus, vous devez configurer LyX pour utiliser les visionneuses dans Outilst>
Préférencesr> Sortie> Général. LyX fournit une série de configurations validées pour
quelques visionneuses, que vous pouvez sélectionner dans le menu déroulant. Si
aucune de ces configurations ne vous convient, vous devrez chercher et trouver une
configuration appropriée vous-méme. La syntaxe utilise les marqueurs suivants:

— $$n: numéro de ligne;
— $$t: nom du fichier .tex (temporairement) créé;

— $$0: nom du fichier de sortie (soit dvi, soit pdf, en fonction de celui qui existe
dans le répertoire temporaire).

Notez que seules quelques visionneuses présentent une fonctionnalité de recherche
directe complete, parmi lesquelles YAP, XDVI, OKULAR®, QPDFVIEW et SUMATRA
PDF 7. d’autres, comme evince®, nécessitent des outils supplémentaires. Alors que
beaucoup des visionneuses PDF largement diffusées (parmi lesquelles on remarquera
Adobe Reader) ne comprennent pas du tout la recherche directe, d’autre visionneuses,
comme XPDF, permettent au moins de recharger le document et de sauter a une page
donnée: vous pouvez au moins naviguer a proximité du point visé. Cette derniere
fonctionnalité est activée par un appel externe a synctex (voir les configurations
prédéfinies).

La recherche directe fonctionne simultanément avec les sorties DVI et PDF. LyX
vérifie simplement quel format vous avez utilisé (c’est-a-dire, quel format est déja
résident dans le répertoire temporaire) et choisit la configuration adéquate.

6. Vous pouvez saisir okular --unique dans Outils> Préférences> Gestion des fichiers> Formats
de fichiers

7. SumatraPDF peut aussi utiliser les commandes DDE via le programme externe CMCDDE —
téléchargeable depuis http://www.istri.fr/spip/zip/CMCDDE.zip

8.

La recherche directe avec evince peut étre obtenue via des programmes externes auxiliaires. Voir
https://wiki.lyx.org/LyX/SyncTeX pour les détails.
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11 LyX et applications externes

11.1 Correcteur TgX

par ASGER ALSTRUP

11.1.1 Introduction

Vous trouverez dans le menu Outils la commande Correction TEX. Cette fonction-
nalité requicre le programme chktex ! et la commande est donc grisée si celui-ci n’est
pas installé. Vous pouvez vous le procurer de CTAN,
https://www.ctan.org/tex-archive /help/Catalogue/entries/chktex.html.

Le paquetage ChkTEX est un programme qui a été écrit par JENS T. BERGER
THIELEMANN qui se plaignait que certaines commandes de I¥TEX n’étaient pas na-
turelles et s’oubliaient facilement. Ce programme parcourt votre fichier BTEX et en
vérifie la bonne écriture. C’est donc ’équivalent de Lint, mais pour ETREX.

La question est donc : mais que vient faire ce logiciel sous [yX alors que LyX
est déja censé produire du KTEX exempt de fautes ? La réponse est simple : tout
comme Lint ne vérifie pas seulement la syntaze d’un fichier C, mais aussi la bonne
utilisation des types, ChkTEX détecte en plus des erreurs syntaxiques quelques erreurs
typographiques. Entre autres, ChkTEX est a méme de détecter des erreurs courantes
comme 2

— de mauvais points de suspension :
Utiliser ... et non pas ...;

— des espaces a l'intérieur des parentheses :
( mauvais espacement );

— T'utilisation d’espaces normaux dans des abréviations courantes :
Par exemple il y a ici trop d’espaces dans ’abréviation C. N. R. S.;

— Tutilisation d’'un mauvais espacement a la fin d’'une phrase dont la derniere
lettre est une majuscule :
Voici un TEST. Et 'espacement n’est pas bon;

— l’insertion d’une espace avant une étiquette ou un autre objet de ce type :
L’étiquette ou la note doit étre collée au texte, sans quoi elle risque d’apparaitre

1. chktex n’est pas encore disponible avec la distribution MiKTEX.
2. NdT : Certaines de ces régles me sont totalement inconnues. Il est possible qu’elles ne
s’appliquent pas a la langue frangaise. — of
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sur une mauvaise page. . L’étiquette est ici trop séparée;

— T'utilisation d’espaces simples au lieu d’espaces insécables devant des références

Si vous n’avez pas de chance, le saut de ligne aura lieu exactement entre le mot
“section” et le numéro, et ¢a ferait le plus mauvais effet... : voyez la section
11.1.1;

— I'utilisation d’un “x” au lieu du symbole “x” entre deux nombres :
2x2 rend beaucoup moins bien que 2 X 2

et bien plus encore... C’est un outil tres utile pour le “polissage final” du docu-
ment avant son impression, et vous devriez 1'utiliser apres 'inévitable correction de
I'orthographe et avant d’affiner la typographie.

11.1.2 Comment l'utiliser

Si le programme est installé, 'employer est un jeu d’enfant : faites
Outils> Correction TEX. LyX générera alors une version IXTEX de votre document,
lancera ChkTEX pour la corriger, puis insérera des “boites d’erreurs” avec les aver-
tissements de ChkTEX, s’il y en a. Ces avertissements seront placés au plus pres de
I’erreur, et vous pourrez facilement les trouver avec Navigationt Erreur, ou par le rac-
courci clavier C-g (d’apres le fichier de raccourcis implicites cua). Ouvrez les boites
d’erreur en cliquant dessus, ou par le raccourci cua C-i, ou le raccourci emacs C-o.
Lisez I'avertissement, et corrigez l'erreur si ¢’en est bien une. Si vous ne comprenez
pas l'avertissement, ignorez-le. En effet, il y a des différences entre ce qu’il y a a
I’écran et les détails techniques que ChkTEX vérifie, et ¢a peut amener certains de ses
avertissements a paraitre mystérieux ou méme stupides.

Ce document est un excellent terrain d’entrainement, et sa vérification levera stire-
ment quelques avertissements. Les ordinateurs sont idiots: la plupart de ces aver-
tissements seront donc des fausses alertes.

11.1.3 Réglages fins

Vous trouverez parfois que ChkTEX est plus bavard qu’il ne devrait I'étre. Vous
pouvez alors choisir de ne pas l'utiliser, ou alors le configurer a vos propres gofits.

Mais, méme si ChkTEX est vraiment configurable et extensible, vous ne pourrez
pas résoudre tous les problemes de ChkTEX dans LyX de cette maniere. En effet,
LyX géneére un fichier IXTEX un peu particulier pour étre ensuite capable de faire
correspondre les numéros de lignes indiqués par ChkTEX* avec la structure interne
du document. De ce fait, certains avertissements ne sembleront pas apparaitre cor-
rectement. Vous pouvez faire deux choses contre cela :

3. Cette note peut apparaitre sur une mauvaise page, car son appel (le petit numéro dans le
texte) n’est pas collé au mot le précédant.

4. Vous pouvez trouver toutes les indications de chktex en faisant Document Fichier Jour-
nal KTEX apres avoir lancé chktex.
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— Paramétrez 'appel a ChkTEX dans Outils > Préférences > Sorties > IATEX, ou alors
dans le fichier de configuration de U'installation de ChkTEX (souvent, le fichier
chktexrc). Voyez ci-dessous pour savoir quels avertissements peuvent étre
activés ou désactivés a la ligne de commande.

— Exportez votre document en tant que fichier IXTEX normal par Fichier > Exporter >
BTEX et lancer manuellement chktex dessus. S’il est invoqué de cette fagon,
ca peut étre pénible de trouver I’endroit correspondant dans le document IxX,
mais avec un peu de patience, vous devriez y arriver.

Voici maintenant les messages d’avertissement qui peuvent étre activés ou désactivés
dans Préférences. Utilisez —n# pour désactiver un avertissement, et —w# pour l'activer.
Les entrées en italiques sont désactivées par défaut, car le réglage de base est “ chktex
-nl -n3 -n6 -n9 -n22 -n25 -n30 -n38”".

Remarquez que vous ne devriez toucher qu’a ces options d’activation et de désac-
tivation d’avertissements, et pas aux autres. En effet, [yyX utilise les autres options
a sa convenance pour dialoguer avec chktex.

1 Command terminated with space. (La commande se termine par une espace.)
2 Non-breaking space (“~”) should have been used. (Il faut utiliser ici une espace

insécable ("~").)

3 You should enclose the previous parenthesis with “{}”. (Vous devriez entourer les
parenthéses précédentes par "{}" .)

4 Ttalic correction (“\/”) found in non-italic buffer. (Une correction d’italique ("\/")
est dans un groupe qui n’est pas en italique.)

5 Italic correction (“\/”) found more than once. (Il y a plus d’une correction d’italique
(n\/u) )
6 No italic correction (“\/”) found. (Il n’y a pas de correcteur d’italique ("\/" ) .)

7 Accent command “cmd” needs use of “cmd”. (La commande "cmd" requiére I'utilisation
de "cmd".)

8 Wrong length of dash may have been used. (Il se peut que le tiret ne soit pas de la
bonne longueur.)

9 “%s” expected, found “%s”. (Attendait "%s", a trouvé "}s".)
10 Solo “%s” found. (Un seul "%s" a été trouvé.)

11 You should use “%s” to achieve an ellipsis. (Vous devriez utiliser "%s" pour une
ellipse (points de suspension).)

12 Inter-word spacing (“\ “) should perhaps be used. (Une espace d’entre mots ("\”)
devrait peut-étre étre utilisé.)

13 Inter-sentence spacing (“\@”) should perhaps be used. (Une espace d’entre phrases
("\@") devrait peut-étre étre utilisé.)

14 Could not find argument for command. (N’a pas trouvé de parameétre a la com-
mande.)

15 No match found for “%s”. (Aucune occurrence de “ %s” n’a été trouvée.)
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16 Math mode still on at end of WTEX file. (Le fichier IATEX se termine dans le mode
Math.)

17 Number of “char” doesn’t match the number of “char”. (Le numéro de "char" ne
correspond pas a celui de "char".)

18 You should use either " or " as an alternative to “"”. (Vous devriez utiliser " ou "
plutét que """.)

19 You should use "’" (ASCII 39) instead of """ (ASCII 180). (Vous devriez utiliser "*"
(ASCII 39) au lieu de """ (ASCII 180).)

20 User-specified pattern found. (A trouvé un format défini par 'utilisateur.)

21 This command might not be intended. (Cette commande n’est peut-étre pas volon-
taire.)

22 Comment displayed. (Un commentaire est affiché.)

23 Either "\,? or >\," will look better. ("\,” ou ’\," présentera mieux.)

24 Delete this space to maintain correct page references. (Enlevez cette espace pour
avoir une pagination correcte.)

25 You might wish to put this between a pair of “{}”. (Ce serait peut-étre mieuzx entre
deuz accolades "{}".)

26 You ought to remove spaces in front of punctuation. (Il n’y a pas d’espace devant
cette ponctuation.)

27 Could not execute IATEX command. (Ne peut pas exécuter la commande KTEX.)

28 Don’t use \/ in front of small punctuation. (N’utilisez pas \/ devant la ponctuation
basse.)

29 $\times$ may look prettier here. ($\times$ serait mieux ici.)

30 Multiple spaces detected in output. (La sortie affiche ici plusieurs espaces.)

31 This text may be ignored. (Ce texte ne sera peut-étre pas pris en compte.)

32 Use " to begin quotation, not ’. (Utilisez " pour ouvrir une citation et non ’.)

33 Use ’ to end quotation, not ". (Utilisez ’ pour clore une citation et non ".)

34 Don’t mix quotes. (Ne mélangez pas les différents types de guillemets.)

35 You should perhaps use “cmd” instead. (Il vaudrait peut-étre mieux utiliser "cmd".)

36 You should put a space in front of/after parenthesis. (Il faut des espaces a ’extérieur
des parentheses.)

37 You should avoid spaces in front of/after parenthesis. (Ne mettez pas d’espaces a
I'intérieur des parentheses.)

38 You should not use punctuation in front of/after quotes. (La ponctuation ne doit pas
apparaitre derriere les guillemets.)

39 Double space found. (Double espace !)

40 You should put punctuation outside inner/inside display math mode. (La ponctua-
tion devrait se trouver a lextérieur du mode mathématique.)

41 You ought to not use primitive TEX in ITEX code. (Vous ne devez pas utiliser de

primitives TEX dans du code IATEX.)
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42 You should remove spaces in front of “%s”. (Ne mettez pas d’espaces devant "%s".)

43 “%s” is normally not followed by “%c”. ("%s" n’est normalement pas suivi de "%c".)

Nous espérons fournir dans les versions futures de IxX une interface plus complete
a cet outil (ainsi qu’a son petit cousin lacheck) pour pouvoir en exploiter toute la
puissance. Mais, , il est dés maintenant utilisable : lancez-le sur I'un de vos documents
de bonne taille, et voyez le résultat.

11.2 Controéle de version sous LyX

par LARS GULLIK BJONNES ET PAVEL SANDA

11.2.1 Introduction

[y X accepte la plupart des commandes simples de RCS/CVS/SVN. Si vous devez
utiliser des fonctions plus sophistiquées, il vous faudra cependant encore passer par
un terminal de commande ou votre client favori.

Notez également que le support de CVS n’est pas aussi bon que celui de Subversion,
que nous vous conseillons donc. Un bon document de départ pour Subversion est le
Manuel SVN®. Pour RCS, lisez d’abord “rcsintro” (c’est un fichier man : lisez-le
avec man rcsintro). Ce fichier décrit toutes les fonctions de base de RCS. Voyez
particulierement le paragraphe sur le répertoire RCS, et la notion de fichier RCS
maitre (le fichier finissant par ,v).

Avant de vous lancer dans I'utilisation du controle de version sous Ly X, vous devrez
connaitre l'utilisation de RCS/CVS/SVN. Le support assuré dans LyX a été réalisé
pour des versions récentes des paquetages GNU RCS ou CVS/SVN il n’est pas garanti
que cela fonctionne avec des versions plus anciennes. En général, les messages de
contrdle ne sont pas affichés apres chaque opération vous pouvez les vérifier dans la
console de lancement de LyX si vous doutez. Les utilisateurs réguliers du controle
de version apprécieront la barre d’outils correspondante, qui peut étre activée via
Affichage > Barre d'outils> Contrdle de version.

Pour créer vos propres commandes externes, consultez vc-command dans le manuel
des Fonctions LyX.

Il est fortement recommandé d’enregistrer les documents en mode non compressé
lors de "utilisation du contrdle de version (décochez Document > Compressé si la case
est cochée): les documents LyX non compressées sont des fichiers textuels qui peuvent
étre fusionnés par le controle de version. Mes documents compressés sont des fichiers
binaires qui ne peuvent pas étre fusionnés. En outre pour éviter des conflits de
fusion nous vous invitons a désactiver Document > Paramétres > Sortie > Enregistrer les
propriétés temporaires si plusieurs utilisateurs travaillent sur le méme document.

5. http://svnbook.red-bean.com/
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11.2.2 Les commandes RCS sous LyX

Les sections suivantes décrivent les commandes RCS supportées par LyX. Vous
pouvez les trouver dans Fichier>Controle de Version. Lyx a été testé avec RCS
5.7/5.8/5.10.

11.2.2.1 Initialiser le contrdle de version

Si votre document n’est pas sous le mode “controle de version”, c¢’est le seul choix
qui vous soit proposé. Si vous étes déja sous ce mode, I’élément S’ INSCRIRE est grisé
et inaccessible.

Cette commande intialise le controle de version avec RCS. Il vous est alors demandé
de donner une description initiale du document. Le document est alors mis en mode
“lecture seule” et il vous faudra faire Nouvelle Version Modifiable avant de le modifier.
Un document sous controle de version a dans le minibuffer “[RCS: <version><locker>|"
accolé au nom de fichier.

En arriere-plan, la commande RCS qui a été lancée est

ci -q -u -1 -t-"<description_initiale>" <nom_fichier>.

Lisez man ci pour comprendre le sens des parametres.

11.2.2.2 Enregistrer les changements

Lorsque vous avez fini de modifier un fichier, vous figez vos modifications® par
FICHIER > CONTROLE DE VERSION > ENREGISTRER LES CHANGEMENTS.... Il vous
sera alors demandé une description de ceux-ci. Cette information est conservée dans
le fichier d’historique. Le numéro de version est alors incrémenté, vos modifications
sont appliquées au fichier RCS maitre et le document est déverrouillé et remis en
mode “lecture seule”.

— Commande RCS : ¢i -q -u -m"<description>" <nom_fichier>

11.2.2.3 Nouvelle version modifiable

En utilisant cette commande, vous verrouillez le document de maniere a ce que
vous soyez le seul a pouvoir I’éditer. Vous seul en possédez les droits d’écriture. Vous
continuez donc a éditer le fichier un moment, puis vous figez vos changements. La
ligne d’état est modifiée pour indiquer que le fichier est verrouillé.

— Commande RCS : co -q -1 <nom_fichier>

11.2.2.4 Revenir a la version du dépot

Ceci annule tous les changements réalisés sur le document depuis que le document
a été figé la derniere fois. Une demande de confirmation apparailt alors, avant que
tous les changements soient perdus.

6. NdT : check-in
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— Commande RCS : co -f -u<version> <nom_fichier>

11.2.2.5 Copy

Ceci va créer une copie du document. Du fait que RCS ne prévoit pas a l'origine
de gérer les opérations de copie, I’historique de version n’est pas préservé et la copie
est ajoutée comme un nouveau fichier. Elle suppose un document propre sans modifi-
cations depuis le dernier enregistrement. On vous demande un nom de fichier et une
description de I'opération de copie. Ensuite la copie est créée, a la fois localement et
dans le dépot. Si les répertoires parents de la copie et du document original sont dif-
férents, tous les chemins relatifs des fichiers inclus sont corrigés (comme avec Fichier>
Enregistrer sous. ..). Enfin, la copie est chargée a la place du document original.

— Commandes RCS :
Copy "<file-name>" to "<new-file-name>"
ci -q -u -i "<new-file-name>"
11.2.2.6 Annuler le dernier enregistrement

Fait comme si la derniére modification n’avait jamais été faite. Aucune modification
n’apparait sur le document LyX, mais la derniére version est effacée du fichier maitre
RCS.

— Commande RCS : rcs -o<version> <nom_fichier>

11.2.2.7 Visionner historique

Montre I'historique complet du document RCS. La sortie de rlog <nom_fichier>
est ainsi affichée dans une fenétre. Voyez man rlog pour plus d’informations.
11.2.2.8 Informations de révision

Lyx ne connait que le numéro de version RCS, voir 11.2.4.11pour les détails.

11.2.3 CVS commands in LyX

A subset of CVS operations is supported by LyX. You can find the commands in
the Filer>Version Control submenu. The version control system SVN is more powerful,
so please use it instead of CVS if possible.

11.2.3.1 General CVS usage

If you start from scratch with CVS you have to create your repository and checkout
the working copy with external tools. If you're using a client-server setup you may
need to login before doing the first repository checkout.

If your documents are under revision control and others are using the same reposi-
tory problems arise when different changes to the same document at the same location
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happen. Standard CVS repositories don’t operate with a file locking mechanism. This
may be surprising, but conflicts only occur if people disagree on the proper content
of the same part of a document. So, if co-workers are used to communicate regularly,
these conflicts occur rarely. If they don’t communicate they have a fundamental
problem anyway. Nevertheless some people like to work with so called “reserved
checkouts”. If they do so the working copy of all files is readonly when checked out
first and the user starts editing after using a special command to make the working
copy writable. When the changes are checked in the working copy returns to readonly
state. With Iy X one has to edit the .cvsrc file and add the line cvs -r to work
with reserved checkouts. The benefit is the possibility to see who is using a writable
copy of some document. It’s not guaranteed only one user makes a copy writable.

LyX tries to guess if you're using reserved or non-reserved checkouts. If your
working copy is readonly or it is writable and an additional copy of your document
exists in the CVS/Base sub-directory a reserved otherwise a non-reserved checkout is
assumed. When a reserved checkout is detected you have to use CHECK OUT to make
your working copy writable if it’s readonly. After doing so the CHECK IN operation
is possible and that makes your working copy readonly again after transferring your
changes to the repository.

More information about CVS can be found here http://www.nongnu.org/cvs and
here http://ximbiot.com/cvs.

Read man cvs to understand the sub-commands and the switches mentioned below.

11.2.3.2 Register

If your document is not under revision control, this is the only item shown in the
menu. And if it is under revision control, the Register item is not visible.

This command registers in CVS your document only in the case you have already
the documents directory under CVS control (in particular CVS/Entries file exists).
This means you have to create or checkout the archive by yourself using external
tools. (In case you forget that step Iy X registers the document with RCS.)

Then you are asked interactively to supply an initial description of the document.
Don’t forget that registered file is not yet checked in.

CVS command that isrun: cvs -q add -m"<entered message>" "<file-name>"

The term "<file-name>" above and for all other CV'S commands is an abbreviation
for “change the current working directory to file location and use the file name without
path component as argument”.

11.2.3.3 Check In Changes

When you are finished editing a file, you commit your changes. When you do this
and you had changed the document, you are asked for a description of the changes.
After that changes are written to the repository. In case you didn’t change the
document and a reserved checkout is detected the reservation made on CHECK OUT
is undone.

120


http://www.nongnu.org/cvs
http://ximbiot.com/cvs

CHAPTER 11. LyX ET APPLICATIONS GENERNVEE DE VERSION SOUS LyX

CVS command:
cvs —q commit -m"<description>" "<file-name>" or
cvs —-q unedit "<file-name>"

11.2.3.4 Check Out Changes

When you are sharing a repository with others, you may have to incorporate their
changes into your working copy.

CVS command: cvs -q update "<file-name>"

If a readonly checkout is detected the working copy is made writable and reserved.

CVS command: cvs -q edit "<file-name>"

11.2.3.5 Revert To Repository Version

This will discard all changes made to the document since the last check in. You
get a warning before changes are discarded. Firstly the file is deleted, secondly CVS
update command is run.

CVS command: cvs -q update "<file-name>"

If a reserved checkout is detected and the working copy has no changes only the
reservation is undone.

CVS command: cvs -q unedit "<file-name>"

11.2.3.6 Copy

This will create a copy of the current document. Since CVS does not support copy
operations natively, the version history is not preserved, and the copy is added as a
new file. It requires a clean document without any changes since the last checkin.
You are asked for a file name and a description of the copy operation. After that the
copy is created, both locally and in the repository. If the parent directories of the
copied and original document differ, all relative paths of included files of the copy are
adjusted (like in File>Save As...). Finally, the copy is loaded instead of the original
document.

CVS commands:
Copy "<file-name>" to "<new-file-name>"
cvs —-q add "<new-file-name>"

11.2.3.7 Rename

This will rename the current document. Since CVS does not support rename
operations natively, the version history is not preserved, the renamed document is
added as a new file, and the original document is deleted. It requires a clean document
without any changes since the last checkin. You are asked for a file name and a
description of the rename operation. After that the document is renamed, both
locally and in the repository. If the parent directories of the new and old file names
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differ, all relative paths of included files are adjusted (like in File>Save As. .. ). Finally,
the document is reloaded using the new name.

CVS commands:
Rename "<file-name>" to "<new-file-name>"
cvs —q add "<new-file-name>"
cvs —-q remove "<file-name>"

11.2.3.8 Update of the local directory checkout from repository

Once your documents gets more complex, containing sub-documents and pictures,
including external .tex files and so on using version control becomes more compli-
cated. LyX supports updating the whole tree in which resides the document. This
become especially useful once you cooperate with people which neither have detailed
knowledge about CVS usage nor they have ambition to commit additional material
to the repository. You have to organize the files structure so that all external files are
in the same directory or subdirectories of the document. It’s good practice anyway
to store multipart documents in an extra directory.

The Update local directory from repository command updates the whole di-
rectory. If local changes are detected user is warned before update starts. In case
of merge conflicts both versions of the conflicting document parts are placed in the
final document. You have to review and correct the result of the merge. You'll find
the conflicts enclosed in pairs of <<<<<<< and >>>>>>> separated by =======_ The
first part is your version as before the update operation with the document name
prepended. The second one is the repository version with the version number after
the sequence of > signs.

CVS commands:
cd $path; cvs diff "." (Ask if changes are detected.)
cd $path; cvs -q update "."

where $path stands for the path to the document.

11.2.3.9 Show History

This shows the complete history of the CVS document. The output of cvs log
"<file-name>" is shown in a browser.

11.2.3.10 Revision info

LyX supports CVS version number, author name, date and time of last commit.
All those are extracted from cvs log -r <file-name>. See 11.2.4.11 for details.

11.2.4 SVN commands in LyX

SVN is now partially supported by [yX. You can find the commands in the File>
Version Control submenu. Please note that if you use password protected access to

122



CHAPTER 11. LyX ET APPLICATIONS GENERNVEE DE VERSION SOUS LyX

repository via ssh, you will be asked in terminal window. IxyX was tested against
SVN 1.5, 1.6, 1.7 and 1.87

11.2.4.1 Register

If your document is not under revision control, this is the only item shown in the
menu. And if it is under revision control, the Register item is not visible.

This command registers in SVN your document ONLY in case you have already
the documents directory under SVN control (in particular .svn/entries file exists).
This means you have to checkout the archive by yourself.

Then you are asked interactively to supply an initial description of the document.
Don’t forget that registered file is not yet commited.

SVN command that is run: svn add -q "<file-name>"

Read man svn to understand the switches.

11.2.4.2 Check In Changes

When you are finished editing a file, you commit your changes. When you do this,
you are asked for a description of the changes. After that changes are commited.
SVN command:® svn commit -q -m"<description>" <file-name>

11.2.4.3 Check Out For Edit

Updates the changes of this file from the repository. Be sure you understand SVN
merging and conflicts resolving before using this function, because all conflicts has
to be resolved manually by you!

SVN command:? svn update --non-interactive "<file-name>"

11.2.4.4 Revert To Repository Version

This will discard all changes made to the document since the last check in. You
get a warning before changes are discarded.
SVN command: svn revert -q "<file-name>"

11.2.4.5 Copy

This will create a copy of the current document including the version history. It
requires a clean document without any changes since the last checkin. You are asked
for a file name and a description of the copy operation. After that the copy is created,
both locally and in the repository. If the parent directories of the copied and original

7. Most of the commands will work with 1.4 too, see 11.2.4.7. There seems to be currently
unresolved permissions problem under SVN 1.8 with reverting changes when file is locked.

8. In case locking is not enabled. See Section 11.2.4.9.

9. Ditto.
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document differ, all relative paths of included files of the copy are adjusted (like in
Filer-Save As. . .). Finally, the copy is loaded instead of the original document.

SVN commands:
svn copy —q "<file-name>" "<new-file-name>"
svn commit

11.2.4.6 Rename

This will rename the current document including the version history. It requires
a clean document without any changes since the last checkin. You are asked for a
file name and a description of the rename operation. After that the document is
renamed, both locally and in the repository. If the parent directories of the new and
old file names differ, all relative paths of included files are adjusted (like in Filer>Save
As...). Finally, the document is reloaded using the new name.

SVN commands:
svn move —-q "<file-name>" "<new-file-name>"
svn commit

11.2.4.7 Update of the local directory checkout from repository °

All the commands above have one shortcoming — they deal with the current doc-
ument only. Once your document contains pictures, includes external .tex files and
so on administration becomes more complicated. LyX now supports updating the
whole tree in which resides the document *'. This become especially useful once you
cooperate with people which neither know about subversion management nor they
have ambition to commit additional material to the repository.

Update local directory from repository command updates the whole direc-
tory and in case of merge conflicts local version of the files are left, so no unintended
data loss occurs. If local changes are detected user is warned before update starts.

SVN commands:
svn diff $path (Ask if changes are detected.)
svn update --accept mine-full $path

where $path stands for the path to the document.

11.2.4.8 Show History

This shows the complete history of the SVN document. The output of svn log
"<file-name>" is shown in a browser.

10. Note that this command will work only with subversion = 1.5
11. One need to organize the files structure so that all external files are in the same directory or
subdirectories of the document.
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11.2.4.9 File Locking

The file exchange through various revision control systems brings the problem of
merge conflicts in case two different users try to edit the same (parts of) document.
When such a conflict happens it needs manual resolving and one reasonable alterna-
tive is to provide some kind of locking mechanism, which guarantees that only one
user is allowed to edit file at the given time.

SVN has two such mechanisms to provide mutual exclusivity for file access — locks
and automatic setting of write permissions (see sec. 11.2.4.10) based on svn:needs-lock
file svn property '2. If this property is detected for a given document IyX starts to
use SVN locks for document editing automatically and the whole check-in/out mech-
anism switches to the same regimen as for RCS. This in particular means there are
two different modes of file use in IyX:

— Unlocked state. The loaded file is in the read-only mode. For editing on needs
to check-out. Check-out consists of updating from the repository and gaining
write lock. If the lock is not possible to obtain, we remain in unlocked state.

— Locked state. The loaded file is in the ‘normal’ edit mode. No other user is
allowed to edit the file. Check-in consists of commiting changes and releasing
write-lock. If no changes have been made to the document, no commit will be
produced ' and only the write-lock will be released.

SVN commands:

Check-in: svn commit -q -m"<description>" "<file-name>"
svn unlock "<file-name>"

Check-out: svn update "<file-name>"
svn lock "<file-name>"

11.2.4.10 Automatic Locking Property

The above mentioned automatic setting of write permissions of the .lyx file can
be set through File>Version Control>Use Locking Property. This command is active
only when the file is not locked on the svn server (i.e. you need to check-out before
proceeding).

SVN commands:
Set: svn propset svn:needs-lock ON "<file-name>"

Unset: svn propdel svn:needs-lock "<file-name>"

11.2.4.11 Revision Information in Documents

There are more possibilities how to activate revision information in our document.

— Iy X supports directly:

12. http://svnbook.red-bean.com/en/1.2/svn.advanced.locking.html
13. Don’t be puzzled by the fact that you will be asked for commit message anyway.
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— tree revision information (vcs-tree-revision). The result is the output
of the svnversion command, the following table gives you an idea, how
to read the results.

’ Output \ Meaning ‘
4123:4168 mixed revision working copy
4168M modified working copy
41238 switched working copy
4123P partial working copy, from a sparse checkout

4123:4168MS | mixed revision, modified, switched working copy

— file revision information. The result comes from parsing the output of
svn info --xml file.lyx. Supported flags are:

— version number of the last commit (vcs-revision)
— author of the last commit (vcs-author)
— date of the last commit (vcs-date)

— time of the last commit (vcs-time)

You can obtain this info via InsetInfo (Insérer>Champ>Révision du contrdle de
version). The information will be available only when you have the file stored
under svn managment (i.e. the .svn directory is available with your document).

Another—a hacking one—possibility is to use svn keywords '*. In short — you
set file keywords property (e.g. svn propset svn:keywords 'Rev’ file.lyx) and then
paste keyword TEX code!® tag in your document (e.g. $Rev$). This way svn
client will automatically substitute revision number (e.g. $Rev: 59 §) after
each update and commit. There are more problems with this approach. Firstly,
the ’$’ character is used in TEX world for math equations, so any occurence of
math formula Rev become Rev : 59 in your LiyX document. Similarly for
other keywords like Id, Date, Author, etc. Secondly svn output is dependent
on your locales, so its very easy that svn would produce some problematic
strings once Date is used. Thirdly you get the whole 'Rev: 59’ string in your
document instead of the plain number. Until subversion implements user’s
custom keywords it will be hard to use this approach reliably or let IyX to
support it directly.

11.2.5 SVN and Windows Environment

My inclination is to say that if the user cannot figure out the command
line operations on their own fairly quickly, they would be well advised to

use TortoiseSVN. —P. A. Rubin

14. http://svnbook.red-bean.com/en/1.4/svn.advanced.props.special. keywords.html
15. This is an easy way how to ensure that LyX won’t break the line in the middle of keyword

tag.
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11.2.5.1 Preparation

In addition to installing Iy’X, and having access to a Subversion repository, the user
will need to install the Subversion client program. A Windows installer for the client
program is available from CollabNet. The user may also want to install TortoiseSVN,
which integrates Subversion operations into the context (rightclick) menu of Windows
Explorer. Operations done outside Iy X will typically be more convenient using the
Explorer context menu. Note that TortoiseSVN is not a replacement for the client
program, which is what IyX itself will use.

11.2.5.2 Bringing a document under Subversion control

Before a LyX document can be brought under version control in Subversion, its
parent directory needs to be under version control. If the document is being added
to a project already in the repository, this is accomplished by checking the project
out to the directory where the new document will be placed. If the project itself is
not yet under version control (for instance, if this document starts a new project),
the directory must be imported into the repository. This is done outside IyX. Both
import and checkout are easily accomplished from the Explorer context menu using
TortoiseSVN, or alternatively can be done using the command line client at a DOS
prompt. The procedure for importing the project using TortoiseSVN is described
below, assuming an existing repository and a new project being started in C:\new
project. For information on using the Subversion client program, run svn --help
in a DOS shell.

1 Locate C:\new project in Windows Explorer, right click it, and select Tor-
toiseSVN > Repo-browser. If necessary, adjust the URL for the repository, then
click OK.

2 Right click the level of the repository under which you want to place the new
project folder (typically the top level) and click Create folder Supply a name
for the project folder and click OK. Add a message for the log file if desired,
then click OK again. The new project folder should appear in the repository.
Finally, click OK again to exit the repository browser.

3 Once again right click C:\new project, this time selecting SVN Checkout. ..
Select the URL of the project folder you just created in the repository, and
set the checkout directory to C:\new project. Click OK. You will be warned
about a non-empty folder; click OK to proceed. You should now have a .svn
directory under C:\new project.

4 Create or open your document in IyX and click File>Version Control > Register.
Add a log message and click OK to commit the document to version control.

From this point onward, you should have full functionality in the File > Version Control
menu. You also have the option of checking the document in and out, viewing
its history, etc. using the TortoiseSVN context menu in Windows Explorer or the
Subversion client program from a command prompt.
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11.2.5.3 SSH tunnel used with SVN under Windows

Compared with Linux setting up an svn client to communicate over ssh under
Windows is a rather troublesome task. We will at least offer some hints how to setup
the client side but prior knowledge about ssh and the Windows command line is
needed, also be prepared for a great deal of frustration. ..

1 Get an svn client for windows, as described in the previous sections. When it
is a fresh install run some svn command (e.g. svn --version) to create config
files, which you will need to change later on.

2 Choose an ssh client for Windows. There are several possibilities, we will use
the one from Putty tools . You will need to set the connection up so that the
client doesn’t ask for any password from you. To keep things easy we will use
only keys without any additional password protection etc.

a) Generate keys by puttygen. Save your private .ppk key file and put the
public one on the server side. If the SVN server runs on Linux, note
that the format of the public key is not compatible with Linux openssh
and you will need to direcly copy-paste the key from the “Public key for
pasting into OpenSSH authorized keys file:” edit field into the server’s
~/.ssh/authorized_keys / authorized_keys?2 file.

b) Get the Putty’s plink. In the SVN config file!?, section [tunnels], setup
ssh command, e.g. ssh=c:/path/plink.exe -i c:/path/private_key.ppk.'®

3 Checkout the SVN archive, e. g.
svn co svnt+ssh://user@server/repository_path.

11.2.5.4 End-of-Line Conversions

When the collaborators are mixing Linux and Windows environments, LyX will
use different line endings inside the .lyx files. This is not a problem as far as [yX
functionality is concerned, but the commit diffs will be huge and merge-conflicts
prone. Fortunately SVN itself knows!® how to deal with CR/LF problems when
switching .lyx files to the native mode. %’

11.2.6 Les commandes GIT sous LyX

Un sous-ensemble minimal des commandes GIT est reconnu par LyX. Les com-
mandes se trouvent dans le sous-menu Fichier > Controle de version. Notez bien que si

16. http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html

17. Exact path depends on Windows version, usually somewhere around c:\Documents and
Settings\user\Application Data\Subversion\config / AppData\Roaming\Subversion.

18. It will usually take a lot of time to get exact command right and it depends on many things.
For example do not have some remote server saved as a default session in Putty etc. If things fail,
try to connect via plink without SVN first.

19. http://svnbook.red-bean.com/en/1.4/svn.advanced.props.file-portability.html

20. For the lazy guys: svn propset svn:eol-style native FILE_NAME
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vous utilisez un acces ssh au dépot protégé par mot de passe, 'authentification sera
requise dans un terminal. IyX a été testé vis a vis de GIT 1.72L.

Une différence importante entre GIT et les autres systemes de controle de version
reconnus réside dans la nature distribuée de GIT. Avec les systemes traditionnels, ; il
y a un serveur central qui héberge le dépot. Les utilisateurs soumettent leurs modifi-
cations au serveur, et récupérent les mises a jour des autres auteurs depuis le serveur.
Avec GIT, les utilisateurs soumettent a un dépot local. Le dépot local peut étre syn-
chronisé avec un dépot distant ou plusieurs en utilisant les commandes GIT pull
et push. LyX n’interagit en aucune maniere avec les dépots distants, il ne travaille
qu’avec le dépot local de maniére similaire a ce qui est fait avec un dépdt central CVS
ou SVN. Si vous utilisez des dépdts GIT distants, vous devez exécuter les opérations
pull et push avec votre client GIT habituel.

11.2.6.1 Initialiser le controle de version

Si votre document n’est pas sous le mode « contrdle de version », c¢’est le seul choix
qui vous soit proposé. Si vous étes déja sous ce mode, 1’élément S’INSCRIRE est grisé
et inaccessible.

Cette commande initialise le controle de version de votre document sous GIT UNI-
QUEMENT si le répertoire du document est déja sous contrdle de GIT (en parti-
culier le fichier .git/index existe®?). Ceci signifie que vous devez créer I’archive
vous-méme.

On vous demandera ensuite une description initiale du document. N’oubliez pas
que la version initialisée n’est pas encore enregistrée.

La commande GIT exécutée : git add "<nom-de-fichier>"

Consulter man git pour comprendre les options.

11.2.6.2 Enregistrer les changements

Lorsque vous avez fini de modifier un fichier, vous figez vos modifications. Il vous
sera alors demandé une description de ceux-ci. Les modifications sont soumises en-
suite.

La commande GIT exécutée : git commit -q -m"<description>" <nom-de-fichier>

11.2.6.3 Revenir a la version du dépot

Ceci annule tous les changements réalisés sur le document depuis que le document
a été figé la derniere fois. Une demande de confirmation apparait alors, avant que
tous les changements soient perdus.

La commande GIT exécutée: git checkout -q "<nom-de-fichier>"

21. Les utilisateurs de Windows devront s’assurer que git est bien dans le chemin d’acces aux
exécutables. Ceci peut étre réglé depuis LyX via Outils> Préférences > Répertoires > Préfixe PATH.

22. Pour cela, & la fois git init *et* un enregistrement initial (ou au moins git add) doivent
étre faits a la main.
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11.2.6.4 Renommer

Cette commande va renommer le document courant, historique de versions inclus.
Elle requiert un document propre sans modifications depuis le dernier enregistrement.
Elle vous demande un nom de fichier et une description de 'opération de renommage.
Le document est renommé ensuite, a la fois localement et dans le dépdt. Si les réper-
toires parents de I'ancien et du nouveau fichier different, tous les chemins relatifs des
fichiers inclus sont rectifiés (comme avec Fichier > Enregistrer sous. . .). Enfin, le ficher
est rechargé sous le nouveau nom.

Les commandes GIT exécutées :
git mv "<nom-de-fichier>" "<nouveau-nom-de-fichier>"
git commit

11.2.6.5 Afficher I'historique

Cette commande affiche 1'historique complet du document sous GIT. Le résultat
de git log "<nom-de-fichier>" est affiché dans un navigateur.

11.2.6.6 Infos de version

LyX reconnait I’empreinte de validation GIT de la derniere soumission du fichier,
sa forme abrégée, le nom de son auteur, la date et I’heure. Toutes ces informations
sont extraites via git log —n 1 --pretty=format:’H/n%an%n%ai.

L’information sur la version de I’arborescence peut étre obtenue via git describe
--abbrev --dirty --long.

Voir 11.2.4.11 pour d’autres détails.

11.2.7 Personnalisation avancée

Avec 'implantation de la commande vc-command, les utilisateurs avancés de LyX
peuvent créer leurs propres commandes de contréle de version.

Par exemple, vous pouvez voir comment deux commandes TortoiseSVN pourraient
étre directement intégrées :

Commit: vc-command DR "." "TortoiseProc /command:commit /path:$$p"

Revert: vc-command DR "." "TortoiseProc /command:revert /path:$$p"

11.2.8 Contréle de version et comparaison de documents

Une des utilisations caractéristiques du controle de version consiste a mettre en
évidence les modifications entre versions, usuellement en créant des fichiers diff.
Alors que ceci est utilisé pour les fichiers textuels ordinaires, ¢a ’est beaucoup moins
dans le cas des fichiers LyX, dont la structures est plus complexe. Nous fournissons
donc un lien vers la fonctionnalité [yX de comparaison de documents. Il y a deux
facons d’invoquer cette comparaison, soit par un appel direct de la fonction IyX
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vc-compare (voir le manuel des fonctions Iy X pour les détails), soit par 'icone de la
barre d’outils ou ’entrée de menu Il est possible de comparer deux révisions particu-
lieres du document, ou plus simplement la version courante en cours de modification
avec une version antérieure (ou la révision «0» est simplement la derniére révision
enregistrée).

Cette fonctionnalité est disponible avec SVN et RCS, bien que dans ce dernier
cas il y ait une contrainte due au schéma de versionnement plus compliqué : lorsque
que l'on désigne une révision, les chiffres pointent toujours sur le dernier élément
du numéro de révision, c’est-a-dire «35» dans « 1.2.35 ». En ce qui concerne GIT,
la fonctionnalité n’est pas disponible, il est juste possible de comparer un document
modifié avec une révision antérieure de X étapes, ou X est défini par HEAD~X.

11.3 Programmation littéraire

Mise a jour par KAYVAN SYLVAN (kayvan@sylvan.com), document d’origine écrit
par EDMAR WIENSKOSKI JR. (edmar-w-jr@technologist.com)

11.3.1 Introduction

Le but principal de cette documentation est de montrer comment utiliser LyX pour
la programmation littéraire. Nous supposerons que vous étes familiers de cette tech-
nique de programmation, et savez donc ce que « tangling » et « weaving » signifient 23.
Si ce n’est pas le cas, veuillez lire les pages web dont les adresses sont indiquées un
peu plus loin. Vous y trouverez une bonne documentation, allant de ’histoire du
développement aux derniers trucs et astuces.

Nous supposerons aussi que vous étes assez familiarisés avec IyX pour pouvoir
changer vos préférences, et le fichier de ressources X. Si ce n’est pas le cas, voyez le
reste de la documentation de IiyX qui couvre ces domaines.

11.3.2 La programmation littéraire

Extrait de la FAQ de la Programmation Littéraire :

La programmation littéraire est la combinaison de la documentation et
des sources en une forme lisible par un étre humain. En fait, la program-
mation littéraire doit étre agréable a lire, et méme aguicheuse! (Désolé,
Bob, je n’ai pas pu résister...) En général, la programmation littéraire
combine la source et la documentation dans un seul et unique fichier.
Des outils de programmation littéraire permettent ensuite de produire
séparément le fichier source et la documentation. Le style WEB de pro-
grammation littéraire fut créé par D.E. Knuth lors du développement de
son logiciel de typographie, TEX.

23. NdT : Respectivement la génération du code et de la documentation. — ar
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Un autre extrait :

En quoi la programmation littéraire différe-t-elle du commentaire ¢
Il y a trois signes distinctifs qui sont, dans 'ordre d’importance :

— un ordre d’élaboration flexible
— le support automatique pour la visualisation

— une documentation mise en forme, notamment les diagrammes et les
mathématiques

Maintenant que j’ai éveillé votre curiosité, voyons les références :

11.3.2.1 Références

La FAQ complete de la Programmation Littéraire se trouve a :

FAQ de la Programmation Littéraire http://www.xmarks.com/site/shelob.
ce.ttu.edu/daves/lpfaq/faq.html

La FAQ dénombre 23 (vingt-trois!) outils différents pour la programmation littéraire.
Certains sont spécialisés pour certains langages de programmation, d’autre ont une
portée plus générale. J'ai sélectionné NoWeb pour mon usage personnel pour plusieurs
raisons :

— Il sait générer la documentation aussi bien en IXTEX qu’en HTML.

— Il a une architecture ouverte, c’est-a-dire qu’il est facile d’y ajouter de nouveaux
filtres 24 et de réaliser des opérations spéciales au besoin.

— Un grand nombre de filtres est déja disponible (dont celui pour le HTML).
— Il est libre.
La page web de Noweb se trouve a :
Page d’accueil de Noweb https://www.cs.tufts.edu/~nr/noweb/

A partir de la, vous trouverez de nombreux liens intéressants et mémes quelques
exemples de programmation littéraire.

11.3.3 LyX et la Programmation Littéraire avec Noweb

LyX supporte la Programmation Littéraire par l'intermédiaire du mécanisme de
gestion des convertisseurs. Ce support est « indépendant de Noweb », c¢’est-a-dire que
vous pourrez utiliser cette nouvelle fonction de LyX avec un autre outil de program-
mation littéraire de votre choix, en changeant juste vos préférences LyX.

24. Filters are programs that read a given data stream and output a manipulated data stream.
That way, a WEB file (consisting of literate code) can be turned into a file consisting only of C
program code or BTEX code.
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11.3.3.1 Génération des documents et du code (weaving and tangling)

Using the noweb module Si vous avez installé Noweb et Iy X avec succes, chaque
fois que vous ouvrez un nouveau document, apres avoir choisi sa classe, utilisez le
menu Document>Parametres... pour ajouter le module « noweb ». Vous le verrez en
cliquant sur « Modules » dans le liste des modules disponibles.

Ajout de code IxX vous permet d’entrer du code par 'intermédiaire d’un insert
paramétrable nommé CHUNK. Noweb délimite les chunks ainsi :

<<Mon code>>=
code
encore du code
toujours du code
(¢

Le probleme est que tout ce qui est compris entre le << et ’arobase @ doit étre pris
tel quel, c’est-a-dire que LyX ne doit faire aucune interprétation de ce qui a été écrit.
C’est aussi géré par le environnement CHUNK, qui fonctionne comme un insert des
texte normal mais qui présente une totale liberté en ce qui concerne I’espacement.

Il est a noter que vous pouvez aussi utiliser la construction « %def » de Noweb
dans vos chunks pour ajouter des éléments de référence croisée :

<<Mon scrap>>=

def une_fonction(param):
"C’est la documentation de cette fonction."
print "Mes paramétres : ", param

@ def une fonction

Pour avoir un exemple de cette construction et des références croisées engendrées,
regardez le programme littéraire python dans LIBDIR/examples/listerrors.lyx
qui devrait clarifier tout ¢a.

Génération de la documentation Arrivé ici, vous avez déja un nouveau fichier
avec sa propre classe de document, et vous avec tapé un peu de code et de texte
dedans. Bien; et maintenant, comment je 'imprime? La réponse est simple : vous
faites Affichager DVI, etc. comme vous le feriez pour un document quelconque. Il n’y
a aucune procédure particuliere.

Pour vous aider a vous y retrouver, je vais vous expliquer ce qui se passe a I'intérieur
de IyX :

1 Quand vous choisissez Affichage> Mise a Jour>DVI, un fichier IfTEX est généré.

Si le document est d'un type littéraire, le fichier généré sera nommé avec l'ex-
tension définie par le format « littéraire » (défini dans la fenétre de Préférences),
sinon le fichier aura ’extension habituelle . tex.
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2 Remarquez que la seule différence est cette extension : LyX n’a rien de particu-
lier a faire. Tant que vous avez utilisé I'insert CHUNK en entrant le texte, tout
se passera sans probleme.

3 Si le document est d’une classe littéraire, IyX utilisera ensuite le convertisseur
interne LyX vers Noweb, suivi par le convertisseur Noweb vers I 25 pour
générer le fichier KTEX

Sinon, il saute simplement cette étape.

4 Enfin, IXTEX est invoqué et le processus continue comme s’il s’agissait d’un
document quelconque.

Vous étes donc indépendant d’un « outil littéraire » donné, car vous pouvez changer
les commandes correspondant aux différents convertisseurs.

Génération du code Quand on demande de Compiler dans les menus, ou quand on
appuie sur le bouton correspondant de la barre d’outils, un fichier KTEX est généré
comme dans I'étape 1 ci-dessus. LiyX invoque ensuite le convertisseur NoWweb->Program.
Celui-ci (comme tout convertisseur) est invoqué en deux parties :

1 Le programme de conversion proprement dit. Ce programme procede a la conver-
sion d'un format & un autre (ici, du format NoWeb au pseudo-format Program).

2 Le filtre de messages d’erreur. C’est un programme dont le seul role est de ré-
écrire les messages d’erreur dans un format compréhensible par LyX. Ca permet
a LyX de placer des boites d’erreur au bon endroit dans le tampon du fichier.

La premiere partie, déterminée par le champ Convertisseur, doit contenir
« build-script $$i ». Ca signifie que IxyX va appeler build-script (un pro-
gramme ou un script) avec le nom du fichier Noweb (en général un fichier dans
le répertoire temporaire de IyX).

Voici une implémentation de build-script que vous pouvez mettre dans un ré-
pertoire de votre chemin d’acces par défaut :

# !/bin/sh

#

notangle -Rbuild-script $1 | env NOWEB_SOURCE=%1 NOWEB_OUTPUT_DIR=$%2
sh

Le prochain élément du réglage du convertisseur est le
« Drapeau » qui doit étre mis a

parselog=$$s/scripts/listerrors

Ceci filtrera par le programme « listerrors » toute erreur créée par le build-script.

La construction prendra normalement place dans le répertoire temporaire de LyX,
les fichiers produits seront donc normalement dans ce répertoire. LyX exportera ce qui
concerne le fichier principal, mais le programme de conversion Noweb->Program peut
produire d’autres fichiers, qui seront perdus quand IxX sera fermé. C’est pourquoi

25. Les convertisseurs sont définis dans la fenétre Outilst> Préférences> Gestion de fichiers, dans
I’onglet Convertisseurs.

134



CHAPTER 11. LyX ET APPLICATIONS EXABRNEAMMATION LITTERAIRE

nous transmettons la variable d’environnement NOWEB OUTPUT DIR pour que
les éléments de la conversion puissent étre copiés a cet endroit.

Instructions de compilation dans le document La derniére partie de I'interface

entre LyX et noweb est le chunk « build-script ». En général, les instructions de

compilation de votre programme doivent étre regroupées dans un chunk a part. Le

build-script vu plus haut est spécifique a noweb et utilise la commande notangle

pour rechercher ce chunk (appelé « build-script ») et passer son contenu dans sh.
Typiquement, un tel chunk ressemble a ceci :

<<build-script>>=

#!/bin/sh

if [ -z "${NOWEB_SOURCE}" ]

then

NOWEB_SOURCE=myfile.nw

fi

[... code to extract files ... use NOWEB_OUTPUT DIR here ...]
[... code to compile files ...]

@

Voyez dans Fichier> Ouvrir un exemple > Modules > Liste d'erreurs Noweb ou dans Fichier>
Ouvrir un exempler>Modules> Noweb2LyX qui implémentent deux versions du pro-
gramme listerrors pour avoir des exemples de comment tout cela va ensemble.
Il est intéressant de constater que ces deux fichiers démontrent I'indépendance de
[yX relativement au langage de programmation littéraire adopté car ils sont écrits
respectivement en Python, C et Perl.

11.3.3.2 Configurer LyX

Vous pouvez configurer ce qui concerne la Programmation Littéraire dans 1'onglet
Convertisseurs de la fenétre Outils> Préférences. Les parties importantes sont :

le format « littéraire » Choisi dans 'onglet Formats, ol vous mettez ce qui est spé-
cifique & Noweb. Le Nom d'interface est « NoWeb », I’Extension est « nw ». [ X
créera donc un fichier d’extension .nw lors de la premiere étape du processus
de conversion.

le format Programme C’est un format fictif dont le seul but est d’étre le point d’ar-
rivée d’une conversion (ce qui permet ainsi de mettre en place un convertisseur
pointant vers lui).

NoWeb->BTEX Ce convertisseur assure la génération de la documentation (« wea-
ving »). Pour Noweb, il faut mettre « noweave -delay -index $$i > $$o »

NoWeb->Program Celui-ci assure la génération du code (« tangling »). Comme vu
plus haut, il faut mettre « build-script $$i », avec comme Autres Options
« originaldir,parselog=listerrors ».
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11.3.3.3 Fonctions pour le déboguage

Une nouvelle fonction est aussi implémentée dans le serveur IyX, la fonction « ser-
veur va a la bonne ligne » que 1'on utilisera avec ddd/gdb ou un autre débogueur.

Lorsque vous déboguez du code avec ddd/gdb, il est possible d’appeler un éditeur
de texte a la position actuelle d’exécution, avec un seul appui clavier. La configuration
par défaut de ddd est Shift-Ctrl-V. Il se trouve que vous pouvez choisir I’éditeur appelé
par ddd dans la fenétre Outils> Préférences> Gestion des fichiers> Formats de fichier en
changeant I'entrée Editeur.

J'ai trouvé avantageux d'utiliser In’X avec ddd en réglant Editeur sur :

echo "LYXCMD:monitor:server-goto-file-row:@FILE@ QLINEQ@" >~/.lyxpipe.in

Ainsi, quand vous utilisez ddd et que vous vous apercevez qu’il faut modifier le code,
vous pressez juste Shift-Ctrl-V (dans la fenétre ddd), et ddd renvoie cette information
a LyX via le serveur IiyX. La fenétre IyyX montrera le fichier en question, avec le
curseur pile poil la ot se trouvait ddd. Plus besoin de jouer aux devinettes ou de faire
défiler tout le document pour savoir ou se situait le probleme!

Notez cependant qu’il vous faut activer cette fonction du serveur IyX, inactive par
défaut. La section 10.2 explique comment procéder.

11.3.3.4 Ajouts a la barre d’outils

Il y a six nouveaux boutons qui peuvent étre ajoutés a la barre d’outils de IyX.
Quatre de ces boutons sont des raccourcis vers les styles Standard, Section, IKTEX et
LyX-Code, pour l'insert paramétrable Chunk. Le dernier bouton est un raccourci vers
la commande « Compiler ».

[yX a tout une série de boutons qui peuvent étre intégrés dans la barre d’outils.
Personnellement, j’ai combiné les six raccourcis ci-dessus avec deux autres : un pour
Document> Mise a Jour>DVI et un autre pour Document>DVI. Voila comment cela
se présente :

Toolbar
Layouts
Icon "layout Standard"
Icon "layout Section"
Icon "layout ERX"
Icon "layout IyX-Code"
Icon "flex.insert Chunk"
Separator
Icon "buffer-view"
Icon "buffer-typeset"
Icon "build-program"
Separator
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End
11.3.3.5 Couleurs personnalisées

Un certain nombre de couleurs de LyX peuvent étre personnalisées dans la fenétre
Préférences. Une des choses qui ennuient nombre d’entre nous est la couleur du code
KETEX. La couleur par défaut est le rouge, or les chunks utilisent la police XTEX, et
comme il y a beaucoup de chunks dans un document de programmation littéraire,
vous en aurez slirement marre de tout voir en rouge. Vous pouvez la changer dans
I’onglet Apparencer> Couleurs.

Le probleme suivant est la présence visible des caracteres « nouvelle ligne » sur
I’écran. Vous pouvez aussi choisir la couleur de ces caracteres particuliers et donc les
faire se confondre avec le fond. Je vous conseille de choisir une couleur qui est proche
de celle du fond, mais pas la méme : vous pourrez toujours les voir, mais ils ne vous
dérangeront plus.

11.3.4 LyX et knitr/Sweave

Les fonctionnalités de knitr et Sweave sont documentées dans Aide>Manuels spé-
cifiques> Knitr and Fichier>Ouvrir un exempler>Modules>Rnw (knitr) et dans Aider
Manuels spécifiques>Sweave et Fichier> Ouvrir un exemple>Modules> > Sweave.
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